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Introduction
This document explains how to configure Cisco Unified Workforce Optimization Quality Management in
a Cisco Unified Contact Center Express (Unified CCX) environment.
Cisco Unified Workforce Optimization Quality Management (Quality Management) is a comprehensive
recording solution that addresses the common needs for recording customer interactions—whether it
is for compliance, quality management, or both.
The Quality Management Administrator Guide contains the information you need to successfully
configure Quality Management Administrator, including:
n

Assigning user roles

n

Setting up groups

n

Creating evaluation forms, manage evaluation forms

n

Setting up workflows for recording customer contacts

n

Setting up recording archiving

n

Maintaining the Quality Management system

Quality Management Administrator controls how devices are configured, calls are recorded, and who
has access to Recording and Quality Management.
Call Recording provides a solution to record all calls—commonly done to meet regulatory compliance
requirements or to handle customer disputes. Call Recording makes the task of recording, archiving,
and retrieving 100% of customer calls more manageable in the following ways:
n

An organization can choose to record all calls for everyone, or for specific teams of
agents and knowledge workers configured in the system

n

Archive parameters are flexible and storage is secure

n

Advanced query options let users find recordings quickly and easily among thousands of
logged interactions

Quality Management helps businesses refine their processes and improve their bottom line in the
following ways:
n

Increase revenue by improving customer satisfaction and increasing customer loyalty

n

Provide consistent, high-quality customer experiences

n

Identify customer needs and expectations

n

Reduce labor costs for agent identifications
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To get started, you need to access Quality Management Administrator. Quality Management
Administrator is installed on the Quality Management Web Base server by default during a normal
install. You can also install it on a desktop, see the Desktop Deployment Guide or the Installation
Guide for more information.
This topic provides the essential information for logging in to Quality Management Administrator,
changing your password, and synchronizing the databases.

Logging into Quality Management Administrator
To log in to Quality Management Administrator:
1. Choose Start > All Programs >Cisco > WFO >Quality Management Administrator.
The Administrator Login dialog box appears.
2. Complete the dialog box as follows, and then click OK or press the Enter key.
n

In a non-Active Directory environment, type administrator in the User Name field and
the password that was set up during system installation in the Password field.
Note: The username, administrator, is a default username. You cannot
change it. The Username field is not case sensitive and the Password field is
case sensitive.

n

In an Active Directory environment, type an AD Account username in the User Name
field, the password associated with the AD Account user in the Password field. Select
the domain that is associated with AD Account user from the drop-down list in the
Domain field.

Quality Management Administrator validates your login credentials.

Changing the Administrator Password
The administrator password must be between 1 and 32 alphanumeric characters long. The password
is case sensitive. The password should remain confidential. If your password is no longer confidential,
change the password.

Note: You can only change the administrator password in a non-Active Directory environment.
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To change the administrator password:
n

From the menu bar, choose Settings > Change Administrator Password, complete the
fields in the Change Password dialog box, and then click OK.

Synchronizing Databases
To ensure the Quality Management database synchronize correctly with the ACD database, follow
these guidelines:
n

Unified CCX: set up teams, agents, supervisors, and devices in Unified CCX before you
synchronize the Unified CCX database with the Quality Management database.

Quality Management automatically synchronizes changes in the ACD database to the Quality
Management database.

To manually synchronize the databases:
n

On the menu bar, choose File > Synchronize Databases.
The synchronization process starts. While the process is running, Quality Management
changes the menu option from Synchronize Databases to Synchronize Databases
(Running) and disables the option.
Note: You might see a Microsoft Windows Security Alert saying that the Windows
Firewall blocked Java(TM) 2 Platform Standard Edition (SE) binary. To add an
exception for this binary, click Unblock and try again.
When the process is complete, Quality Management returns the menu option to
Synchronize Databases and enables the option.

Logging Out of Quality Management Administrator
n

To log out and leave Quality Management Administrator running, choose File > Log Of,
and then click OK.
You are logged out of Quality Management Administrator and the application remains
available.
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n

To log back in when Quality Management Administrator is running, choose File > Administrator Login, type administrator in the User Name field and the administrator password
in the Password field, and then click OK.

n

To log out and close Quality Management Administrator, choose File > Exit or click Close
in the upper right corner of the window.
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Administrator Interface
The Quality Management Administrator interface has two panes. The left pane is a navigation tree. The
right pane displays the node that you selected in the left pane.
The administrator responsibilities are partitioned into hierarchical roles. For more information on these
administrator roles and the scope for each role, see Administrator.

Note: To perform all administrative functions and receive admin logs, you must run Quality
Management Administrator as an administrative user.
The following image shows what an system administrator would see.

Moving Within the Navigation Tree
Use the following methods to move within the navigation tree.
Navigating using the mouse

Navigating using the keyboard
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l

l

l

Double-click an icon/node name to
expand or collapse the tree.
Click the plus sign (+) to the left of the
folder icon to expand the tree.
Click the minus sign (–) to the left of the
folder icon to collapse the tree.

l

l

l

Press the Up and Down arrow keys
to move from one node to the next.
Press the Left arrow key to collapse
the tree.
Press the Right arrow key to expand
the tree.

Sorting Tables
Data that appears in a table can be sorted by as many columns as there are in the table. The sort can
be ascending or descending.
The small triangles at the right of the column heading display the direction of the sort. These arrows
also change size depending on the column’s position in the sort. The triangle in the primary sort
column is biggest, the one in the secondary sort column is slightly smaller, and so on.
To sort a table by one column, click the column heading. To reverse the sort order, click the column
heading again.

To sort a table by multiple columns:
1. Press Ctrl and click the primary sort column heading.
2. Continue holding down Ctrl and click any other column headings you want to sort the table
by.
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System Configuration allows you to initially configure and then later modify the Quality Management
environment. There are two ways to access the System Configuration node:
n

System Configuration Setup (postinstall.exe)—this executable runs provides a limited set
of configuration options that are required during initial configuration or to quickly modify
certain system settings. Use postinstall.exe when installing or upgrading Quality
Management. The steps you see in the postinstall.exe depend on the environment in
which you install Quality Management and the options that you choose to configure. The
postinstall.exe opens automatically after you install Quality Management.
Note: The Inclusion List does not appear in postinstall.exe. It appears in Quality
Management Administrator under the System Configuration node.

n

Quality Management Administrator (admin.exe)—this executable provides the full set of
configuration options, including adding agents when installed on the server. Use
admin.exe to manage day-to-day system operational changes or to validate user roles
and license assignments.
If you are running Quality Management Administrator on a desktop, some features are
disabled under System Configuration. You can only modify these features when you are
running Quality Management Administrator or postinstall.exe on the Web Base server.

Modifying the System Configuration
To modify the system configuration information:
1. Choose one of the following options:
n

Go to the following folder on the Quality Management server, double-click
postinstall.exe.
<install folder>\WFO_QM\bin\
The default path is C:\Program Files\Cisco\WFO_QM\bin\postinstall.exe.

n

Log in to Quality Management Administrator. See Logging into Quality Management
Administrator for instructions.

2. Select the window you want to modify. The selected window appears in the right pane.
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3. Complete the fields.
4. Click Save. Modifications take effect after you save your changes.

System Database
Use the System Database window to configure connection information for the Quality Management
system database (system database).

Note: You can only change the information in the System Database window from the
postinstall.exe or Quality Management Administrator on the Web Base server. The System
Database window in Quality Management Administrator on a desktop is read-only.
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Field

Description

Host Name/IP Address

The hostname or IP address of the system operations server
(the server on which SQL Server is installed).
If you need to specify a configured port on the system operations
server where an external SQL server will listen, choose Host
Name and use the following format in the IP Address field:
<IP address or hostname>:<port number>
where <IP address or hostname> is the IP address or hostname
and <port number> is the configured port number of the system
operations server.
Example: 10.188.252.11:1455

Best Practices: Use a hostname in all instances where
you are required to specify a hostname or IP address, if
possible.
SQL Instance Name

The SQL instance name of the Microsoft SQL Server service.
Leave this field blank if you want to use the default instance
name. The default instance name is automatically assigned
when Microsoft SQL Server is installed.

Username

The username used by the Quality Management's DB Proxy
service, for example qmdbuser, to access the system database.
This username must be assigned the db_datareader, db_
datawriter, and db_owner roles. See “Microsoft SQL Server” in
the Installation Guide for more information.

Password

The password used by the DB Proxy service to access the
system database. See “Microsoft SQL Server” in the Installation
Guide for more information.

Configuration Settings Used By Services
If you change the settings on the System Database window, the following table shows when your
changes take effect.
Service

Data API
Service

Configuration settings applied when...

Restart the service.
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Service

Configuration settings applied when...

DB Proxy
Service

Restart the service.

Sync Service

No restart required. The next sync period (every 10 minutes) applies the
configuration settings.

Update IP Address or Hostname
When upgrading Quality Management, you will be prompted to update the IP addresses or hostnames
for the servers.

To modify the IP address or hostname for a server:
1. Click Modify, complete the fields, and click OK.
2. Repeat step 1 for each additional server.
3. Click Continue with These Changes.
To continue without making any changes to the IP address or hostname:
n

Click Continue without Making Changes.

Data Synchronization
Use the Data Synchronization window to add, modify, or delete the connection information to Unified
CCX.

Note: You can only change the information in the Data Synchronization window from the
postinstall.exe or Quality Management Administrator on the Web Base server. The Database
Synchronization window in Quality Management Administrator on a desktop is read-only.
You can configure the connection information to one or more Unified CCXs.
If you modify the information in the Data Synchronization window after the initial installation and
configuration, you must restart the Sync services before your changes take effect.
The following window shows the configuration for a Unified CCX.
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The image below illustrates the Unified CCX filters:
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Field

Description

Add

Add an ACD.

Rename

Rename a selected ACD.

Delete

Delete a selected ACD.
Note: When you delete an ACD, all associated data (that
is, teams and users) will be deleted.

Unified CCX
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Field

Side A Server Name

Description

The name of the Unified CCX server for the Side A (primary)
Cisco Unified CC database.
Note: The server name must match the case of the name
on the Unified CCX server. If the server name is all
lowercase on the Unified CCX server, you must enter it
as all lowercase in this field.
If the server name contains a hyphen ( - ), replace the hyphen
with an underscore ( _ ). If the server name starts with a
number, add the letter “i” to the beginning of the instance name.
For example, if the server name is “100-voiceuccx-01”, enter
“i100_voiceuccx_01”.

Side A IP Address

The IP address for the Unified CCX server for the Side A
(primary) Cisco Unified CC database.

Side B Server Name

The name of the Unified CCX server for the Side B (secondary)
redundant Cisco Unified CC database, if one exists.
Note: The server name must match the case of the name
on the Unified CCX server. If the server name is all
lowercase on the Unified CCX server, you must enter it
as all lowercase in this field.
If the server name contains a hyphen ( - ), replace the hyphen
with an underscore ( _ ). If the server name starts with a
number, add the letter “i” to the beginning of the instance name.
For example, if the server name is “100-voiceuccx-01”, enter
“i100_voiceuccx_01”.

Side B IP Address

The IP address for the Unified CCX server for the Side B (secondary) redundant Cisco Unified CC database, if one exists.

DB Instance Name

The name of the Cisco Unified CCX database. The name is
<side A server name>_uccx and the field is disabled by default.

Port

The port number used by the Cisco Unified CCX database. The
port number is 1504 and the field is disabled by default.
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Field

Description

Login ID used to access the Cisco Unified CC database and
synchronize users in a Unified CCX environment. This user
must have read permission to the database. The login ID is
uccxworkforce by default.

User

Note: If you are using Cisco MediaSense, use
uccxhruser for the login ID. This login ID has the
permissions required to synchronize users and reconcile
contacts. The uccxworkforce login ID does not have
permission to use contactcalldetail and
agentconnectiondetail tables that are required for
reconciliation.
Password

Password used by uccxworkforce to access the Cisco Unified
CC database in a Unified CCX environment.

ACD Filters

Allows you to determine what data is synced and determines
which devices are available in a telephony implementation. See
Touch-Point Filtering for more information.

Configuration Settings Used By Services
If you change the settings on the Cisco Unified CC Database window, the following table shows when
your changes take effect.
Service
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ACD Data Synchronization Service

Changes take effect immediately.

Reconciliation Service

Changes take effect immediately.
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Service

Sync Service

Configuration settings applied when...

No restart is required:
n

After the initial installation

n

After you fix incorrect sync information

The next sync period applies the configuration settings without
restarting the Sync service.
Best Practices: When there are substantial changes to
the database, update the settings in the Cisco Unified CC
Database in the following order:
1. Stop the Sync service and the Upload Controller service.
2. Back up the SQMDB catalog.
3. Change the configuration settings on the Cisco Unified CC
Database window.
4. Start the Sync service.
5. Verify the data by looking for mass deactivations.
6. Restart the Upload Controller service. Restarting the
Upload Controller services adds new calls to the database.
MANA Service

The next polling period applies the configuration settings.

Data API service

Restart the Data API service.

Touch-Point Filtering
Touch-Point Filtering allows you to determine what data is synced and determines which devices are
available in a telephony implementation. A “touch point” is a third party system that has data that can
be synced with Quality Management for recording purposes. The ability to filter this data so that
Quality Management sees only a subset of the touch point’s data is useful in the following
environments:
n

Multi-tenancy environments where a single ACD/telephony implementation is used by
multiple customers and each customer has their own Quality Management installation.

n

Environments where an ACD/telephony implementation has more data than Quality
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Management requires. For example:
l

l

Only a subset of all extensions are assigned to agents and therefore required for
recording purposes.
Quality Management will only be used by a subset of the call center.

By default, all teams and users are synced and available to be configured in Quality Management
Administrator. Touch-Point Filtering allows you to you to configure filters so that Quality Management
only has access to the ACD/Telephony data that matches the filter. The available filters depend on the
ACD and telephony implementations.
When you add a filter, the ACD Filter dialog box appears. The fields associated with this dialog box are
described in the following table.

Field

Description

Name

The name of the ACD filter.

Prefix Type

The type of prefix that Touch-Point Filtering will use to filter the
data. In this instance, the data is filtered by Team Name.

Prefix Value

The name of the team. No wildcards are allowed.
Example: If you enter Team1, both Team1 and Team10
will be synced.

Trim Prefix

Remove the prefix before adding synced information to the Quality Management database. Your options are as follows:
n

True—removes the prefix. True is the default value.

n

False—keeps the prefix

Example: QM_TeamA becomes TeamA.

Telephony Groups
A telephony group consists of at least one signaling source, one signaling group, one signaling server,
one recording cluster, and devices.
Quality Management allows you to add backups for the signaling source, signaling group, signaling
server, recording cluster, and devices. Adding any one of these backups is optional. However, Cisco
recommends using backups for resiliency purposes.
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Note: Some telephony group types do not support a backup signaling source.

The Telephony Groups window allows you to add, modify, and delete the telephony groups:
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Field

Add

Description

Add a telephony group and complete the following fields:
n

Name—Enter a unique name for the telephony group.
Best Practices: Specify a name that identifies how
the telephony group is being used (for example,
location, recording cluster, recording type, and so
on).

n

Telephony Group Type—Select the telephony group type
from the drop-down list.

Rename

To change the name of the selected telephony group, enter the
name in the New Name field and click OK.

Delete

Delete the selected telephony group.
Note: If you delete a telephony group, Quality
Management will remove all devices associated with this
telephony group from the VoIP Devices table.

Revert Recent Changes

Reverts changes made after the last save to previously committed configuration settings.

Show Gateway Recordings Prior to Reconciliation

When selected, this check box allows archive users in an Unified
CCX environment to view root calls in the Recordings application
before the calls are reconciled, including all PCI events. When
cleared, calls do not appear in the Recordings application until
reconciliation is complete and all PCI events are excluded. This
check box is clear by default.

Telephony Groups
The following window shows the Cisco Unified Call Manager Telephony Groups screen:
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The following table describes what is supported based on telephony group type.
Telephony Group Type

Changes

Unified CM

A Unified CM telephony group can have any number of
signaling groups.

All Others

All other telephony group types can support multiple telephony
groups, but they are restricted to a single signaling group and
Recording Cluster per telephony group.

Signaling Groups
Signaling groups are unique to the selected telephony.
A Unified CCX signaling group consists of one or more signaling services. Each CTI service in a Unified
CM signaling group can have a separately administered list of Unified CM CTI Managers to connect to
for JTAPI. The signaling group can have any number of Recording Clusters.
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All other telephony group types are restricted to a single signaling group and Recording Cluster per
telephony group. CUBE supports primary and backup signaling services, but MediaSense supports
only a single signaling service.

Recording Clusters
Quality Management supports Recording Clusters. A Recording Cluster is a group of one or more
Recording Servers. A Recording Server indicates which Recording Cluster it belongs to when it
connects to a signaling service.
You can assign a Recording Servers to a Recording Cluster. When configuring a Recording Cluster
remember the following points:
n

If you have knowledge workers in a CUBE or MediaSense Recording environment who
require screen recording, you need to create a Recording Cluster that connects to a CTI
server and has no Recording Servers assigned to it.

n

You can assign one or more Recording Servers to a Recording Cluster. A Recording
Cluster requires at least one primary Recording Server.
A primary signaling service will exhaust the capacity of all primary Recording Servers
before sending calls to secondary Recording Servers. A backup signaling service will
exhaust the capacity of all secondary Recording Servers before sending calls to primary
Recording Servers. This allows primary/backup signaling services and
primary/secondary Recording Servers to be split geographically while keeping the traffic
as local as possible. Significant traffic should only traverse the WAN in specific failure
scenarios.

n

A Recording Server can only belong to one Recording Cluster.

n

You can move Recording Servers between Recording Clusters.

Important: You must run postinstall.exe on all Recording Servers before you can assign a
Recording Server to a Recording Cluster. If you do not run postinstall.exe on the Recording
Servers the Select Record Servers dialog box will be empty.

Telephony Group Configuration
The Telephony Group Configuration dialog box appears when you add a telephony group. It allows you
to assign a name to the telephony group and associate it with a telephony signaling method.
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Field

Description

Name

The name of the telephony group. The name must be unique.

Telephony Group Type

The telephony signaling method for Unified CM. The possible
telephony group types are as follows:
n

CUBE—no additional configuration is required after you
add this telephony group.

n

Unified CM—see Unified CM Configuration for more
information. The field displays Unified CM by default.

n

MediaSense—see MediaSense Configuration for more
information.

Unified CM Configuration
The Unified CM Configuration dialog box appears when you add or edit a telephony group with a Cisco
Unified Communications Manager (CM) telephony type. It allows you to configure a Cisco Unified CM
cluster.
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The Cisco Unified CM window also allows you to configure the following users:
n

Simple Object Access Protocol (SOAP) Administrative XML Layer (AXL) user

n

Unified CM Java Telephony Application Programming Interface (JTAPI) user

These users are used by the Computer Telephony Integration (CTI) service to log in to Unified CM.
A Unified CM cluster comprises a set of Unified CM servers that share the same database and
resources and has one or more CTI Managers. The CTI Manager is a service that runs on Unified CM
and handles JTAPI events for every Unified CM in the cluster. For more information on CTI Managers,
see Signaling Groups.
You can specify one or more Unified CM telephony groups.

Note: A Unified CM telephony group requires at least one CTI Manager.
You enter each Unified CM in the Unified CM telephony group in postinstall.exe so that the Desktop
Recording service can find the location of the Recording CTI service. Quality Management stores an
association between the Recording CTI service and the Unified CMs in the cluster. If a Unified CM is
not in the list, the Desktop Recording service will not know where to register for events.
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Note: Adding a new Unified CM telephony group here does not actually add a Unified CM
cluster. It creates the association between the Recording CTI service and the Unified CMs in
the cluster.

Field

Description

Name

(Read only) The name of the telephony group. The name must
be unique.

Telephony Group Type

(Read only) Displays Unified CM by default.

Endpoint only does
Screen Recording

When selected this check box indicates that the Unified CM telephony group is being used for screen recording only. The
Desktop Recording service will not record audio when this box is
selected. This only applies when you are using one of the following recording methods:

Enable Network Recording

n

Network Recording

n

Cisco CUBE Recording via SIP Recording

n

Cisco MediaSense Recording

When selected this check box indicates that the Unified CM telephony group is using Network Recording and the Recording CTI
service will listen for SIP messages. The Recording CTI service
will not listen for SIP messages when the check box is cleared.

You can install the Recording CTI service and CUBE SIP CTI
service on the same machine if you clear the Enable Network
Recording check box.
Example: You are recording voice through Gateway
Recording (using the CUBE SIP CTI service) and
recording screen from a single server.

Note: The Recording CTI service and CUBE SIP CTI
service will interfere with each other while listening for
SIP messages if the Enable Network Recording check
box is selected.
CDR Configuration

Allows you to enable the Unified CM’s Call Detail Records (CDR)
Report. See CDR Configuration for more information.
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Field

Description

Filters

Allows you to configure the telephony filters for this telephony
group. See Filters for more information. Use a telephony filter to
filter the devices that are imported.

SOAP AXL Access Username

The AXL (Administrative XML Layer) authentication username
on the publisher for this cluster. The SOAP AXL account is used
to access devices in Unified CM from the VoIP Devices window.
This username is created when you configure Unified CM.
Note: If you change a username or password, you must
restart all associated signaling services.

SOAP AXL Access Password

The AXL authentication password on the publisher. This
password is created when you configure Unified CM.
Note: You must type this password; you cannot use
copy/paste to enter the Unified CM password.

SOAP AXL Access Version

The Unified CM version on the publisher.

Note: An error message will appear if the Version field is
not configured.
JTAPI Username

The JTAPI username for CTI. All phone devices, used for
recording are associated with this application user (end user).
The Recording CTI service logs into the Unified CM with this
user. The username must be between 1 and 32 alphanumeric
characters. This field is enabled when you choose CTI or Mixed
from the Telephony Signaling Method drop-down list.
Note: If you change a username or password, you must
restart all associated signaling services.
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Field

JTAPI Password

Description

The JTAPI user’s password for CTI. This must be between 1
and 32 alphanumeric characters. This field is enabled when you
choose CTI or Mixed from the Telephony Signaling Method
drop-down list.
Note: You must type this password; you cannot use
copy/paste to enter the Unified CM password.

IP Address

The host name or IP address of the subscriber (if any) Unified
CMs. You can enter one publisher Unified CM, and one or more
subscriber Unified CMs.
Note: When using hostnames, verify the server can
resolve the name of the subscribers. If the hostname
cannot be resolved, the Recording CTI service cannot log
in.

Publisher

The field indicates whether or not the provided Host Name/IP
address is associated with the publisher CTI Manager service. If
the field is blank, the Host Name/IP address is associated with a
subscriber CTI Manager service.

AXL Provider

This field indicates whether or not the provided
Host Name/IP address is associated with the AXL provider.

Add

Add a new publisher or subscriber. See Subscriber
Configuration for more information.

Delete

Remove the selected publisher or subscriber.

Find Subscribers

Use the AXL user to locate subscribers associated with the
publisher entered. This is a good way to validate the AXL user
credentials and to populate the list of subscribers, if any are
found.

CDR Information Formats for the QM3002 Notification Trigger
You can specify in which format you want to display the CDR information in the CDR Configuration
dialog box. Examples of the available formats are listed here.
In these reports, call durations are expressed in milliseconds.
If the agent is listed as “Unknown” it means the agent has not yet successfully logged in to a PC that
has the Desktop Recording service installed and running. The agent is probably not configured
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correctly. Notifications for unknown agents are filtered out if the “Notify on users configured in QM”
check box is enabled.

CDR Configuration
CDR Configuration allows you to enable Unified CM’s Call Detail Records (CDR) Report.

Field

Description

Unified CM Version

Select the version of the Cisco Unified CM you are using.

Host Name/IP Address

Choose host name or IP address, and then enter the
information for the Unified CM.
Best Practices: Use a hostname in all instances where
you are required to specify a hostname or IP address, if
possible.
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Field

Username

Description

The name of the user with rights to access the CAR reports.
Note: If you change a username or password, you must
restart all associated signaling services.

Password

The password of the user with rights to access the CAR reports.

Ignored Extensions

Displays the list of ignored extensions. Quality Management
does not send notifications about extensions that appear in this
list. Select one of the following options to modify the extensions
that appear in this list.
n

Add—add a new extension to the list

n

Remove—delete an extension from the list

n

Edit—modify a selected extension in the list

Filters

Field

Description

Telephony Filters

Lists the names of the available telephony filters.

Add

Add a new telephony filter.

Remove

Delete a selected telephony filter.

Edit

Modify a selected telephony filter.

Name

The name of the telephony filter.

Extension Range

The range of device extensions that you want to include in the
sync.
An extension range comparison is done numerically. Pluses are
limited from the numbers and compared mathematically. In this
case, a range of 1 to 1000, would find the extension 500 in
range.
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Field

Device Name Range

Description

The range of device names that you want to include in the sync.
Device names are compared alphabetically and/or
lexicographically. So a range of 1 to 1000 would not find 500,
instead you would have to specify the range as 0001 to 1000.
This is because device names can be any string and are not
limited to mostly being numbers as extension are.

Summary Only
Status Report
Start Time: 01/11/2008 15:25:53
End Time:
01/11/2008 16:25:53
Extensions with Missed Calls:
Ext
Agent
Found
Missed
1545 JonesM
0
8
2201 SmithB
0
15

% Missed
100%
100%

Detail (Tab Delimited)
Status Report
Start Time: 01/11/2008 15:23:41
End Time:
01/11/2008 16:23:41
Extensions with Missed Calls:
Ext
Agent
Found
Missed
% Missed
1545
JonesM 0
8
100%
2201
SmithB 0
16
100%
Missed Calls (all times in GMT):
CallID
Agent
Ext
ANI DNIS StartTime
Duration
16778554
JonesM 1545 2671 1545 01/11/2008 03:29:3613000
16778560
JonesM 1545 2671 1545 01/11/2008 03:29:5214000
16778561
JonesM 1545 2671 1545 01/11/2008 03:30:097000
16778594
JonesM 1545 2671 1545 01/11/2008 03:36:0112000
16778596
JonesM 1545 2671 1545 01/11/2008 03:36:1811000
Detail (Plain Text)
Status Report
Start Time: 01/11/2008 15:24:57
End Time:
01/11/2008 16:24:57
Extensions with Missed Calls:
Ext
Agent
Found Missed
1545
JonesM
0
8
2201
SmithB
0
16
Missed Calls (all times in GMT):
Call ID = 16778554
Agent = JonesM
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Ext
= 1545
ANI
= 2671
DNIS
= 1545
Start
= 01/11/2008
End
= 01/11/2008
Duration= 13 sec
Call ID = 16778560
Agent = JonesM
Ext
= 1545
ANI
= 2671
DNIS
= 1545
Start
= 01/11/2008
End
= 01/11/2008
Duration= 14 sec

03:29:36
03:29:49

03:29:52
03:30:06

Managing Ignored Extensions
Select a Unified CM telephony group from the list of telephony groups in the Telephony Groups
window, click CDR Configuration, and choose one of the following options:
n

To add an ignored extension, click Add in the Ignored Extensions section, enter the extension in the field, and click OK.

n

To edit an ignored extension, select the extension from the Ignored Extensions list, click
Edit, make the necessary changes in the Edit Extension dialog box, and click OK

n

To remove an ignored extension, select an extension from the Ignored Extensions list
and click Remove.

Configuring the QM3002 Notification Trigger
This task describes how to configure the QM3002 notification trigger.

1. Click CDR Configuration in the Unified CM Configuration window for a Unified CM telephony
group type.
The Configuration dialog box appears.
2. Select the version of the Cisco Unified CM you are using from the Unified CM drop-down list.
3. Choose Host Name or IP Address, and then enter the information for the Unified CM.
4. Type the Unified CM username and password.
Enter the name and password of the user with rights to access the CAR reports.
5. Add the extensions that you do not want to receive notifications. See Managing Ignored
Extensions for more information.
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6. Configure the properties for the notification.
7. Click OK.
Subscriber Configuration
Use the Subscriber Configuration dialog box to add a Unified CM server to the Cisco Unified CM
cluster. Alternatively, you can use the Find Subscribers button in the Unified CM Configuration dialog
box to find the list of subscribers.

Field

Host Name/IP Address

Description

The host name or IP address of the publisher or subscriber (if
any) Unified CMs. You can enter up to 8 subscriber Unified
CMs.
Note: When using hostnames, verify the server can
resolve the name of the publisher or subscribers. If the
hostname cannot be resolved, the Recording CTI service
cannot log in.

Best Practices: Use a hostname in all instances where
you are required to specify a hostname or IP address, if
possible.
Is Publisher

Select this check box if the provided Host Name/IP address is
associated with the publisher CTI Manager. Only one publisher
CTI Manager is allowed. This check box is disabled when a publisher CTI Manager is configured.

Note: A publisher CTI Manager must be configured
before you can add subscriber CTI Managers.
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Field

Is AXL Provider

Description

Select this check box if the provided Host Name/IP address is
associated with the AXL provider.

Unified CM Signaling Group
For the Unified CM telephony group, you can specify a primary and backup CTI Manager through
Quality Management. Any Unified CM that has the CTI Manager running on the subscriber can be your
primary or backup CTI Manager.

Note: You can configure any machine as the primary CTI Manager, but it is a good idea to
avoid using the publisher, because it already has the highest load. Using another server as the
primary CTI Manager helps avoid decreasing the Unified CM performance.
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Field

Description

Primary Signaling Details

Host Name/IP Address

The hostname or IP address of the primary signaling service. A
primary hostname or IP address is required.
This signaling service can belong to more than one signaling
group.
Best Practices: Use a hostname in all instances where
you are required to specify a hostname or IP address, if
possible.

CUCM CTI Managers for
JTAPI

The IP address of one or more primary CTI Managers. The CTI
Manager is a service that runs on Unified CM and handles
JTAPI events for every Unified CM in the cluster.

Backup Signaling Details

Host Name/IP Address

The hostname or IP address of the backup signaling service. A
backup hostname or IP address is optional.
This signaling service can belong to more than one signaling
group.
Note: The signaling service remains on the backup
server until you manually initiate fail back to the primary
server.

Best Practices: Use a hostname in all instances where
you are required to specify a hostname or IP address, if
possible.
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CUCM CTI Managers for
JTAPI

The IP address of one or more backup CTI Managers. The CTI
Manager is a service that runs on Unified CM and handles
JTAPI events for every Unified CM in the cluster.

Additional Associated
Servers

IP addresses for the remaining subscribers that are not
associated with the primary and backup CUCM CTI Manager
for JTAPI.

Up Arrow or Down Arrow

Use the Up or Down arrow buttons to move the CUCM
CTI Managers to the desired location.
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Field

Description

Add

Allows you to add a CUCM CTI Manager.

Delete

Allows you to delete a selected CUCM CTI Manager.

Unified CM Recording Cluster
Configure a recording cluster for Unified CM.

Field

Description

Primary Record Servers

The primary Recording server assigned to this recording cluster.

Secondary Record Servers

The secondary Recording server assigned to this recording
cluster.

Left Arrow or Right Arrow

Use the left or right arrow buttons to move the selected Recording Server to the desired location.
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Field

Description

Add

Allows you to add one or more Recording Server as primary or
secondary Recording servers.

Remove

Allows you to delete a selected Recording Server.

MediaSense Configuration
The MediaSense Configuration dialog box appears when you edit a telephony group with a
MediaSense telephony type. It allows you to configure the Cisco MediaSense cluster associated with
the telephony group. Quality Management uses this information to download call recordings from
Cisco MediaSense.

Field
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Description

Name

The name of the telephony group.

Telephony Group Type

The telephony signaling method for Cisco MediaSense. The
field displays MediaSense by default.
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Field

Primary MediaSense API
Server IP Address or
Hostname

Description

The hostname or IP address of the primary Cisco MediaSense
API server.
Best Practices: Use a hostname for the primary and
secondary MediaSense API server, if possible.

Secondary MediaSense
API Server IP Address or
Hostname

The hostname or IP address of the secondary Cisco
MediaSense API server.
Best Practices: Use a hostname in all instances where
you are required to specify a hostname or IP address, if
possible.

MediaSense Subscription
Service IP Address or
Hostname

The hostname or IP address for the MediaSense Subscription
service.

Authentication Username

The username for the Cisco MediaSense API server.
Note: If you change a username or password, you must
restart all associated signaling services.

Authentication Password

The password for the Cisco MediaSense API server.

MediaSense Signaling Group
There is no configuration required for the MediaSense signaling group.

MediaSense Recording Cluster
There is no configuration required for a MediaSense recording cluster.

Managing Telephony Groups
To add a telephony group:
1. From the Telephony Groups window, select the Telephony Groups node, click Add, complete the fields, and then click OK to create a telephony group.
2. If there are fields associated with the new telephony group, complete the fields.
Note: You cannot continue to the next step until you complete the fields.
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3. Expand the new telephony group node, click Signaling Groups, click Add, complete the field,
and then click OK to create a signaling group.
4. Complete the fields for the signaling group.
Note: You cannot continue to the next step until you complete the fields.
5. Expand the new signaling group node, click Recording Clusters, click Add, complete the
field, and then click OK to create the new recording cluster.
6. Complete the fields for the Recording Cluster and then click Save.

Configuration Settings Used By Services
If you change the settings for a telephony group, the following table shows when your changes take
effect.
Telephony
Group Type

Service

Configuration settings applied when...

CUBE

CUBE SIP CTI
Service

Restart the service.

MediaSense

Monitoring and
Recording MediaSense Subscription service

Restart the service.

Unified CM

Recording CTI
Service

Restart the service.

Quality Management Administrator (VoIP
Devices)

Reload the VoIP Device window.

Desktop Record- Restart the service.
ing service
Network Record- Restart the service.
ing service

Note: If you add a backup Recording CTI
Service from the postinstall.exe while in Update
Mode, you must restart the Network Recording
service.
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Enterprise Settings
Use the Enterprise Settings window configure the settings for Quality Management.

The Enterprise Settings window allows you to:
n

Share login fields with other products. See the following topics for more information:
l

Sharing Unified Workforce Optimization with Multiple Products

l

Share Login Fields

n

Configure the locale for your system if your version of Quality Management supports
other languages in addition to English. See Configuring Quality Management for more
information.

n

Choose the default audio format for your recordings.
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n

Select the quality of your screen recordings:
Quality Level

Encoding Bit Rate

Screen Speed

Screen CPUs

Good

200

1 (real-time)

0 (1 code)

Better

400

2 (better)

1 ((cores/2)-1)

Best

600

2 (better)

2 (cores-1)

The higher the quality level selected , the more system resources are used.
n

Specify when the DB Cleaner service runs.

n

View license information and update software licenses, if you are not using an ACD, by
importing a new software license file. See Configuring Quality Management for more
information.

n

Configure the report logo that appears in reports generated in the Reporting application.
See Report Logo Configuration for more information.
Note: The Report Logo Configuration button is only enabled from postinstall.exe
or Quality Management Administrator on the Web Base server.

n

Configure session timeouts for Recording and Quality Management and Quality
Management Administrator. See Session Timeout Options for more information.

n

Configure the security mode to allow only secure and encrypted connections. See Service Security Mode for more information.

Sharing Unified Workforce Optimization with Multiple Products
Unified Workforce Optimization allows you to access several different products from a single login
page. You can choose to access all products with a single password or separate passwords for each
product when you run the postinstall.exe.

Best Practice: If you are using multiple Unified Workforce Optimization products, you should
configure your Jetty web server to use 1024 MB of RAM for each product.

Share Login Fields
You can choose to allow access to one or more of the following products from Unified Workforce
Optimization:
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n

Quality Management

n

WFM

You can also choose to share common login fields for these products by selecting the Share Login
Fields with Other Products check box. If you select this option for each product, users are prompted
for a single set of common login credentials.

Best Practices: Select the Shared Login Fields check box.
If a user is not configured for multiple Cisco products or the user wants to log into both of the Cisco
products with different login credentials, the user can select the Separate Product Logins check box
in the Login window.
If you do not select the Share Login Fields with Other Products check box, users are prompted for
separate login credentials for each Cisco product.
Cisco recommends using shared login fields when the users use the same username and password
for both products.
See the User Guide for more information on single-user login authentication.

Locale
Use the Locale section to enable the default language in the Unified Workforce Optimization interface.
Users can change the default language when they log in to Unified Workforce Optimization.

Note: The Locale section only appears when multiple locales are available.

To change the default locale for the Unified Workforce Optimization interface:
n

Select the desired language from the Locale drop-down list.

Storage Configuration
Use Storage Configuration to manage the storage of recordings, including: the default audio format
and the database cleanup time.
Choose the default audio format. Your options are as follows:
n

SPEEX—provides the smallest file size. Choose this option if your greatest concern is to
maximize storage space. When upgrading from 10.0 or lower, the default is SPEEX.

n

WAV-8—files are approximately four times larger than SPEEX files. Choose this option if
you want to compromise between greater audio fidelity and storage space.

n

WAV-16—files are approximately twelve times larger than SPEEX files. Choose this option
if you want the maximum audio fidelity and you are not concerned with storage space.

51

Configuring Quality Management
The Database Cleanup Time field specifies when the DB Cleaner utility runs. This utility deletes expired
recordings from the database. The value provided must be between 00: and 23:59 in 1-minute
increments. Choose a time when no uploads are occurring to reduce the load on the system. Default =
00:05.

License
This section displays the available licenses and allows you to import licenses. The license type
determines what Quality Management records. When a user logs into Unified Workforce Optimization,
that user has access to all Quality Management applications allowed by the license and roles assigned
to that user. The license determines what is recorded, not what is viewed, in Unified Workforce
Optimization.

Example: If Agents X and Y use AQM or AQMS+ license, they can record their screens. For
more information on Licensing, see "Mixed Mode Licensing" in the Design Guide.
What appears in the License section after the initial installation depends on whether the Synchronize
Users with ACD check box is cleared or selected. If you select the Synchronize Users with ACD check
box, you are running Quality Management with Unified CCX with mixed-mode licensing enabled.
Quality Management obtains the licenses from the Cluster View Daemon (CVD) in Unified CCX and
then displays the active license information in the License section. Your licenses can be updated
through Unified CCX Licensing.

Note: If a connection to the CVD cannot be made when initially running postinstall.exe, Quality
Management will continue to try connecting to the CVD. You will not be able go to the next
window until Quality Management can successfully connect to the CVD.

Note: If you add new license types (for example, change from only the CR license to the AQM
license), you must ensure Quality Management Administrator is configured to support the new
license types (for example, add a quality management workflow and assign users to the AQM
license).

Note: Beginning with QM 11.0, only the AQM and AQMS+ licenses are available. QM and
QMA licenses are not available.
Contact your sales representative to obtain a new license file.

To import a Cisco CR license file:
1. Click the Upload License button.
The Upload License File dialog box appears.
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2. Navigate to the folder where your updated Cisco CR license file is stored, and select the file.
If you are fixing a corrupted license, upload your existing license file.
3. Click Upload File.
The Licensing Server uploads the Cisco CR license file.

Report Logo Configuration
Report Logo Configuration allows you to customize the logo that appears in reports generated by the
Reporting application in Unified Workforce Optimization.
Custom logos must conform to the following specifications:
n

The logo must be 60 × 60 pixels

n

It must be in PNG format

n

The file must be named "logo.png"

To replace the default logo with your own custom logo:
1. Navigate to the C:\Program Files\Cisco\WFO_QM\Jetty\report_solutions\reports folder, copy the original logo.png and save it to a backup folder.
2. Copy and replace the custom logo.png to the following folders:
n

C:\Program Files\Cisco\WFO_QM\Jetty\report_solutions\reports

n

C:\Program Files\Common Files\QM\config

Note: By copying your custom logo file into the Common Files folder, it will be
available even if you upgrade to a new version. PostInstall automatically
copies it from the Common Files folder to the correct folder within the Quality
Management file structure every time it is run.
3. Start postinstall.exe or Quality Management Administrator.
4. On the Enterprise Settings window, click Report Logo Configuration.
5. Click Select New Logo, browse to the location of your logo, and then click Select Image.
6. Click Save.
7. Restart the Jetty service.
To restore the default logo:
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1. On the Enterprise Settings window, click Report Logo Configuration.
2. Click Use Default Logo and then click Save.
3. Restart the Jetty service.

Session Timeout Options
You can configure Quality Management Administrator or Recording and Quality Management in
Unified Workforce Optimization for one of the following options:
n

Close all open popup windows and log off the user after a specified number of minutes of
inactivity (session timeout)

n

Allow a user to remain logged in indefinitely (default setting)

To configure the session timeout period, enter the desired number of minutes of inactivity before
timeout occurs in the minutes field.

Note: When you change the Session Timeout value for Quality Management Administrator, you
must restart Quality Management Administrator before the changes can take effect.
If a user accessed one or more Recording and Quality Management applications, each application
displays a Timeout Warning dialog box 30 seconds before the application actually times out. If the user
does not respond to the Timeout Warning dialog box, the dialog box and the application are closed
and an alert is sent to the user stating that the application timed out and was closed.
When you are playing a customer conversation, the session remains in an active state. Unified
Workforce Optimization does not time out when you are playing a customer conversation.

Service Security Mode
If you configured the servers to run with Secure Socket Layer (SSL) and plan to use Hypertext Transfer
Protocol Secure (HTTPS), some traffic will continue through non-secure transport. Specifically, voice
and screen uploads will continue over non-secure transport as the data is already encrypted.
Select the Allow secure / encrypted connections check box to enable secure (HTTPS) connections for
traffic other than voice and screen upload. When this check box is selected, you must use HTTPS
when connecting to Unified Workforce Optimization. Once enabled, you will not be allowed to play
back recordings or live monitor a user if you are using HTTP to connect to Unified Workforce
Optimization.
When the check box is selected, the useSSL flag for web, voice, and screen servers will be set to true
and their httpPort setting will use the statically defined value of 7001.

Note: You will need to manually block port 80 if required. See the "Quality Management Port
Usage" in the Installation Guide for more information on port usage.
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When the check box is cleared, the useSSL flag for web, voice, and screen servers will be set to false,
and their httpPort setting will use port 80.

Pack noEnterprise Server Settings
Use the Enterprise Server Settings window to configure Active Directory. You can also configure the
method (SMTP or SNMP) used to notify administrator or supervisors of system problems, and enable
the ability to email reports.

Note: The Active Directory section appears in the Enterprise Settings window only if your
system is configured to use Active Directory.

The Enterprise Server Settings window allows you to:
n

Configure Microsoft Active Directory domains (in an Active Directory system only). See
Active Directory for more information.

n

Enable Kerberos Authentication for Recording Controls. When enabled, a user must
enter their AD credentials to access Recording controls. This check box is enabled only
when Active Directory is enabled.
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Note: You will be prompted to restart the Jetty service. Changes to Kerberos
Authentication goes into effect after the Jetty service is restarted.

n

Configure the method (SMTP or SNMP) used to notify administrators or supervisors of a
system problem and decide if emailing reports will be allowed.

Configuration Settings Used By Services
If you change the settings on the Enterprise Settings window, the following table shows when your
changes take effect.

Service

Configuration settings applied
when...

Quality Management Administrator (AD
Authentication and Administrator session timeout
change)

Log into Quality Management
Administrator.

Unified Workforce Optimization (AD Authentication
and localization changes)

Start the Data API service.

Kerberos Authentication for Recording Controls

Restart the Jetty service

Active Directory
The Active Directory section appears in the Enterprise Settings window only if your system is
configured to use Active Directory. Use the Active Directory section to configure Active Directory
domains.
n

There must be at least one domain configured

n

Each domain must have at least one user path configured

To add or delete an Active Directory domain from the Enterprise Settings window:
n

To add an Active Directory domain, click Add in the Active Directory section. The Domain
Information window appears. Complete the fields and click OK.

n

To delete an Active Directory domain, select the Active Directory domain you want to
delete from the list in the Active Directory section, and then click Remove.

Domain Information
The connection information that you enter for Active Directory in the Domain Information dialog box is
verified using the entered credentials, and the user paths are validated when you click OK in the
Domain Information dialog box.
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Field

Domain Type

Base DN

Description

Select the domain type:
n

Active Directory

n

OpenLDAP

The location of all Active Directory users in the directory server
tree. This field is autofilled with a sample format with variable
names that you replace with the domain information. Maximum
number of characters allowed = 1000. If your hostname has
more than 3 parts, add additional DC= domain statements to the
beginning of the Base DN field.
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Field

Description

Domain Name

Defaults to the first part of the string entered in the Base DN
field. In most cases this is the domain name, but in some cases
you must edit the default.

Host Name/IP Address

The host name or IP address of the Active Directory server.
Best Practices: Use a hostname in all instances where
you are required to specify a hostname or IP address, if
possible.

Port

The port used to access the Active Directory server. The field is
autofilled with the default port 389, or 636 if you are using SSL
(Secure Socket Layer).
Note: If you change the port to anything other than 389 or
636, clearing or selecting the Use SSL check box will not
change the port.
The Quality Management server must allow socket
communication on this port to be able to access the Active
Directory server for user authentication.
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Display Name

The name (not the login name, but the display name as
configured in Active Directory) of a user with read access to the
Active Directory database. Maximum number of characters
allowed = 1000.

User Password

The user’s password.

User Search Base

The node in the Active Directory folder under which the user
resides. Maximum number of characters allowed = 1000.

Use SSL

Select this check box to use SSL for connection to Active
Directory. The check box is clear by default and indicates SSL is
not enabled. Clearing or selecting this check box changes the
default port number in the Port field.
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Field

Admin Group

Description

The name of the security group in Active Directory. Only users
assigned to this security group can be assigned the system
administrator role.
Note: All users in the Admin Group must belong to the
same domain specified in the Base DN field.

Note: AD Account users associated with the Security
Group setting are not given an administrator role by
default.
To assign the system administrator role to a user in this security
group, see Administrator Configuration.
Best practice: Create a security group with a unique
name in Active Directory and add the users who you want
to have system administrator privileges in Quality
Management Administrator and Unified Workforce
Optimization. Specify the name of that security group in
this field. This prevents any conflict with default security
groups in Active Directory.
Note that adding users to the Domain Admins group is
not appropriate in this instance because the users in the
Domain Admins group also have permission to make
changes in Active Directory.
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Field

Add Certificate

Description

Locate the Certificate Authority (CA) certificate for Active
Directory. Active Directory with SSL requires this certificate.
The certificate provides the Active Directory identity and public
key for SSL communication.
Contact your Active Directory administrator for the location of
the CA certificate for Active Directory. In many cases, the
Certificate Authority on the Active Directory machine issues the
CA certificate for Active Directory. If this is the case, you can
access the certificate from:
http://<Active Directory server IP address
or hostname>/<certsrv>
You can use certificate enrollment tools other than certsrv in this
command.
Note: Quality Management can only import Distinguished
Encoding Rules (DER) encoded binary X.509 or Base64 encoded X.509 formatted certificates. These files
typically have one of the following extensions: der, pem,
or cer.
Download the certificate from this website by clicking Download
a CA certificate, Certificate Chain, or CRL and save it to a
folder. Then click Add Certificate to import the certificate.
Note: After you import the certificate and save your
changes, log out of Quality Management Administrator
and log back in to verify the certificate works.

View Certificate
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View the certificate associated with Active Directory.
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Field

User Records (OUs)

Description

One or more paths to user records (OUs). Click Add to add at
least one path, or Remove to remove an existing path.
Maximum number of characters allowed = 1000.
You must specify Active Directory paths from the most specific
to the least specific (from left to right in the path statement). For
example, if the Active Directory tree is:
ou=US
ou=Minnesota
ou=Minneapolis
ou=Users
Then the user record appears as follows:
ou=Users,ou=Minneapolis,ou=Minnesota,ou=US
Quality Management will search subtrees by default. For
example, you could write the user record path as follows, and
Quality Management will search all the subtrees under
Minnesota.
ou=Minnesota,ou=US

Add

Add a user record.

Remove

Remove a user record.

Edit

Modify a user record.

OK

Save your changes.

Cancel

Exit without saving changes.

SMTP Configuration
SMTP Configuration allows you to configure the SMTP email connection.

Note: This feature is only enabled on the Web Base server.
Notifications can be sent to the Event Viewer or in emails to specified recipients. To use email
notification, enable the Use Email Notification check box and then configure up to 5 email addresses.
Notification emails will be sent from the sender email address configured in the SMTP Configuration
dialog box. If you are using email notification, you must configure SMTP. This can be done only from
the Quality Management Web Base server.
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Field

Host Name/IP Address

Description

Choose Host Name or IP Address, and then enter the
hostname or IP address of the SMTP server.
Best Practices: Use a hostname in all instances where
you are required to specify a hostname or IP address, if
possible.
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Port

The port used by the MANA service to communicate with the
SMTP server.

Use Authentication

Select this check box if authentication is needed to access the
SMTP server.

User

The username required to access the SMTP server.

Password

The password required to access the SMTP server.
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Field

Authorization Type

Description

The type of authorization required. Your options are as follows:
n

NONE

n

BASIC

n

TLS

n

SSL

From Address

The email address from which all notifications will come.

Emergency Address

The email address where notification will be sent if the Quality
Management database is down when the MANA service
attempts to get its initial configuration. The notification email
addresses configured in the Monitoring and Notification window
are stored in the Quality Management database, and thus will
not be functional in the event that the Quality Management
database is unavailable when the MANA service first starts.
If the MANA service has already obtained a valid configuration
from the Quality Management database, and the Quality
Management database goes down while the MANA service is
running, the MANA service will use the valid configuration it
already has. As a result, the notification that the Quality
Management database is down will go to the configured email
address, not to the emergency address.

To configure SMTP settings for email:
n

Click SMTP Configuration, complete the fields, and then click OK.

SNMP Configuration
SNMP Configuration allows you to configure the Simple Network Management Protocol (SNMP)
connection.

Note: This feature is only enabled on the Web Base server.
Notifications can be sent by SNMP. SNMP is an application-layer protocol that provides a message
format for communication between Quality Management and a trap destination.

63

Configuring Quality Management

Field

Description

Trap Destinations

The available trap destinations.

Add

Add a trap destination.

Remove

Remove a trap destination.

Edit

Edit a trap destination.

To configure SNMP settings for notification:
n

Click SNMP Configuration, choose one of the following options, and then click OK.
l

Click Add to add a new trap destination.

l

Select a listed trap destination and then click Edit to change the IP address.

l

Select a listed trap destination and then click Remove to delete IP address.

Restart the Windows SNMP service to enable your changes.

Note: You must restart the SNMP service any time you make a change in trap destinations.

Allow Emailing of Reports
When selected, the Allow Emailing of Reports check box allows you to email a report to a specific
person or distribution list. For more information on creating a distribution list, see Notification
Distribution.
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Gamification Metrics
Use the Gamification Metrics window to configure the connection settings to allow the retrieval or
posting of gamification metrics. Additional configuration options are provided in Recording and Quality
Management when you log in to Unified Workforce Optimization.

The default metric for this window is Quality; you can add one or more additional metrics, either
Quality or Adherence.
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Field or Button

Metric Name

Data Pushed

Description

The name of the metric. The available metrics are as follows:
n

Adherence—the agents' adherence data. This metric is
pulled from WFM and requires additional configuration.
Once configured, Quality Management will retrieve the
nightly, as well as historical performance data from WFM.

n

Quality—the agents’ performance data from evaluations.
This metric is pushed from Recording and Quality Management and required no additional configuration.

Indicates how the data is collected. The options are as follows:
n

Yes—the data is pushed (or posted)

n

No—the data is retrieved (or pulled)

Server

The hostname or IP address of the server.

Add

Add a new metric.

Edit

Modify a selected metric.

Delete

Remove a selected metric.

Type

Select the metric type (Adherence). When you click Add, the
Add Gamification Metric dialog box displays this field.

Gamification Configuration
Use the Gamification Configuration dialog box to configure the connections settings for a selected
metric.
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Field or Button

Name

Data Collection

Historical Data Range

Description

The name of the metric. The available metrics are as follows:
n

Adherence—the agents’ adherence data. This metric is
pulled from WFM and requires additional configuration.
Once configured, Quality Management will retrieve the
nightly, as well as historical performance data from WFM.

n

Quality—the agents' performance data from evaluations.
This metric is pushed from Recording and Quality Management and required no additional configuration.

Choose one of the following options:
n

Data Push—When you select this option, the data is
pushed (or posted) to the specified server.

n

Data Pull—When you select this option, the data is
retrieved or pulled from the specified server.

Select an historical date range from the drop-down list.
This field is enabled when you select Data Push.

Request Historical Data

When clicked, Quality Management pushes historical data to the
specified server.
This button is enabled when you select Data Push.

Server Configuration Host- The hostname or IP address of the server container for the
name or IP Address
gamification metric. This field is enabled when you clear the
Data Push check box.

For the adherence metric, specify the hostname or IP address of
the WFM container.
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Server Configuration Port

The port number for the server for the gamification metric. This
field is enabled when you clear the Data Push check box.

Connection Configuration
Fetch Resource Address

The location of the API where the performance data will be
retrieved from. When you choose the Adherence metric, this
field is prepopulated with the path to the performance data and
cannot be changed.
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Field or Button

Description

Connection Configuration
Schedule

The schedule for retrieving the performance data. By default the
value is * * * * *. You can adjust the retrieval schedule to suit your
needs.
This field accepts a free form text value of the cron formatted
(http://www.nncron.ru/help/EN/working/cron-format.htm)
schedule.

Managing Gamification Metrics
To update connection details for a metric:
n

Click Update Connection Details, complete the fields in the Gamification Configuration dialog box, and then click OK.

Administrator Configuration
Note: When you upgrade to from 10.5 or earlier, the only administrator that exists will be the
default administrator. The default administrator is a system administrator. Users who were
assigned the administrator role in10.5or earlier will require additional configuration. After
upgrading to , you need to assign your administrator users based on the new hierarchical
administrative roles.
The Administrator Configuration window allows you to assign the system administrator role to users
who belong to the Admin Group. See the Domain Information for a description of the Admin Group
and Administrator for a description of the administrator roles.

Important: Once you assign the system administrator role to a user in a non-Active Directory
environment, the default administrator user becomes obsolete and you can no longer log in as
a default administrator.

Note: You can only promote users to system administrator from postinstall.exe on the Web
Base server.
If you are using Active Directory, the Administrator Configuration window will only display users in the
security group that have a complete configuration (including a Last Name).
If you are not using Active Directory, the Administrator Configuration window will display users
configured in the User Administration window.
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Field or Button

Description

Last Name

The user's last name.

First Name

The user's first name.

User ID
Is System Admin

When True appears in the field, the user is assigned to the
system administrator role. A blank field indicates the user is not
a system administrator.
To assign the business or telephony administrator role to a user,
seeUser Administration.

Windows Username
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The user’s Windows user name.
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Field or Button

Description

Domain

The user's domain name.

Add System Admin Role

To assign the system administrator role, select one or more
users who are not system administrators and click the Add System Admin Role button.

Remove System Admin
Role

To remove the system administrator role, select one or more
users who are system administrators and click the Remove System Admin Role button.

Managing Administrators
n

To assign the system administrator role, select one or more users who are not system
administrators and click the Add System Admin Role button.

n

To remove the system administrator role, select one or more users who are system
administrators and click the Remove System Admin Role button.

Site Settings
Use the Site Settings window to configure one or more sites and associate teams and Recording
Clusters with each site.
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When you install the Site Upload Server on a server, this is the first screen to appear in postinstall.exe.

Note: The Site Settings window only appears when you install the Site Upload Server.
You can use the Site Settings window to do the following:
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n

View the current site configuration

n

Modify or remove a site

n

Add or remove teams from a site

n

Add or remove Encoding Servers from a site

n

Add or remove Recording Clusters from a site

n

Change the default site

n

Specify when, where, and how many uploads can occur

Configuring Quality Management
n

Schedule uploading of peak and off-peak recordings from the agent desktops to the Site
Upload servers

n

Configure storage locations

n

Enable and configure two stage upload

Field

Description

Delete Selected Site

Remove an existing site.

Default Site

The default site is assigned to new teams that have not been
associated with a site. In rare circumstances, it also becomes
the default site when a service cannot find a site for a recording.

Site Name

The name of the site.

Peak Hours Begin

The time, in 24-hour format, when peak hours in the contact
center begin. Must be between 00:00 and 23:59 in 1-minute
increments. Default = 09:00.

Peak Hours End

The time, in 24-hour format, when peak hours in the contact
center end. Must be between 00:00 and 23:59 in 1-minute
increments. Default = 17:00.

Max Peak Hour Uploads

The maximum number of recordings that can upload
simultaneously during peak hours. Must be a value from 1 to
100. This limit is set to conserve bandwidth on the network.
When one upload completes, another takes its place, but there
can be no more than the configured number uploading at any
one time. Default = 5.

Max Off Hour Uploads

The maximum number of recordings that can upload
simultaneously during off hours (the hours not specified as peak
hours as defined by the Peak Hours Begin and Peak Hours End
fields). Must be a value from 1 to 200. This limit is set to
conserve bandwidth on the network. When one upload
completes, another takes its place, but there can be no more
than the configured number uploading at any one time. Default
= 100.
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Field

Storage Location

Description

You can change the storage location to any local or external
folder. You do not have to store recordings on the machine that
hosts the Site Upload Server.
If you change the storage location, you must run the Set
Recording Home Directory tool to restart the services.
Note: If you are using remote storage, the Media API that
is part of the Site Upload Server must run as a user who
has access to the location you choose for recordings.

IP Address

The IP address of the machine that hosts the Site Upload
Server and the voice recordings, and the path where voice
recordings are stored.

Cache Location

(Cloud-based storage only) The location where unencrypted
voice and screen recordings are stored. These files are used for
playback. The specified directory must be accessible by the local
system users and each of the Encoding servers. External
location credentials must be shared with the permanent storage
location.
A cache location is required if you are using cloud-based
storage. Unencrypted files must be stored separate from the
permanent storage location for performance reasons. Note that
the Jetty service must be restarted when you change the cache
location for the changes to go into effect.

Local Site Cache Location

Choose this option to store the unencrypted voice and screen
recording in a local site cache location.
Best Practices: If there is only one configured Media
Encoder and it is local, choose the Local Site Cache
Location for best performance.
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Field

External Site Cache Location

Description

Choose this option to store the unencrypted voice and screen
recording in an external site cache location.
Best Practices If there are one or more Media Encoders
and they are not local, choose the External Site Cache
Location. You can specify any network location
accessible to the Jetty services and all Media Encoder
services configured for this site.

Site Cache Location User- Enter the username required to access the site cache location.
name
This user must meet these requirements:
n

The site cache location must know the user (the user is a
trusted domain user).

n

If the user is a domain user, the domain specified must be
trusted by the site cache location. This means the site
cache location that you are configuring has to be on a
domain that trusts or is trusted by the domain you are
entering.

n

The user must be able to log on as a service.

n

The user must have read and write access to both the site
cache drive location entered AND the location where
Quality Management is installed on the local server.

Note: The Jetty and Media Encoder services must be
running as this user.
Site Cache Location Pass- Enter the password required to access the site cache location.
word

Local Storage Location

Choose this option to store the voice and screen recordings on
the Quality Management server.
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Field

External Storage
Location

Description

Choose this option to store the voice and screen recordings on
an external server.
Note: The default path is C:\Program Files\Common
Files\QM\Recordings. If you need to change the path, do
not specify the root directory (for example, D:\ or E:\).
Always include at least one folder in the path (for
example, D:\Cisco).

Storage Location Path

The path where voice and screen recordings are stored. Click
Browse and navigate to the storage folder.
Note: The default path is C:\Program Files\Common
Files\QM\Recordings. If you need to change the path, do
not specify the root directory (for example, D:\ or E:\).
Always include at least one folder in the path (for
example, D:\Cisco).

Browse
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Field

Storage Location
Username

Description

If you selected an external storage location, enter the username
required to access that location. If the user is a domain user,
enter the name with the format <domain>\<username>.
For external screen storage and playback to work, you must
provide a domain user that has read and write access to the
local server and the external storage system.
This user must meet these requirements:

Storage Location
Password

n

The local server must know the user (the user is a trusted
domain user).

n

If the user is a domain user, the domain specified must be
trusted by the local server. This means the Recording
Server that you are configuring has to be on a domain that
trusts or is trusted by the domain you are entering.

n

The user must be able to log on as a service.

n

The user must have read and write access to both the
external drive location entered AND the location where
Quality Management is installed on the local server.

If you selected an external storage location, enter the password
required to access that location.
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Field

Description

Enable Two Stage Upload

When selected, two stage upload is enabled. Two stage upload
immediately uploads screen and audio recordings to a
temporary storage location. You can then configure a workflow
to upload files from the temporary storage location to the
permanent storage location at the End of Day.
Two stage upload functions in one of two manners:
1. If you are using Desktop Recording (or Gateway Recording), the Desktop Recording service will round robin through
all Recording Servers associated with the site. This will happen regardless of the location of the Recording Servers. If
you are using Desktop Recording and need to limit your
uploads to a local Recording Server, you will need to configure a site for that location.
2. If you are using Server Recording, the Desktop Recording
service will round robin through Recording Servers that are
in the same cluster as the agents. All recordings will go to
your local Recording Cluster. If no configuration information
is available for your local Recording Cluster, no recordings
will upload from those agents.
Enable two stage upload when:
n

Your contact center has multiple sites that are separated
by a WAN and you want to use the Immediate Upload feature but you have limited bandwidth.

n

You are using Desktop Recording and your contact
center requires the agents to shut down their desktop at
the end of a shift. Shutting down the desktop interrupts
the scheduled upload based on the agent's workflow.
Two stage upload ensures the recordings are
immediately uploaded to the temporary storage location
after a call.
On startup, the Desktop Recording service retrieves all
site information, including all two stage upload locations.
When a call ends, recordings are moved to a temporary
storage location and then uploaded to the permanent

78

Configuring Quality Management

Field

Description

storage location. The files are moved in the following
order: voice, screen, ini. If there are no two stage upload
locations, two stage uploads are turned off.
Recordings are uploaded using the round-robin method to the
available storage locations.
Note: When two stage upload is enabled, it is possible
that voice and screen recordings for a call might be stored
in different storage locations.
When cleared, recordings are uploaded directly to the central
storage location. When the upload occurs is determined by the
workflow assigned to the agent.
This check box is only enabled when at least one Recording
Cluster is assigned to the site.
Configure Two Stage
Upload

Click this button if you want to configure a temporary storage
location. The Two Stage Upload Configuration dialog box will
display the Recording Servers associated with the Recording
Clusters assigned to the site. Click the Modify button associated
with the selected server to configure the UNC path, username,
or password to that server.
This button is enabled when you select Enable Two Stage
Upload and at least one Recording Cluster is assigned to a site.

Two Stage Upload Configuration Server

The IP address or hostname of the of the Recording server that
hosts the temporary storage location.
This field appears in the Two Stage Upload Configuration dialog
box.
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Field

Two Stage Upload Configuration UNC

Description

The storage location path to the TwoStageLocation folder on
the Recording server where voice and screen recordings are
temporarily stored. The path must be in UNC format. The
default path is as follows:
\\<server>\TwoStageLocation
where <server> is the IP address or host name of the Recording
server that host the temporary storage location.
The TwoStageLocation folder is automatically created the first
time the Recording server is started. The default path is as
follows on the Recording server:
<temporary recording storage location>\TwoStageLocation
where <temporary recording storage location> is the path to the
temporary recording directory. See Set Temporary Recording
Directory for more information.
Important: The TwoStageLocation folder properties must
be shared using Advanced Sharing and a username and
password must be configured to access this folder. The
user must be allowed the following permissions: Full
Control, Change, and Read. Quality Management uses
this path and the specified user name and passwords to
access the TwoStageLocation folder.
This field appears in the Two Stage Upload Configuration dialog
box.

Two Stage Upload Configuration Username

Enter the username required to access the TwoStageLocation
folder on the Recording server.
This field appears in the Two Stage Upload Configuration dialog
box.

Two Stage Upload Configuration Password

Enter the password required to access the TwoStageLocation
folder on the Recording server .
This field appears in the Two Stage Upload Configuration dialog
box.

Modify

Click this button to modify the fields in the selected row.
This button appears in the Two Stage Upload Configuration
dialog box.
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Field

Description

Team

A list of assigned teams.

Encoding Server

A list of assigned Encoding Servers.

Recording Cluster

A list of assigned Recording Clusters.
Note: Assigning a Recording Cluster to a site takes
precedence over a team. So a if a user is assigned to
Team 1 on Site 1, but is associated with Recording
Cluster A on Site 2, the recordings for that user will be
uploaded to Site 2.

Edit

Modify the assigned teams, Encoding Servers, or Recording
Clusters.

Site Considerations
If you plan to use multiple recording storage locations, you can associate each recording storage
location to a site.
When configuring sites, consider the following:
n

A site is a single Site Upload server associated with a set of teams. A site can be
configured to be the system’s default site. The default site is used for teams that have
not been associated with a site or whenever a recording service cannot find a site for a
recording (this can happen in rare circumstances).

n

You can configure one or more sites for a Quality Management system and define the
teams that are assigned to each site.

n

When a site is taken down for maintenance or failure, the recordings created by the
agents while the site was down will be uploaded when the site recovers.

n

When upgrading from 9.0 or earlier, Quality Management will create a single site and
assign the Site Upload server, Upload Controller service, and all defined teams to that
site. Peak and off-peak settings will also be moved to the site. Once Quality Management
is installed, you can add more sites.

n

When an agent plays a recording from the Recordings application, the Recordings
application will play back the recording from the Site Upload server that is associated
with the agent’s team.
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n

For Desktop Recording, Quality Management records the agent’s calls while the agent is
logged in to the desktop. When the agent logs out, the recordings are uploaded to the
Site Upload server that is associated with the agent’s team. It is possible to have two different agents using the same computer at different times and have their recordings
uploaded to different Site Upload servers.

The following figure shows three sites—two external sites that communicate with the rest of the system
over a WAN and one site that communicate over a LAN. Each site has a Site Upload server with an
Upload Controller and a Recording Cluster. Each site has one or more teams assigned to it and the
users in those teams will upload to the proper site.

Multiple site configuration example

Site recording storage location example: The Web Base server is located in the United
States (site 3) and a Site Upload server is located in Germany (site 1) and all the German teams
or groups are assigned to the German site. When a German agent records a call, the recording
is uploaded to the German site recording storage location in Germany. When the agent plays
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back the recording, the recording is retrieved locally and avoids wide area network (WAN)
traffic.

The following figure shows two sites using two stage upload feature.

Two stage upload example: Immediately after a call, Site A and Site B upload the recordings
to their Recording server that hosts the temporary storage location. At the End of Day, the
recordings are then uploaded to the permanent storage location.

Managing Site Settings
n

To view the existing site configuration, click Site Settings.
The Site Settings window appears.

n

To view a different site, click the tab associated with the site.
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New sites appear in Site settings when you install Quality Management on the server
associated with the new site and configure the new site in the Site Settings window.
n

To remove a site:
1. Click the tab for the site you want to remove.
2. Click Delete Selected Site.
3. Click Yes in the Confirm Delete dialog box.
4. Choose where you want to move recordings from the deleted site, and then click OK.
5. Manually remove the recording files stored at the deleted site, and then click OK.
6. Open the Services window on the server and stop the following services:
l

Quality Management DB Proxy Service

l

Quality Management DB Cleaner Service

7. Click OK in the Proceed? dialog box to continue.
8. Click OK to dismiss the Save Successful dialog box.
The Manually Move Recordings dialog box appears. You need to manually move the
existing recordings from the server associated with the old site to the server associated
with the new site. The teams from the old site are now assigned to the new site and
future recordings for those teams will now be stored on the server for the new site.
n

To modify a site, select the site’s tab, complete the fields, and then click Save.

n

To change the default site, select a site from the Default Site drop-down list, and then
click Save.

n

To modify the current upload settings for a site, click the site’s tab, complete the fields
under Peak Uploads, and then click Save.

n

To change the recording storage location:
a. Complete the fields under Storage Location and then click Save.
b. Select Tools > Set Recording Home Directory to restart the services.

n

To enable two stage upload:
a. Select Enable Two Stage Upload.
b. Click Configure Two Stage Upload.
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c. Click Modify and complete the fields.
d. Click OK.
n

To modify the list of assigned teams, Encoding Servers, or Recording Clusters to a site,
select the site’s tab, click Edit under Team, Encoding Server, or Recording Cluster, and
choose one of the following options: select one or more teams, Encoding Servers, or
Recording Clusters from the Teams, Encoding Servers, or Recording Clusters list and
click the > button to move the teams to the Assigned Teams or Assigned Recording
Clusters list. To move all teams or Recording Clusters to the Assigned Teams or Assigned
Recording Clusters list click the >> button, and then click Save.
l

l

Add teams, Encoding Servers, or Recording Clusters. Click Edit under the option
that you want to modify, select one or more items from the available list and click
the > button to move the selected items to the assigned list, or click the
>> button to move all items to the assigned list, and then click OK.
Remove teams, Encoding Servers, or Recording Clusters. Click Edit under the
option that you want to modify, select one or more items from the assigned list
and click the < button to move the selected items to the available list, or click the
<< button to move all items to the available list, and then click OK.

Configuration Settings Used By Services
If you change the settings on the Site Settings window, the following table shows when your changes
take effect.
Service

Configuration settings applied when...

Upload Controller service

The next End of Day applies the configuration settings. If you
want the changes to take effect immediately, restart the Upload
Controller service.

DB Cleaner service

The next cleanup time applies the configuration settings. If you
want the changes to take effect immediately, restart the DB
Cleaner service.

Media webapp (Jetty
service)

Restart the Jetty service.

Network Recording service

If two stage upload is enabled and you move a Recording
Cluster from one site to a different site, you must restart the
Network Recording service for that Recording Cluster for the
changes to take effect.
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External Storage and Services
If you select External Storage Location in the Site Settings window in System Configuration Setup, you
must configure the Jetty service.
This step must be done after you install the Quality Management Web Base Services and before you
start recording contacts.

To enable external storage and services:
1. Create a username and password for the external storage user on the external storage
server.
2. Configure the Jetty service for external storage.
To configure services for external storage:
1. Select Start > Administrative Tools > Services.
The Services window appears.
2. Right-click Monitoring and Recording Jetty service and choose Properties.
The Monitoring and Recording Jetty Service Properties window appears.
3. Click the Log On tab, choose This Account by providing the username and password for the
external storage server, complete the fields, and then click Apply.
If the provided information is correct, the following message will appear:
The account .\<username> has been granted the Log On As A
Service right.
where <username> is the username you provided in the This Account field.

Inclusion List
Quality Management uses the Inclusion List window to determine which calls to record and which
calls to ignore. Quality Management only records calls that match the extension patterns in the
Patterns to be Recorded list.
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A tab appears in the Inclusion List window for each configured telephony group. You can configure
extension patterns for inclusion or exclusion for each telephony group.
The Patterns to be Recorded list contains extension patterns that will be recorded. By default, the
Patterns to be Recorded list displays an asterisk (*) in the Pattern column, Extension in the Type
column, and Either in the Direction column. This indicates that all incoming and outgoing calls on all
extensions in the telephony group will be recorded. As soon as specific extension patterns are
configured in the Patterns to be Recorded list, recording is limited to those extension patterns only.
The Pattern column lists the extension pattern that will be filtered in the Patterns to be Recorded or
Patterns to be Excluded from Recording lists. You can use the following wildcards to configure ranges:
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n

The asterisk (*) in a string can represent any quantity of any character, as long as the
other characters in the string match.

n

The question mark (?) in a string can be replaced by any character, but the length of the
string must be exactly as represented.

Extension patterns can be further filtered by selecting:
n

The direction of the call (for recorded calls only). Your options are:
l

Inbound—filters all inbound calls that match the extension pattern

l

Outbound—filters all outbound calls that match the extension pattern

l

Either—filters all inbound and outbound calls that match the extension pattern

See Gateway Recording Considerations and Cisco MediaSense Recording Considerations
for more information.
n

The type of call. Your options are:
l

l

l

l

l

Any—filters all called, calling, and extensions calls that match the extension
pattern
Called—fillers all calls received by the phone numbers that match the extension
pattern
Calling—filters all calls made by the phone numbers that match the extension
pattern
Extension—filters all extensions that match the extension pattern
Excluded—excludes all inbound or outbound calls that match the extension pattern.

To rearrange the order of extension patterns that appear in the Patterns to be Recorded list, select an
extension pattern from the list and use the Up or Down arrow buttons to move the extension pattern to
the desired location. Extension patterns are filtered starting at the top of the list and continues down to
the bottom of the list.
The Patterns to be Excluded from Recording list displays extension patterns that will not be recorded.
Extension patterns that appear in the Patterns to be Excluded from Recording list are filtered before
any extension patterns that appear in the Patterns to be Recorded list. Only extension patterns found
in the Patterns to be Recorded list will be recorded.
You can also import or export an inclusion/exclusion list for a single telephony group. Changes to the
inclusion/exclusion list take effect the next time the CTI service polls for configuration (five minutes at
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most). Importing or exporting a large inclusion/exclusion list is quick (Less than five seconds).
However, it might take up 30 seconds to save a large inclusion/exclusion list to the database.
Any changes you make to the Inclusion List take window take effect at the next recording client login.

Field

Description

Add

Add an extension pattern.

Remove

Remove an extension pattern.

Modify Type

Change the call type associated with an extension pattern.

Modify Direction

Change the direction associated with an extension pattern.

Import

Allows you to select the location and name of an
inclusion/exclusion file to import. The file must be in CSV format
(see CSV Format for more information). Importing an
inclusion/exclusion list overwrites the existing file. An import
does not merge changes.
Note: If the CSV file has errors in it, the import will fail and
the existing data will remain unchanged. An error
message will indicate why the import failed and identify
the record that failed if applicable.
After importing a CSV file, you must click Save to save your
changes.

Export

Allows you to select the location and specify a name for the
exported inclusion/exclusion list. The file must be in CSV format.
Once exported, you can open the file in Microsoft Excel.

CSV Format
The CSV file containing the inclusion/exclusion list must use the following format:
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Pattern

A number pattern with optional * and ? wildcards

Type

One of the following
types:

Bounds

One of the following
directions:

n

Extension

n

Inbound

n

Calling

n

Outbound

n

Called

n

Either

n

Any

n

Excluded

When creating an inclusion/exclusion list, remember the following points:
n

Exclusions are matched before inclusions, but exclusions can appear anywhere in the
CSV.

n

Within each group (inclusions and exclusions), patterns are matched starting from the
top and working down the list.

n

Additional columns after Pattern, Type, and Bounds are allowed in an imported CSV.
However, the additional columns will be ignored.

Gateway Recording Considerations
The considerations in this topic apply to the following Gateway Recording method:
n

Cisco CUBE Recording via SIP Recording

When the call direction cannot be determined, the Inclusion List will only match a Direction with a
value of Either. All calls, both inbound and outbound, appears as inbound. Cisco recommends setting
the value of the Direction to Either when creating an exclusion for a Gateway Recording method.

Cisco MediaSense Recording Considerations
If you are using Cisco MediaSense Recording, the Inclusion List affects which recordings are
uploaded to Quality Management. Initial recording decisions are based on the Cisco MediaSense
configuration.
When configuring the Inclusion List for Cisco MediaSense Recording, consider the following:
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n

The entire call is recorded and saved on the Cisco MediaSense Recording cluster.

n

Quality Management only downloads Cisco MediaSense recordings that appears in the
Patterns to be Recorded list.

n

Quality Management does not download Cisco MediaSense recordings that appear in
the Patterns to be Excluded from Recording list.
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n

When the call direction cannot be determined, the Inclusion List will only match a Direction with a value of Either. Cisco recommends setting the value of the Direction to
Either when creating an exclusion for Cisco MediaSense Recording.

Managing Extension Patterns
To manage extension patterns:
1. Select the appropriate telephony group cluster tab in the Inclusion List window.
2. Choose one of the following options:
n

Add an extension pattern. Click Add beneath the Patterns to be Recorded or
Extensions to be Excluded, type a number in the Add Pattern dialog box, click OK, and
then complete the remaining fields in the table.
You can enter the exact number or use the * or ? wildcards plus numbers to
configure a range of numbers. For example:
Enter This:

To Record:

6124

Number 6124.

61*

Any number that start with 61 and are of any length.
Example: 6124, 61555, 613

61??

Any number that start with 61 and are 4 digits long.
Example: 6124, 6125, 6126

n

Modify a call type. Select an extension pattern, click Modify Type, select the different
type from the drop-down list, and then click OK.

n

Modify a call direction. Select an extension pattern, click Modify Direction, select a
different direction from the drop-down list, and then click OK.

n

Remove an extension pattern. Select the extension pattern in Patterns to be Recorded or Extensions to be Excluded, click Remove, and then click OK.

n

Import an inclusion/exclusion list. Click Import, select the location, the file name of
the inclusion/exclusion list, click OK, and then click Save.
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n

Export an inclusion/exclusion list. Click Export, select the location, type the file name
of the inclusion/exclusion list, and then click OK.

3. Click Save.

Excluding Extension Patterns
If you have a limited number of extension patterns you want to exclude from being recorded, you can
configure the Inclusion List to ignore only those extension patterns and record all others.

Example: If you want to record all extension patterns except for extensions 3411, 3412, and
3413, configure your inclusion list so that there is an asterisk in the Patterns To Be Recorded
list, and extensions 3411, 3412, and 3413 listed in the Patterns To Be Excluded From
Recording list.
Extension patterns listed in the Patterns To Be Excluded From Recording list always take precedence
over extension patterns listed in the Patterns To Be Recorded section. You cannot use the same
extension pattern (specifically or through the use of wildcards) in both lists.

Example: 12* cannot appear in both lists.

Monitoring and Notification
Use the Monitoring and Notification window to enable the Monitoring and Notification (MANA) service
and add a distribution list for notifications.
The following image displays the Monitoring and Notification window for Unified CCX.
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Only one notification trigger requires configuration: Problem ID QM3002 under QM Task Settings. This
trigger compares data in the Unified CM’s Call Detailed Records (CDR) Report (for Unified CM versions
8.x+ and 9.x) with the Quality Management database. Specifically, it compares the call records in the
Unified CM with the call records in Quality Management. If there is a discrepancy, notification is sent.

Note: The MANA CDR Report (QM3002 notification trigger) does not support devices that are
recorded by Cisco MediaSense. If your site is a mixed-recording environment where Server
Recording, Network Recording, or Desktop Recording and Cisco MediaSense Recording are
used together, the CDR Report will not be accurate since Cisco MediaSense devices result in
false positives.
By default, Problem ID QM3002 is disabled. The notification trigger does not have to be configured
unless you enable that problem ID in the Notification Distribution dialog box.
You can create multiple distribution lists. For each distribution list, you can choose to specify the
events that trigger notification.

Example: You can set up a distribution list for global outages (all QM1000 level errors) and all
“JTAPI not associated with a device” (specific QM2002 error).
You can also configure the following information:
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n

Distribution list of persons receiving notification, if you configure email as a means of
notification

n

Email address of the person(s) receiving notification, if you configure email as the means
of notification

n

Trap destinations receiving notification, if you configure SNMP as the means of
notification

n

If and how often a renotification of the problem should be sent out

n

Types of problems that will trigger notification

Note: You can only change the information in the Monitoring and Notification window from the
postinstall.exe or Quality Management Administrator on the Web Base server. The Monitoring
and Notification window in Quality Management Administrator on a desktop is read-only.
Connection information is saved locally to the Web Base server so the emergency user can still be
notified using email if a major component (for example, the database) is down, and the other email
addresses are not available. This allows the Quality Management Administrator to edit the emails and
allows Monitoring and Notification to notify one user when the configuration is not accessible.

Field or Button

Description

Use Monitoring/
Notification Service

Select this check box to enable the MANA service. If enabled, at
least one notification method (event viewer, SNMP, or email)
must be enabled as well. This check box is selected by default.

Distribution List

The available distribution lists.

Add

Add a distribution list.

Remove

Remove a distribution list.

Edit

Edit the selected distribution list.

Polling Period

Sets the interval at which the MANA service checks for the
selected notification triggers. Default = 10 minutes, Minimum = 0
minutes, Maximum = 1440 minutes (1 day). The timer starts
when the last polling task is complete.
Note: When you change the polling period, it takes one
polling cycle before the new polling period goes into
effect.
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Field or Button

Description

Never

Choose this option if you do not want to be renotified of a
problem after the initial notification.

Every N Polling Periods

Choose this option if you want to specify how frequently you
want renotification to occur after the initial notification and
specify the number of polling periods. For example, if you
choose to be notified every 3 polling periods, you receive the
initial notification on the first polling period the problem is
detected, no notification the next two polling periods, and then
another notification on the next polling period. This pattern will
continue as long as the problem is detected.

Every Polling Period

Choose this option if you want renotification to occur every
polling period after the initial notification.

QM Task Settings

The fields listed in the QM Task Settings section are used to
configure QM3002.

Miss Threshold

Percentage of missed CDRs required to trigger notification.

Minimum Misses

Lowest number of missed CDRs required to trigger notification.

Notify on users
configured in QM

When you select this option, Quality Management only
generates notifications about users who are configured in
Quality Management.

Notify on users that are
logged in

When you select this option, Quality Management only
generates notifications about users who are currently logged in
to a desktop where the Desktop Recording service is installed.
This only applies to the Desktop Recording service.

Display Type

Choose one of the following options.
n

Summary Only—displays 1 row per agent with missed
CDR that meet the above criteria. See Summary Only for
an example.

n

Details (Tab Delimited)—displays each missed CDR in tab
delimited format. See Detail (Tab Delimited) for an
example.

n

Details (Plain Text)—displays each missed CDR in text
format. See Detail (Plain Text) for an example.
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Configuration Settings Used By Services
If you change the settings on the Monitoring and Notification window, the following table shows when
your changes take effect.
Service

MANA service

Configuration settings applied when...

The next polling period applies the configuration settings.

Notification Distribution
The Notification Distribution dialog box allows you to create a distribution list, specify the notification
type for the distribution list, and assign the type of MANA alerts that are sent to the distributions list.
The following image displays the Notification window for Unified CCX.

The MANA alerts are classified as follows:
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n

QM1xxx—indicates a global outage that might affect recording for the entire system.

n

QM2xxx—indicates individual outages that might affect recording for individual users.
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n

QM3xxx—indicates a possible configuration problem. The notifications might not point to
an actual issue, so you might want to turn these notifications off to avoid unnecessary
notifications.

n

QM4xxx—indicates a problem with MANA that prevents it from reporting problems.

Field

Description

Distribution List Name

The name of the distribution list.

Notification Type

The type of notification you want to use to send notification messages. Your options are:

Email Addresses

n

Event Viewer—use the Event Viewer for displaying
notification messages

n

Email—use email for sending notification messages

n

SNMP—use SNMP for sending notification messages

The list of email addresses to which notification is sent.
Maximum = 5 email addresses. A comma is required to
separate two or more email addresses.
Example: jane.doe@acme.com,
john.smith@acme.com, robert.dee@acme.com

Note: This field is enabled when you select Email as your
notification type.
Available Problems

The list of problems that will not trigger notification. Move any
problem that does not require notification to the Available
Problems list. QM3002 appears in this list by default.
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Field

Enabled Problems

Description

The list of problems that will trigger notification. By default, all
problems are enabled, except for QM3002. You must configure
QM3002 under QM Task Settings in the Monitoring and
Notification window before you can enable this Call Detail
Record (CDR) task.
Note: QM3002 is not supported with Cisco MediaSense
Recording.
See Configuring the QM3002 Notification Trigger for more
information.

Managing Notification Distribution Lists
To manage notification email addresses:
n

To add a distribution list, perform the following steps.
l

Click Add in the Notification Distribution section.

l

Type the name of the distribution list in the Distribution List Name field.

l

l

l

Type the email addresses that are included in the distribution list in the Email
Addresses field.
Move the type of problems you want sent to this distribution list to the Enabled
Problems list.
Click OK.

The new distribution list appears in the Distribution List.
n

To remove a notification distribution list, select the distribution list from the Distribution
List, click Remove, and then click OK.
The distribution list is removed from the Distribution List.

n
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To edit a notification distribution list, select the distribution list from the Distribution List,
and click Edit. In the Notification Distribution dialog box, modify the distribution list that
you want to change, and then click OK.
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Status
The Status window reports the version of the installed Quality Management components and displays
the status of the signaling servers by telephony group. Click refresh to see the latest signaling server
information.

Configuration Settings Used By Services
If you change the product version, the following table shows when your changes take effect.
Service

Upload Controller service

Configuration settings applied when...

Periodically check for a version mismatch.

Manually Installing the Cisco JTAPI Client
Follow the instructions in this task only if the postinstall.exe did not automatically install the Cisco JTAPI
Client in the Cisco environment.

Note: This task is not required if you are configuring Quality Management for Cisco
MediaSense Recording.
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To manually install the Cisco JTAPI Client:
1. Stop the Recording CTI service or CUBE SIP CTI service.
2. Download the Cisco JTAPI Client from the Unified CM Plug-ins webpage.
3. Install the Cisco JTAPI Client on the Quality Management server where the Recording CTI service or CUBE SIP CTI service is installed.
4. Copy the jtapi.jar file from the C:\WINDOWS\ java\lib folder to the C:\Program
Files\Cisco\WFO_QM\ext folder
If you are not using the default path to the java\lib folder specified in step 4, copy the
jtapi.jar file to correct folder.
5. Start the Recording CTI service or CUBE SIP CTI service.
6. Start postinstall.exe in C:\Program Files\Cisco\WFO_QM\bin.
7. Choose Tools > Test CTI Service.
The CTI Service Ready dialog box appears and displays the following message:
The CTI Service test completed successfully.
8. Click OK to dismiss the dialog box and close the System Configuration Setup window.

Rules for Upgrading or Modifying the ACD Database in
Update Mode
Observe the following rules when you change access to the Unified CCX Administration database in
update mode:
n

Do not change the location of the Unified CCX Administration database after initial setup.
If you do, you might be unable to access Quality Management historical data if the
structure and contents of the new database is not the same as that of the old database.

n

Stop the Sync Service and disable this service on startup to protect the Quality
Management database before you upgrade or rebuild the Unified CCX Administration
database.

Stopping the Sync Service Before Upgrading the ACD Database
Perform this task before you upgrade the Unified CCX Administration database.

To stop the Sync service:
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1. Select Start> Administrative Tools > Services. The Services window appears.
2. Right-click Monitoring and Recording Sync Service and choose Stop.
3. Right-click Monitoring and Recording Sync Service again and choose Properties.
The Monitoring and Recording Sync Service Properties window appears.
4. Choose Disabled from the Startup Type drop-down list, and click OK to save your changes.
5. Upgrade or rebuild the Unified CCX Administration database.
6. Return to the Services window, right-click Monitoring and Recording Sync Service and
choose Start.
7. Right-click Monitoring and Recording Sync Service again, choose Automatic from the
Startup Type drop-down list, and then click OK to save your changes.
This action enables the Sync Service on startup.
Note: Do not start Sync Service and enable the Sync Service for the hardware profile
until both Unified CCX Administration databases (if using High Availability) are running
and synchronized because the Sync Service reads data from the Unified CCX
Administration database. Failing to do so could potentially deactivate users if there
is a problem with the Unified CCX Administration upgrade or rebuild.
8. Verify the teams and agents in the upgraded Unified CCX Administration appear correctly.

Changing the Web Base Server
To change the IP address or host name for the Web Base server:
1. From the postinstall.exe, choose File > Choose Base Server.
The System Configuration Setup dialog box appears window appears.
2. Choose the network address type. Your options are:
l

IP Address—the IP address of the base server.

l

Host Name—the FQDN or hostname of the base server.

3. Enter the IP address or hostname of base server.
The base server is the computer where you installed the Web Base Services, Database
Services, Voice/Screen Services, and signaling service.

101

Configuring Quality Management

4. Enter the IP address or hostname of the Unified Workforce Optimization Container.
The Unified Workforce Optimization Container is located on the base server.
If you also purchased WFM, this product will share this container once it is configured to
point to this container. The following figure displays the System Configuration Setup dialog
box.

5. Choose one of the following options:
l

l

If you are running postinstall.exe on the base server, choose the IP address or
hostname of the base server from the Local Services drop-down list, and then click
OK.
If you are running postinstall.exe on a different server, choose the IP address or
hostname for the server from the Local Services drop-down list, and then click OK.

Example: If you want to run Network Recording on a different server and installed
the Network Recording service and Monitor service on that server, choose the IP
address for the Network Recording server from the IP Address for Local Services
drop-down list. If the computer has multiple NICs, multiple addresses appear in the
IP Address for Local Services drop-down list. Choose the IP address used for network
traffic.

To change the configuration data in update mode:
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1. Start postinstall.exe.
This executable is located in the C:\Program Files\Cisco\WFO_QM\bin folder.
2. Select the window you want to modify from the left pane, enter the new data in the right
pane, and then click Save on the toolbar or File > Save from the menu bar.
n

You can display the windows in any order you wish.

n

If you modify something in a window, you must click Save to save your changes
before you move on to another window.

n

If you make a change to a window but need to change back to the original
setting, click the Revert to Saved button on the toolbar. This discards any
changes you made that have not been saved, and restores the settings in the
window to the last saved version.

3. When you finish, choose File > Exit or click Close.
System Configuration Setup closes.
4. Stop and restart the modified service and all desktops for the change to go into effect.

System Configuration Setup Tools
System Configuration Setup (postinstall.exe) provides a number of tools you can use to update your
site information. These tools are available through the Tools menu. These tools normally run during
the initial installation of Quality Management.
The Tools menu, in postinstall.exe, only enables tools when the tools are available on the server where
you are running the postinstall.exe.
The following table displays the available tools and the servers on which they are located.
Tool availability in Postinstall
Servers

Tool

Web
Base

Operations

Data
base

Site
Upload

CTI

Voice
Record
& Monitor

x

x

x

Start Local Services

x

x

Create Database
Catalogs

x

x

Media
Encoding

x
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Servers

Tool

Generate Info for
MSI Clients

Web
Base

Operations

Data
base

Site
Upload

CTI

Voice
Record
& Monitor

x

Download/Install
JTAPI

x

Encrypt Audio Files

x

Set Recording
Home Directory

x

Generate SSL Certificates

x

Test CTI Service(s)

x

x

x

x

x

Test MediaSense
Subscription Service

x

x

x

x

x

Display Metadata
Encryption Key

x

x

x

x

x

x

Choose Monitor
Adaptor
Remove Recording
Services

x

x

x

x

x

x

x

Set Temporary
Encoding Directory

x

SIP Trunk Certificate
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x

x

Set Temporary
Recording Directory

Change
IP Addresses or
Host Names

Media
Encoding

x*

x

x

x

x
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Servers

Tool

Web
Base

Operations

Data
base

Site
Upload

CTI

Voice
Record
& Monitor

Recording File
Encryption Key

Media
Encoding

x

* When using secure SIP or SRTP, the CTI server requires a SIP Trunk Certificate.

Start Local Services
This tool offers a convenient way to start all the Quality Management that are on the local computer.
You can run this tool any time. However, you should notify users because restarting services might
cause outages.

Create Database Catalogs
This tool creates a new Quality Management database if one does not exist or updates an existing
database to the latest schema version without overwriting any existing data. You can use this tool to
recreate your Quality Management database if you have no backup database and your database was
corrupt and you deleted it. This tool populates a fresh database when the Unified CCX and Data API
sync with it.

Generate Info for MSI Clients
This tool updates the information required by the MSI client installation programs to successfully
install the Desktop Recording service, Recording Thin Client, and Quality Management Administrator.

Download/Install JTAPI
Use this tool when you upgrade Unified CM. This tool downloads and installs JTAPI.

Encrypt Audio Files
This tool enables you to encrypt any unencrypted audio files. Run this tool only after you upgrade all
desktops to the latest version of Quality Management. All audio files are encrypted after you run this
tool.

Set Recording Home Directory
This tool allows you to restart services after you update the Site Settings window. Run this tool when
upgrading from the Basic license to the Advanced license.

Generate SSL Certificate
This tool generates a security certificate for the Media webapp and Unified Workforce Optimizationgenerated reports. Use this tool if your certificate is corrupt or if the IP address of the server changes
(the user sees a Security Alert dialog box whenever the Media webapp or Reports runs). This tool is
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available only when you run postinstall.exe on the Quality Management server (for reporting) and the
Site Upload server (for Media webapp).
When you run the tool, you see a Security Alert dialog box. Click View Certificate to display the
Certificate dialog box, and then Install Certificate to install a new certificate.

Test CTI Services
This tool verifies that the local Recording CTI service or CUBE SIP CTI service has the correct JTAPI and
accepts connections. The tool makes a request to each running Recording CTI service or CUBE SIP CTI
service and, if all succeed, returns a success message. If any requests fail, Quality Management
reports the failure and lists which succeed. The reports are available in Unified Workforce
Optimization.

Note: This tool is not required for Cisco MediaSense Recording.
If you made any changes to the Recording CTI service or CUBE SIP CTI service in postinstall.exe, you
must restart the Recording CTI service or CUBE SIP CTI service before you run this test.

Test MediaSense Subscription Service
This tool verifies that the running MediaSense Subscription Service has the correct connection and
authentication information and accepts connections. This tool makes a request to the MediaSense
Subscription Service and, if it succeeds, it returns a success message. If the request fails, Quality
Management reports the failure.
If you made any changes to the MediaSense Subscription Service in postinstall.exe, you must restart
the MediaSense Subscription service before you run this test.

Display Metadata Encryption Key
This tool displays the customer-specific key used for Advanced Encryption Standard (AES) encryption.
This key can be used by external applications to access encrypted user-defined metadata directly
from the Quality Management database. You must provide the administrator’s user name and
password to access this information.

Choose Monitor Adaptor
This tool displays a dialog that asks for the IP address of the NIC card used for the Monitor service and
server-based monitoring. This might be different from the network IP address you entered during
System Configuration Setup (postinstall.exe).
The monitor adapter dialog pops up automatically during postinstall.exe if multiple NIC cards are on the
box and the box hosts the Monitor service. You should choose the IP address of the NIC card that you
connected to the SPAN port on the switch.

Note: This tool is not required for Cisco MediaSense Recording.
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Remove Recording Services
Use this tool to finalize the removal of Network Recording service and Monitor service servers by
removing them from database. Uninstall the services from the server before you use this tool.

Set Temporary Recording Directory
This tool allows you to choose a temporary storage location for recordings before they are uploaded.
You can change the temporary storage location at any time. When you change the temporary storage
location, postinstall.exe moves the recordings to the new location.

Set Temporary Encoding Directory
This tool allows you to choose a temporary storage location for encodings before they are uploaded.
You can change the temporary encoding location at any time. When you change the temporary
encoding location, postinstall.exe moves the encodings to the new location.

SIP Trunk Certificate
Use this tool to generate, upload, or download a SIP trunk certificate. A SIP trunk certificate is required
when your system is configured for Network Recording with Cisco Unified CM 8.5 or later. See the
Cisco CUCM documentation for any changes to the required CUCM configuration for your version.

Note: This tool is not required for Cisco MediaSense Recording.

To manage a SIP trunk certificate:
1. Select Tools > SIP Trunk Certificate, choose one of the following options, and follow the
prompts:
l

l

l

Generate SIP Trunk Certificate—use this tool to generate a SIP trunk certificate. The SIP
trunk certificate is saved to the C:\Program Files\Common Files\QM\Certificates folder.
Upload SIP Trunk Certificate—Use this tool to upload a SIP trunk certificate from a flash
drive or folder.
Download SIP Trunk Certificate—Use this tool to download the SIP trunk certificate to a
flash drive or folder. Follow the upload instructions in the Cisco Unified Communications
Manager Administration Guide to upload the certificate to Cisco Unified CM.

2. Copy and upload both the Certificate and Key files generated to any additional CTI servers
using the same menu if you want every server to use the same certificate. Otherwise
repeat this entire process for each CTI server.
3. Upload the Certificate file to your CUCM OS Administrator.
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Change IP Addresses or Hostnames
This tool allows you to change the IP address or hostname for the Site Upload server (Site Services),
Recording Server, Monitor server, and Media Encoding server (Encoding Server). During an upgrade,
this feature runs automatically after the Quality Management Quality Management database is
initialized.

Recording File Encryption Key
This tool enables you to generate and manage your own encryption keys if desired. It is available only
on servers that host the Media Encoder Service. With it, you can generate a new key and export and
import the keystore to and from a specified location.

About Encryption
Quality Management provides a set of default encryption keys. These default keys are global, not
customer specific. They do not require backup because they can be restored when you reinstall the
Site Upload Server bundle. Creating your own private encryption keys with the Recording File
Encryption Key tool is optional.

IMPORTANT: If you decide to generate new encryption keys, you must generate them on only
one Media Encoder Service server, and then import the keystore from that server to all other
Media Encoder Service servers in your system. Do not generate keys on multiple Media
Encoder Service servers.

Best Practice: It is strongly recommended that you export your keystore to a secure location
for safekeeping. If you lose the keystore, you will not be able to read any of your encrypted files.
The keystore cannot be recovered or regenerated.
Encrypting voice and screen recordings protects sensitive information such as Social Security
numbers and credit card numbers. The encryption feature complies with the Payment Card Industry
Data Security Standard (PCI DSS). When a recording is encrypted, the recording file stored on the
agent’s computer or on the storage server cannot be copied and played back.
When you use the Recording File Encryption Key tool, you generate a new set of customer-specific
keys. This provides a higher level of security for your contact center by ensuring that the encryption
keys are unique. Recording file encryption uses an asymmetric key pair (public/private) to encrypt
recording files. Once new keys are generated, the public key is published and all new recordings
going forward are encrypted using the newly created public key. The private keys are used to decrypt
the recordings for playback.
The Media Encoder service automatically detects new keys and uses these new keys within ten
minutes of your generating the keys. The keys are stored locally on the Media Encoder service server
under the Common Files folder. This ensures the keys are not modified or lost during an upgrade.
Recordings are placed in a queue for encryption after the recording ends. The time it takes to
complete the encryption depends on the system’s volume and load. They are then uploaded through
an encrypted connection to the storage server.
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Managing Encryption Keys
To generate a new key, follow these steps:

1. On a Media Encoder Service server, choose Tools > Recording File Encryption Key > Generate New Key. A warning dialog box appears.
2. Read the warnings, and then click Yes to continue.
Note: If the warning tells you that this server does not have the latest keystore, it
means that a new key was previously generated on a different Media Encoder
Services server and that this server does not have that key, making it impossible for
this server to decrypt recordings encrypted with the newer key. You should import
the latest keys to this server before generating a new key on it.
3. The new key is generated and placed in the local keystore, located here:
C:\Program Files\Common Files\QM\config\filecryptokeystore

WARNING : Never change the filecryptokeystore file in any way, delete it, or paste a changed
version over the file. Doing so makes recording calls impossible.
Always use the PostInstall Recording File Encryption Key import/export options to export the
filecryptokeystore file. Always remember to keep the file in a secure place.

Note: When upgrading from a previous version of QM that used Proxy screen recordings (such
as version 9.3 and earlier), keep your filecryptokeystore file from the earlier version to use with
the RecToM4VEncoder utility. This utility needs that file to decrypt the older screen recordings,
and to re-encode them for playback in the new version.
To export a keystore, follow these steps:

1. On the Media Encoder Service server where you generate new keys, choose Tools > Recording File Encryption Key > Export Keys.
2. Browse to a location to save the keystore, such as a portable flash drive, or to a secure location for safekeeping.
3. Name the keystore, then click Okay to export the keystore. You cannot overwrite an existing
exported keystore.
To import and merge new keys into the local keystore on another Media Encoder Service server, follow
these steps:
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1. On one of the Media Encoder Service servers in your system, choose Tools > Recording File
Encryption Key > Import Keys.
2. Navigate to the location where you exported the keystore, select the keystore, and click
Okay.
3. The new keys in the keystore are merged into the local keystore on this server, located at:
C:\Program Filesl\Common Filese\QM\config\filecryptokeystore

4. Repeat these steps on all Media Encoder Service servers in your system except the one
from which the keystore was exported.
5. After the keystore is imported to all Media Encoder Service servers, restart all instances of
the following services:
l

Desktop Recording Service

l

Network Recording Service (VoiceRecordServer.exe)

l

Recording Thin Clients (ScreenRecordServer.exe)

The new key will not be used for encryption until these services are restarted.
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Use the Record Server Configuration node to configure devices for Cisco MediaSense Recording,
Server Recording, Network Recording, and Network Based Recording.

Note: You do not need to configure devices if you are only using Desktop Recording
(Endpoint).
You can enable Server Recording, Network Recording, and Network Based Recording for a device
from the Record Server Configuration node for the following types of agents:
n

Agents who work different shifts and share a desk (Hot Desking)

n

Agents who log into a phone (Extension Mobility) in a Unified CCX environment

n

Agents using Citrix or Microsoft Terminal Services thin clients (audio and screen recording)

n

Agents using just a phone, and no PC (audio recording only)

If an agent’s phone is configured for Server Recording, Network Recording, and Network Based
Recording,
n

The agent can be recorded

n

Supervisors and managers can monitor a live call

Note: You cannot monitor the default user, even if the default user is recorded using Network
Recording, or Network Based Recording.
Server Recording, Network Recording, and Network Based Recording have the following limitation: a
device cannot be simultaneously registered for Server Recording and Network Recording or Network
Based Recording. You can, however, change the configuration from Server Recording to Network
Recording or Network Based Recording, or from Network Recording or Network Based Recording to
Server Recording.

VoIP Devices
The VoIP Devices window supports VoIP devices in the telephony groups (Unified CM clusters) for
Server Recording (SPAN), Network Recording, or Network Based Recording.
The first time you access the VoIP Devices window, it is empty. You must search the devices configured
in Unified CM for the ones you want to enable. See Enabling VoIP Devices for Recording for more
information.
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The VoIP Devices window allows you to search for the devices configured in Unified CM and enable
the devices for Server Recording, Network Recording, or Network Based Recording. You can then
associate an agent, a Monitor service server (Server Recording only), and a Recording Cluster with
those devices.

Field

Users Assigned to Site

In Telephony Group

Description

The site’s IP address. You can filter knowledge workers by site.
You can choose from the following:
n

All Sites

n

Default Site

n

<site’s IP address or hostname>

The IP address for the telephony group. Your options are as
follows:
Unified CCX:

Where

Matches

n

All Groups

n

<telephony group’s IP address or hostname>

Search devices by a specify component. You can choose from
the following:
n

Agent

n

Device Name

n

Extension

n

(Unified CCX only) Monitor Server

n

Recording Cluster

n

Recording Type

n

Signaling Group

The name or extension number of the component.
You can use wildcards ( * ) and question marks ( ? ) in this field,
in addition to a specific string.
Note: This field is case sensitive.
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Field

Find

Description

When clicked, locates every device that matches the search
criteria.
Note: The VoIP Devices window must be populated
before the Find button can display search results. See
Enabling VoIP Devices for Recording for more
information.

Device Name

The name of the device.
Accepted prefixes in device names are IPC, CSF, and SEP, for
example, IPC<username>. Devices with these prefixes are
treated as IP phones.

Device Type

The type of device. The device types are:
n

All Types

n

Cisco Phone

n

User Profiles

n

Remote Agent Port

Telephony Group

The IP address for the telephony group (Unified CM cluster).

Extension

The extension associated with the device. If a device has two
extensions associated with it, two entries appear in the search
results table. If you select the Enabled Check box for one
extension, Quality Management also selects the other
extension.
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Field

Agent or Configure Agent

Description

Allows you to assign one of the following login options to a
device.
n

User Login Required—choose this option to configure the
device for Hot Desking. If you choose this option, the
device will not be recorded until an agent or knowledge
worker logs in using the Recording API.

n

<Last name, first name, (user ID)>—choose this option to
assign a specific agent, knowledge worker, or default
hoteling agent to the device.

You can double-click the Agent field or click the Configure Agent
button when you want to associate a login option with a device.
Before you click Configure Agent, you must select one or more
devices.
When using the Agent drop-down list or the Configure Agent
button to a assign device to an agent or a knowledge worker,
consider the following:
n

Recording and Quality Management is licensed by the
number of named users. Named users are users who are
configured and licensed.
Example: agents, knowledge workers,
supervisors, managers, evaluators, and archive
workers
The total number of devices that you can assign to Default
Hoteling Agents is equal to the total number of licenses
for your system.

n
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Assigning a device to a Default Hoteling Agent does not
use or consume a license, it just puts a limit to the number
of devices that can be assigned to a Default Hoteling
Agent. This prevents a situation where Login commands
are not processed when the Web Base server is not available or there is an error when a user tries to log into the
system. It ensures the device is recorded no matter what
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Field

Description

the situation is.

Monitor Server or
Configure Monitor Server

n

Do not assign a Default Hoteling Agent to Extension
Mobility profiles.

n

If you do not assign the device to a Default Hoteling Agent
and intend to use Hot Desking you must choose User
Login Required from the Configure Agent drop-down list.
This ensures that the device will be recorded when
someone logs into the device using Extension Mobility or
the Login API command.

Allows you to associate the IP address for the Monitor server
with this device. If a Monitor server is not applicable, the field
displays No Configuration.
Example: You cannot associate a Monitor server with a
Remote Agent Port or User Profile.
You can double-click the Monitor Server field or click the
Configure Monitor Server button when you want to associate a
Monitor server with a device. Before you click Configure Monitor
Server, you must select one or more devices.

Signaling Group

Displays the signaling group associated with this device.

Recording Cluster or Con- Allows you to assign the Recording Cluster to a device. If a
figure Recording Cluster
Recording Cluster is not applicable, the field displays No
Configuration.

Example: You cannot associate a Recording Cluster
with a User Profile.
You can double-click the Recording Cluster field or click the
Configure Recording Cluster button when you want to assign a
Recording Cluster to a device. Before you click Configure
Recording Cluster, you must select one or more devices.

115

Record Server Configuration

Field

Recording Type or
Configure Recording
Type

Description

Allows you to assign recording type to a device.
You can double-click the Recording Type field or click the
Configure Recording Type button when you want to select a
recording type for a device. Before you click Configure
Recording Type, you must select one or more devices.
You can choose from the following options:
n

Event Notification—Choose this option when you are not
using Server Recording, Network Recording, or
Network Based Recording but you would like to use Live
Monitoring and/or Screen Recording:

n

Server Recording—choose this option to use Server
Recording (SPAN).

n

Reconciliation—choose this option when the only type of
recording you are doing is reconciliation. You do not need
to choose this option to enable reconciliation, all calls are
reconciled. Choose this option when you are not using
Event Notification, Server Recording, Network Based
Recording, or Network Recording. This option is appropriate for MediaSense or Gateway Recording.

n

Network Recording—choose this option to use Network
Recording.

Example: Assign Event Notification to a device
configured for Cisco MediaSense Recording to allow Live
Monitoring and Screen Recording.
You cannot configure the recording type for a User Profile
device.
Remove From
Configuration

When clicked, Remove from Configurationallows you to remove
one or more devices from the VoIP Devices table.
Note: You must select one or more devices before
clicking the button.
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Field

Import Devices

Description

Allows you to select the location and name of devices file to
import. The file must be in CSV format (see CSV Format for
more information). Importing a device list merges with the
existing file and adds new devices or modifies existing devices. It
does not remove existing devices. If a configured devices does
not appear in the imported file, it will not be affected by the
import.
Note: If the CSV file has errors in it, the import will fail and
the existing data will remain unchanged. An error
message will indicate why the import failed and identify
the record that failed if applicable.
After importing a CSV file, you must click Save to save your
changes.

Export Devices

Allows you to select the location and specify a name for the
exported device list. The file must be in CSV format. Once exported, you can open the file in Microsoft Excel.

Enable Unified
CM Devices for
Recording

When clicked, Enable Devices for Recording allows you to
search for devices in Unified CM and enable those devices for
recording in Quality Management.

Synchronize Devices
With Clusters

When clicked, Synchronize Devices With Clusters allows you to
synchronize device changes from Unified CM with the list of
devices in the VoIP Devices window. It removes any devices
that were deleted in Unified CM and updates extensions for
modified devices.
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Field

Create/Edit Default
Hoteling Agent

Description

When clicked, allows you to create or modify one or more
Default Hoteling Agents. You must provide the following
information for each Default Hoteling Agent:
n

First Name—the Default Hoteling Agent’s first name.

n

Last Name—the Default Hoteling Agent’s last name.

n

Windows Username—the login ID for the Default Hoteling
Agent.

n

Teams—the team assigned to the Default Hoteling Agent.
The assigned team determines the scope for the Default
Hoteling Agent.

This is a generic user profile. The agent does not log into the
phone using this user profile. It is assigned to a device in case an
agent does not log in. The total number of Default Hoteling
Agents is equal to the total number of licenses for your system.
The following items must be associated with each recording type.
Recording Type

Server Recording

Associated Items

Agent
Monitor server IP address
Recording Cluster name
Recording type of "Server Recording"

Network Recording

Agent
Recording Cluster name
Recording type of "Network Recording"

Network Based Recording

Agent
Recording type of "Reconciliation"

When configuring VoIP devices using Gateway Recording for agents, consider the following:
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n

Unified CM telephony group:
l

The Endpoint only Does Screen Recording check box must be selected in the
Unified CM Configuration dialog box (see Unified CM Configuration).
Note: If the Endpoint only Does Screen Recording check box is cleared, the
phone device will default to Desktop Recording (Endpoint).

n

ACD agent:
l

l

n

If the agent’s phone is daisy-chained you do not need to configure the device in
the VoIP Devices window.
If the agent’s phone is not daisy-chained the device must be configured in the
VoIP Devices window.

Knowledge worker:
l

l

The agent’s phone must be configured in the VoIP Devices window.
If the agent requires screen recording in a CUBE or MediaSense Recording environment, you need to assign Event Notification to the device and a Recording
Cluster that connects to a CTI server and has no Recording Servers assigned to it.

When configuring VoIP devices using Gateway Recording and you plan to use Recording Controls,
consider the following:
n

The Endpoint only Does Screen Recording check box must be selected in the Unified CM
Configuration dialog box (see Unified CM Configuration) when you configure the
Unified CM telephony group.

n

Recording Type must be set to either Event Notification or Reconciliation.

When configuring VoIP devices and assigning licenses to users, note the following:
n

The CTI service checks for valid licenses every sync.

n

If a license becomes invalid or a user’s license is added, removed, or changed, the
change will take effect the next time the CTI service syncs.

n

If the license server is unavailable, the CTI service will use the last licensing state that it
successfully received.

Consider the following when you configure a VoIP device for Server Recording, Network Recording, or
Network Based Recording.
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The VoIP Devices window only allows 64 characters in the fields. This affects the number of extensions
you can configure for a VoIP device. You can configure up to 12 extensions of 4 digits each for a VoIP
devices and not exceed the 64 character limitation.

Example: 5555,5556,5557,5558,5559,5560,5561,5562,5563,5564,5565,5566

Hot Desking
Hot Desking is a situation where one desk is shared between several people who use the desk at
different times. This work surface can be an actual desk or just a terminal link. Companies use Hot
Desking when not all the employees are in the office at the same time, or employees are not regularly
in the office for very long.
Hot Desking includes the following scenarios:
n

Using Extension Mobility in a Unified CCX environment

n

Sharing the same extension

n

Logging into the Recording API—see the API Programmers Guide for more information on
the Recording API

Remember the following points when you configure a device for Hot Desking:
n

When configuring Hot Desking for an agent with a Quality Management license or Call
Recording license, you must use the Login and Logout commands for the Recording
Controls API.

n

If an agent is already logged in to a different device, Quality Management logs the agent
out of the old device when the agent logs into the new device.

n

If you assign a device to an agent by selecting an option in the Agent column from the
VoIP devices window:
l

l
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The agent cannot use the Recording Controls API to log into the device (the login
will be ignored).
The agent can use the Recording Controls API to log into a different device. Quality
Management records both devices for the agent.

n

If an agent is on a call when another login request comes in, that call is ended. Quality
Management logs the agent out, creates a new user for that extension, registers the
device with the CTI, and records all subsequent calls for that extension.

n

If an agent issues a logout command using the Recording Controls API and there is an
active call for that extension, Quality Management ends the call, and logs out the user.
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n

If an agent issues a login command using the Recording Controls API, and the username
and extension matches the username and extension for an agent who is currently logged
in, Quality Management ignores the request.

n

The Desktop Recording service supports Hot Desking, provided the agents use their own
accounts to log in and log out of their client machine.

Synchronization Issues
Note: This information only applies to Unified CCX.
The following list describes the synchronization issues with the devices listed in the VoIP Devices
window.
n

An agent configured for a device could be deactivated, lose the agent or knowledge
worker role, or become unlicensed. In these cases, the agent can no longer be recorded,
and Quality Management removes their association with their device. Every time the
VoIP Devices window appears and loads the data, the agents are automatically
synchronized. The VoIP Devices window displays a list of the invalid agents that will be
removed from their associated devices.

n

Someone modifies or removes a configured device in the Unified CM cluster. When you
click the Synchronize Devices with Clusters button, it updates the modified devices and
then displays a list of devices configured for Server Recording but no longer configured in
a cluster. You can choose to remove the devices from the VoIP Devices list.

Enabling VoIP Devices for Recording
To enable VoIP devices for recording:
1. On the VoIP Devices window, click Enable Devices for Recording.
You must click this button before you do anything else on this window to populate the list of
VoIP devices.
2. Choose one of the following options.
l

To find all the devices in the available cluster, click Find.
Note: By default, the search criteria are set up to return every device in a
selected cluster when you click Find.
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l

If the cluster has many devices, you can search for devices that match a certain
criteria. You can search by a combination of device type (Phone, Remote Agent Port,
User Profile, or All Types), cluster IP address, device name, or extension.
Note: You can type wildcard characters (* or ?) or specific numbers in the
Matches field. This field is case sensitive.
A list of all of the devices that are in the cluster appears.
If a device has two extensions associated with it, two entries appear in the search
results table. If you select the Enabled check box for one extension, Quality
Management Administrator also selects the other extension.

3. To sort by a particular column, click the column heading.
4. Choose one of the following options:
l

To select a specific device, click its row.

l

To select additional devices, press and hold the Ctrl key while clicking the other rows.

5. When you are done selecting devices, click Check Selected, and then click OK.
The devices you selected appear on the list of VoIP devices.

Configuring Devices for VoIP
To configure a device for VoIP monitoring:
Note: To configure multiple devices, see Managing VoIP Devices.
1. Enable the devices for recording.
See Enabling VoIP Devices for Recording for more information.
2. Find the devices to be configured.
See Filtering VoIP Devices for more information.
3. Assign a device to a Recording Type.
4. Assign a device to an agent, the default hoteling agent, or User Login Required.
5. Assign a device to a Recording Cluster.
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The Recording Cluster is not required for User Profiles.
6. Assign a device to a Monitor server.
7. Assign a device to a recording type.
8. Click Save.

Filtering by Site
To filter agents or knowledge workers by site:
n

Choose a site from the Users Assigned to Site drop-down list.
The agents or knowledge workers associated with the selected site appear in the VoIP
Devices window.

Filtering VoIP Devices
To filter VoIP devices:
1. On the VoIP Devices window, choose a site from the Users Assigned to Site drop-down list.
2. Choose the type of device you want to locate from the Find Devices of Type drop-down list in
the Device Search pane.
3. Choose the IP address for the cluster from the In Cluster drop-down list.
4. Enter the name of the device or extension for the device in the Where drop-down list
You can use wildcards * and question marks ? in this field, in addition to a specific string.
5. Click Find.
The VoIP Devices window displays a list of devices that match the search criteria.

Extension Mobility
When configuring agents for extension mobility in a Network Recording, Network Based Recording, or
Server Recording environment, you need to ensure the following:
n

A user profile is associated with each agent

n

Every phone an agent can log in to is associated with a Recording Cluster

When an agent logs in to a phone, their calls are recorded by the Recording Cluster assigned to their
phone.
When configuring agents for Extension Mobility, consider the following:
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n

If the user is on a phone call when they log out of a device, the recording will stop.

n

If you change the user profile (for example, the extension) in Unified CM, you must click
the Synchronize Devices with Clusters button in the VoIP Devices window for the change
to take effect.

n

If you change the user profile in Unified CM and synchronize the databases in Quality Management Administrator, current calls on that device might be stopped and restarted.

n

You can also configure Extension Mobility Cross-Cluster (EMCC), in which the physical
phone is unregistered and in CUCM a new (temporary) phone is created and used by
CUCM. The new temporary phone in the visiting CUCM cluster inherits everything from
the home CUCM cluster. EMCC is configured by setting the Device Type to User Profile,
Recording type to Network Recording, and then selecting a signaling group and recording
cluster for the device.
Note: The Build in Bridge (BIB) must be enabled on the visiting cluster in the
callManager service parameters before EMCC is configured.

To configure a user for Extension Mobility:
1. From the VoIP Devices window, select a device assigned to the Extension Mobility profile
(Device Type is User Profile) created in Cisco Unified CM, and then click Configure Agent.
The Configure Agent dialog box appears
2. Choose Default Hoteling agent or User Login Required from the Configure Agent drop-down
list.
To ensure all calls are recorded on the phone, choose the default Hoteling agent from the
Configure Agent drop-down list.
3. Assign the device to a recording cluster.
4. Assign the device to a signaling group.
5. Assign the device to a recording type.
6. Click Save.

CSV Format
The CSV file containing the device list must use the following format:
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CSV Column

DeviceName

Value

The MAC address or
extension of the
device

Required

Yes

Notes

If you are using hard phones and IP
Communicator in a Unified CM
environment, use the following
format when inserting the device
name:
SEP<MAC>
where <MAC> is the MAC address
for the device.
If you are using Jabber or EM in a
Unified CM environment, Quality
Management supports Jabber
beginning with CSF and EM
profiles have no required naming
convention.
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CSV Column

DeviceType

Value

The type of device

Required

No

Notes

If you do not include the type of
device, Quality Management will
insert standard device type
associated with your telephony
platform. The supported device
types are as follows:
l

Phone—Quality Management
will use the appropriate
phone type for the telephony
group type. The default
recording types by ACD are
as follows:
l

l

l

l

Extensions
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One or more extensions associated with
the device

No

Cisco: Server Recording
CS1000: CS1000

RemoteAgentPort—Only supported for Unified
CM telephony groups. The
default recording type is
Server Recording.
UserProfile—Only supported
for Unified CM telephony
groups. The default recording type is None.

The extensions associated with the
device.
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CSV Column

Value

TelephonyGroup The name of the
telephony group
associated with the
device

Required

No

DisplayID

The agent's display
ID

No

Username

The agent's Windows username

No

DomainName

The agent's Windows domain

No

LastName

The agent's last
name

No

Notes

If you do not include the telephony
group:
n

Quality Management will
insert the first telephony
group found in the database.

n

The update will fail for any
device names that appear in
multiple telephony groups.

When identifying an agent, Quality
Management filters matching fields
in the following order:
1. Display ID
2. Username (if no domain is
provided); username and
domain (if a domain is
provided).
3. Last name and first name.

Note: If you
supply the first
the first name,
the last name
is required.
Likewise, if
you supply the
last name, the
first name is
required.
FirstName

The agent's first
name

No

MonitorServer

The Monitor Server
for this device.

No

Recording
Cluster

The name of the
Recording Cluster

No

Only used for the Server Recording
Type.
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CSV Column

RecordingType

Value

The recording type
for the device

Required

No

Notes

If you do not include the recording
type, Quality Management inserts
Default for the device type. See Supported Recording Types for more
information.

Managing VoIP Devices
Before you configure VoIP devices, follow the steps as described in Enabling VoIP Devices for
Recording to populate the list of VoIP Devices.

To manage VoIP devices :
n

To synchronize device changes from Unified CM with the list of devices in the VoIP
Devices window, click Synchronize Devices With Clusters, and then click OK.
Whenever you modify a VoIP device in Unified CCX, the modifications do not go into effect
until the Unified CCX and Quality Management databases synchronize.

n

To assign multiple devices to a Monitor Server, select the devices from the list, click Configure Monitor Server, select the IP address for the Monitor Server from the drop-down
list, click OK, and then click Save.
l

Use Shift + Click to select contiguous rows in the list of devices.

l

Use Ctrl + Click to select non-contiguous rows in the list of devices.

n

To assign multiple devices to a recording type, select the devices from the list, click Configure Recording Type, select the appropriate recording type from the drop-down list,
click OK, and then click Save.

n

To assign a device to a Monitor Server, double-click the device’s Monitor Server field,
choose the IP address for the Monitor Server from the drop-down list, and then click
Save.
When configuring a Monitor Server, note the following:
l

l

n
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The Recording Type must be Server Recording (SPAN)
You cannot associate a Monitor server with a Remote Agent Port (CTI port) device
because the server for the Monitor service must be found at run-time.

Import a device list, click Import Devices, select the location, the file name of the device
list, click OK, and then click Save.

Record Server Configuration
n

Export a device list, click Export Devices, select the location, type the file name of the
device list, and then click OK.

n

To assign a device to a recording type, double-click the device’s Recording Type field,
select the appropriate recording type from the drop-down list, and then click Save.

n

To remove one or more devices, select the devices from the list, click Remove From Configuration, click Yes, and then click Save.

n

To assign multiple devices to a Recording Cluster, select the devices from the list, click
Configure Recording Cluster, select the name of the Recording Cluster from the dropdown list, click OK, and then click Save.

n

To assign the agent association for multiple devices, select the devices from the list,
click Configure Agent, choose the agent association from the drop-down list, click OK,
and then click Save.
You can only assign the following agents association to multiple devices.
l

Default Hoteling Agent—all recordings on the device will be associated with the
Default Hoteling Agent until another agent or knowledge worker logs into the
device.
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The Personnel node allows you to create groups and teams and assign roles, groups, teams, and
licenses to users.
You can configure existing ACD users or create non-ACD users. If you are using Active Directory (AD)
you can link AD users to ACD or non-ACD users.

User Roles and Privileges
Example: The scope of a supervisor who has one team of knowledge workers consists of the
recordings and evaluations for those knowledge workers. The scope of a manager who has
several groups of teams of agents and knowledge workers consists of the data for all of those
agents and knowledge workers
A role is a collection of privileges. A user can have one or many roles. When the user logs into Unified
Workforce Optimization, the user can access all roles and privileges assigned to that user.

Example: If a user is assigned to both the evaluator and manager roles, the user has access to
all privileges assigned to the evaluator and manager roles.
A privilege is the permission to perform a transaction.

Example: Managers have the ability to access archive recordings for their groups.
Quality Management defines a user’s scope by roles and privileges. Scope refers to the data (such as
recordings and evaluations) that a user can view.

Administrator
The administrator responsibilities are partitioned into the following hierarchical roles: system
administrator, telephony administrator, and business administrator.
You can configure system administrators when you run postinstall.exe. Configuring system
administrators is a two-step process:

1. Create users in Quality Management Administrator.
Note: If you are using Active Directory, the users must be assigned to the Admin
Group. See the description of Admin Group in Domain Information for additional
information.
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2. Assign users to the system administrator role in Administrator Configuration under
postinstall.exe.
Important: Once you assign the system administrator role to a user in a non-Active
Directory environment, the default administrator user becomes obsolete and you
can no longer log in as a default administrator.
The system administrator is primarily responsible for server configuration, IP changes, integration
points, and passwords. The system administrator can configure telephony and business
administrators.
A telephony partition is a group and/or team to which a telephony administrator is assigned. If you
want the telephony administrator to administer a specific set of groups or teams, you must assign the
manager or supervisor role to the telephony administrator, and then assign the groups or teams.

Example: If you want a manager to be responsible for administering a specific group, assign
the telephony administrator role to the manager.
The telephony administrator is primarily responsible for who is configured and/or recorded, the
workflows, and the type of devices and recording methods used in the assigned groups and teams
within the telephony partition. The telephony administrator can also determine who has the following
privileges in Unified Workforce Optimization.
n

Accessing recordings

n

Evaluating recordings

n

Reporting on recordings

n

Exporting recordings

The telephony administrator can configure business administrators within the telephony partition.
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The business partition is a group and/or team to which a business administrator is assigned. If you
want the business administrator to administer a specific set of groups or teams, you must assign the
manager or supervisor role to the business administrator, and then assign the groups or teams.

Example: If you want a supervisor to be responsible for creating and configuring evaluation
forms and templates for assigned teams, assign the business administrator role to the
supervisor.
The business administrator is primarily responsible for creating and configuring evaluation forms and
templates for assigned groups and teams within the business administrator partition.
When managing administrators, consider the following points:
n

In an Active Directory environment, the system, telephony, or business administrator
must have an AD Account user associated with the Security Group security setting.

n

In a non-Active Directory environment, the system administrator is created when you
installed/upgraded Quality Management.

n

Telephony and business administrators can be promoted to system administrators.

n

System, telephony, and business administrators can log in to Quality Management
Administrator.

n

The system administrator does not require a license to log into Recording and Quality
Management. However, a Recording and Quality Management license is required if you
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want the system administrator to manage the Dashboard application inUnified Workforce Optimization.
The scope for each administrator role is shown in the following table.

Area

System Configuration or
postinstall.exe

Record Server
Configuration
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Window or feature

System Administrator

Telephony
Administrator

System Database

X

Data Synchronization

X

Telephony
Groups

X

Enterprise Settings

X

Gamification
Metrics

X

Administrator
Configuration

X

Site Settings

X

Recording
Clusters

X

Mobile Agent
Monitor

X

Inclusion List

X

X

Monitoring and
Notification

X

X

Status

X

X

Mobile Agent
Monitor

X

X

VoIP Devices

X

X

X

Business Administrator

Personnel

Area

Personnel

Recordings

Window or feature

System Administrator

Telephony
Administrator

Business Administrator

User Administration

X

X

Team Administration

X

X

Group Administration

X

X

Quality Management Workflows

X

X

Evaluation
Forms

X

X

X

Templates

X

X

X

Forms

X

X

X

Archive Workflows

X

X

Metadata

X

X

Export

X

X

Call Events
Administration

X

X

Recording Visibility Administration

X

X

Interface Configuration

X

X
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Area

Unified Workforce Optimization

Window or feature

System Administrator

Telephony
Administrator

Business Administrator

Dashboard: configuring dashboards by role

X

Dashboard: lock
down dashboard

X

Recordings

X

Live Monitoring

X

Recording Monitoring

X

X

X

Application Management

X

X

X

Reporting:
Recording
Access by User

X

X

Reporting:
Recording
Access by
Contact

X

X

Reporting:
User Recording
Status

X

X

Reporting: System Status

X

X

Reporting: Audit
Trail

X

Agents and Knowledge Workers
Agents and knowledge workers have the following privileges:
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n

View their own quality scores and the aggregate quality scores for their team and group
on a dashboard

n

Export recordings within their scope, if enabled

n

Review evaluation results on their own scored contacts

Personnel
n

Enter comments on their scored evaluations.

n

View their own historical reports

n

Access recordings of their own contacts, if enabled
Note: Agents who are not assigned to a team can still log into Unified Workforce
Optimization and access their customer conversations.

n

Access all recordings marked as Training

Supervisors
Supervisors have the following privileges:
n

View dashboard with their team’s and group’s quality scores and details of individual
agents within their team

n

Enter comments on their team’s scored evaluations

n

Update their previously-scored evaluations

n

Export recordings within their scope, if enabled

n

Approve evaluations for agents in their teams, if required

n

Designate recordings in their teams to be retained as Training or HR recordings

n

View agent and team-level historical reports

n

Access customer conversations for their team

Managers
Managers have the following privileges:
n

View dashboard with their group’s quality scores and details of individual teams within
their group

n

Review evaluation results on all of their group’s scored contacts

n

Enter comments on their group’s scored evaluations

n

Approve evaluations for agents in their groups, if required

n

Export recordings within their scope, if enabled

n

Designate contacts for retention as Training contacts
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n

View agent, team, group, and enterprise-level historical reports

n

Access customer conversations for their group

Evaluators
Depending on how the permissions were configured in the User Administration window, an evaluator
has the following privileges:
n

Evaluate conversations that occur within one of the following scopes:
l

l

All Teams—evaluators can evaluate any conversation, including their own conversation.
Scope Additions—evaluators can evaluate only conversations for teams within
their scope, their own conversations, and the teams listed under Evaluator's
Teams in the User Administration window. If there are no teams within the
evaluator's scope or listed under Evaluator's Teams, the evaluator can only
evaluate their own conversation.
Best Practices: To allow an agent or knowledge worker to perform self
evaluations, assign the evaluator role and select Scope Additions from the
Evaluator scope drop-down list in the User Administration window.

n

Conversations can be either automatically assigned to an evaluator for evaluation or the
evaluator can choose which conversation to evaluate next.

n

Approve evaluations, if required

n

Export recordings within their scope, if enabled

n

Update their previously-scored evaluations

n

Designate contacts for retention as Training or HR contacts

Assign the evaluator role to agents and knowledge workers if you want them to evaluate their own
conversations.

Archive Users
Archive users can view all archived call contacts made by all active and inactive groups, teams, and
agents. Archive users have the following privileges:
n
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Search and review customer conversations for all of the agents and knowledge workers
across the enterprise

Personnel
n

Export customer conversations, if enabled

n

Access customer conversations for deleted users

User Administration
The User Administration window allows you to assign roles, groups, teams, and licenses to users.
The User Administration window displays one of two versions, depending on whether or not you
configure your system to interface with Microsoft Active Directory. See Active Directory Systems or
Non-Active Directory Systems for more information.

Note: Whenever you modify a user in the ACD (for example, change a user’s name), the
modifications do not appear in Quality Management until synchronization occurs. The
synchronization process runs automatically at 10-minute intervals. If necessary, you can
manually synchronize these databases (see Getting Started for more information).
The User Administration window has tabs that sort users into categories according to their roles and
status within Quality Management. You can use Shift+click or Ctrl+click to select items in a tab's table
and then copy and paste the results to other applications. When more than one user is selected, the
User Properties panel and bulk modifications are disabled.

Active Directory Systems
In an Active Directory system, there are three types of users:
n

Active Directory Account. A user set up in Microsoft Active Directory. All users in Quality
Management must be in Active Directory. You can only configure a user in Quality
Management if that user has a last name in Active Directory.

n

ACD User. A user set up as an agent and/or supervisor and assigned to a team in the
ACD. You can assign an ACD user to manager, evaluator, and archive user roles in Quality
Management.

n

Non-ACD User. A user created in Quality Management.

You must link an ACD user to an Active Directory account within Quality Management to assign roles to
that user in Quality Management.
Once you link an ACD user to an Active Directory account, you cannot unlink the ACD user. You can
switch a link from one Active Directory account to another Active Directory account by following the
procedure for linking an ACD user to an Active Directory account and selecting a new Active Directory
user to link to.
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If that Active Directory account is already linked to an ACD user, the links will be switched. For example,
if:
n

ACD User 1 is linked to Active Directory Account 1

n

ACD User 2 is linked to Active Directory Account 2

and you want to link ACD User 1 to Active Directory Account 2, you can do so. The end result is that the
links will be switched:
n

ACD User 1 is linked to Active Directory Account 2

n

ACD User 2 is linked to Active Directory Account 1

There are other linking/unlinking situations that can exist. When you attempt to link or unlink various
combinations of ACD, Active Directory, and Quality Management users, popup messages appear telling
you what you must do to accomplish the task, or if it is allowed in Quality Management.
The following table describes the buttons.
Tab

Link AD to ACD Users

Description

Assign an ACD user to an Active Directory account.
Note: Once you link an Active Directory to an ACD
account, you can only unlink the Active Directory account
by deleting the user from the ACD system.

Create Users

Add a non-ACD user. Non-ACD users are users that exist only
in Quality Management and Active Directory. Non-ACD users
do not exist in the ACD. Like ACD users, you must link non-ACD
users to an Active Directory Account to be part of the Quality
Management system.

License Users

Assign a user with a license. See License/Unlicense Users for
more licensing information.

Delete User

Remove a non-ACD user. See Deleting an ACD User for
information on deleting an ACD user.

Link User

Link the selected ACD user to an Active Directory account.

Add

Add an ACD team, QM team, or group to a list.

Remove

Delete an ACD team, QM team, or group from a list.

Save

Saves your changes.

Cancel

Cancels your current changes.
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The following table describes the search fields. The search fields are disabled until you click the
Search tab. Use one or more filters when running a search. A search with no filters returns all users.
The following filters can use the * wildcard at the beginning or end of a search string: Last Name, First
Name, Windows Username, and Extension. If the search string does not contain an *, the results will
display all results that contain the specified search string.

Description
Tab

Last Name

Filters the search by the user's last name.

First Name

Filters the search by the user's first name

Group

Filters the search by the name of the group.

Team

Filters the search by the name of the team.

Windows Username

Filters the search by the user's Windows user name,

Extension

Filters the search by the user's extension.

The following table describes the tabs.

Tab

Description

Linked Users

Active Directory users linked to an ACD or non-ACD users. This
includes the administrator.

Managers

ACD and Non-ACD users assigned to the manager role.

Evaluators

ACD and Non-ACD users assigned to the evaluator role.

Archive Users

ACD and Non-ACD users assigned to the archive user role.

Supervisors

ACD users assigned to the supervisor role or non-ACD users
assigned to the supervisor role.

Agents

Users assigned to the agent role in the ACD.

Knowledge Worker

Non-ACD users assigned to the knowledge worker role.

Unlinked ACD Users

ACD users who are not linked to an Active Directory user.

Unassigned Users

Non-ACD users not assigned to the manager, evaluator,
knowledge worker, supervisor, or archive user roles. This tab
only lists non-ACD users, because ACD users always have at
least one role.
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Tab

Description

Administrators

Users assigned to the administrator role.

Search

Users found by the search feature.

The following table describes the information that appears about the users on each tab.
Column

License

Description

The license assigned to the user. The possible licenses are:
n

CR

n

CRS+

n

AQM

n

AQMS+

A user must be licensed to be able to log into Unified Workforce
Optimization and be recorded.
Last Name

The user’s last name, as set up in the ACD or Quality
Management. The name appears as it is configured in Active
Directory.
For Active Directory authentication, the first and last names are
displayed in their respective columns after you link a user. A
report that normally displays a user’s first and last name will
display the Active Directory first and last name.

First Name

The user’s name appears as it is configured in Active Directory.

User ID

The user ID assigned to the user.
If the user is an ACD user in a Unified CCX environment, the
format is <agent’s PG>.<agent’s ICM Peripheral Number>.
If the user is a Quality Management user, the Quality
Management system assigns a number.

Assigned Team

The team assigned to the agent or knowledge worker.

Assigned Group

The group assigned to the agent.

Windows Username

The user’s Windows user name.
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Column

Top Admin Role

Description

The highest administrator role assigned to the user. Use the
Admin Role drop-down list to assign the business or telephony
administrator role to a user. The possible values are as follows:
n

None—no administrator roles are assigned to the user.

n

Business—assigns the business administrator role to the
user.
Note: Only a system administrator or telephony
administrator can assign the business
administrator role to a user.

n

System—indicates the user is a system administrator.
Note: The Administrator Role drop-down list is
disabled when the user is a system administrator.
See Administrator Configuration for more
information on assigning users to the system
administrator role.

n

Telephony—assigns the telephony administrator role to
the user.
Note: Only a system administrator can assign the
telephony administrator role to a user.

Extension

The extension associated with the Active Directory user.

Domain

The domain assigned to the Active Directory user.

When you select a user listed in any of the tabs, that user’s properties are displayed in the lower
section of the window. User properties are described in the following table.
Column

License

Description

The license assigned to the user.
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Column

Description

First Name

The user’s first name, as set up in the ACD or Quality
Management.

Last Name

The user’s last name, as set up in the ACD or Quality
Management

Assigned Team

The team assigned to the agent or knowledge worker.

User ID

The user ID assigned to the user. If the user is an ACD user, the
format is <agent’s PG>.<agent’s ICM Peripheral Number>. If
the user is a Quality Management user, the Quality
Management system assigns a number.

Windows Username

The user’s Windows user name.

Domain

The user's Domain.

Evaluator Scope

The evaluation scope assigned to the user. The scope defines
who the evaluator can evaluate. The options are as follows:
n

All Teams—evaluators can evaluate any conversation,
including their own conversation. When this option is
selected, Evaluator's Teams will be disabled.

n

Scope Additions—evaluators can evaluate only
conversations for teams within their scope, their own
conversations, and the teams listed under Evaluator's
Teams. If there are no teams within the evaluator's scope
or listed under Evaluator's Teams, the evaluator can only
evaluate their own conversation.
Best Practices: To allow an agent or knowledge
worker to perform self evaluations, assign the
evaluator role and select Scope Additions from the
Evaluator scope drop-down list.

This field is enabled when the Evaluator check box is selected.
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Column

User Time Zone

Description

The time zone in which the user resides. The drop-down list
shows Coordinated Universal Time (UTC) time zone codes.
The time listed in contacts reflects the time zone selected in this
field.
Example: For agents in Chicago, select [-0600/-500]
America/Chicago.

Roles

Administrator

The roles assigned to the user. The available check boxes are
as follows:
n

Agent—available for ACD users only and disabled by
default.

n

Knowledge Worker—available for non-ACD users only.

n

Supervisors—disabled by default for ACD users.

n

Evaluator

n

Manager

n

Archive User

The administrator roles assigned to the user. The available
check boxes are as follows:
n

Business

n

Telephony

n

System—indicates the user is a system administrator. This
check box is disabled by default. See Administrator Configuration for more information on configuring system
administrators.

Supervisor’s ACD Teams Lists the ACD teams assigned to the supervisor in a
Unified CCX environment.
Supervisor’s QM Teams

Lists the QM teams assigned to the supervisor.

Evaluator's Teams

Lists the teams assigned to the evaluator.

Manager’s Groups

Lists the groups assigned to the manager.
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To link ACD users to Active Directory accounts when you initially set up Quality
Management:
1. From the User Administration window, click Link AD to ACD Users.
The Link AD to ACD Users dialog box appears.
2. Select the Active Directory domain that your users are in from the Domain drop-down list.
3. Select the path to your users from the UserPath list
You can select one or more user paths from this list. You can select one or more user paths
from this list.
4. Click Find.
The users who exactly match the search query appear in the list. The first five columns
display information from Active Directory. The last three columns display information from
the ACD.
5. Select the Active Directory accounts that you want to link to your ACD users, and then click
OK.
To link all users in the list, click Select All.
Note: If some ACD users have names that don’t exactly match their Active Directory
accounts, you have to link them individually.
The following figure displays selected users in the Link Active Directory to ACD Users dialog
box.
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The ACD users that you linked to Active Directory accounts appear on the Linked Users tab.
To link an ACD user to an Active Directory account:
1. From the User Administration window, click the Unlinked ACD Users tab.
2. Select the user you want to link, and then click Link User.
The Link Selected User dialog box appears with the user’s last name and first name already
filled in with the first two letters (plus an asterisk, which is a wildcard).

147

Personnel

Important: If the Active Directory account you are trying to link to an ACD user is
already assigned to the system administrator role, the following message appears:
AD user <Doe, John> is already designated as a QM user. Delete
user <Doe, John> first.

Delete the user as instructed (see User Administration), create a new non-ACD user
(see Creating a non-ACD User using Active Directory or Creating a Non-ACD User
without Active Directory) and then reassign the system administrator role to the user
(see Managing Administrators).
In a non-Active Directory environment, you must ensure that there is a replacement
non-Active Directory user assigned to the system administrator role because the
default administrator role in a non-Active Directory environment is no longer
available the moment you assign a user to the system administrator role in
Administrator Configuration.
3. Optional: Select the Active Directory domain that your users are in from the Domain dropdown list.
4. Optional: Select the path to your users from the UserPath list.
5. Enter your search criteria in one or more of the following fields:
n

Last Name

n

First Name

n

Windows Username

You can use an asterisk as a wildcard character. The asterisk matches any number of
characters.
6. Click Find.
The users who match the search query appear in the list.
7. Select the Active Directory account you want to link your ACD user with from the search
results, and then click OK.
The user you just linked now appears under the Linked Users tab.
To create a non-ACD user:
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1. From the User Administration window, click Create Users.
The Link New Users dialog box appears.
2. Optional: Select the Active Directory domain that your user is in from the Domain drop-down
list.
3. Optional: Select the path to your user from the UserPath list.
4. Enter your search criteria in one or more of the following fields:
n

Last Name

n

First Name

n

Windows Username

You can use an asterisk as a wildcard character. The asterisk matches any number of
characters.
5. Click Find.
The users who match the search query appear in the list.
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6. Select the specific Active Directory account that you want to link, and then click OK.
The non-ACD user you created appears in the Linked Users tab.
To assign Quality Management user roles to an ACD user:
1. Select the ACD user from the Linked Users tab in the User Administration window.
The user’s properties appear in the User Properties section of the window.
2. Select the desired role check box in the Roles section.
You cannot assign the agent role to an ACD user from Quality Management Administrator.
You can only assign agent and supervisor roles in.
You cannot assign the supervisor role to an ACD user from Quality Management
Administrator. You can only assign supervisor role in Unified CCX.
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Note: To assign the system administrator role to a user, see Administrator
Configuration.
3. If the user is assigned to the supervisor, evaluator, or manager role, assign the teams or
groups to the user and click Add.
4. Click Save.

Non-Active Directory Systems
In a non-Active Directory system, there are two types of users:
n

ACD User. A user set up as an agent and/or supervisor and assigned to a team in the
ACD. You can assign an ACD user to manager, evaluator, and archive user roles in Quality
Management.
An ACD user can only be assigned the agent role or supervisor role in Unified CCX. You
can only assign ACD teams to a supervisor in Unified CCX.
Note: An ACD user is not a part of Quality Management system until you configure
the ACD user in Quality Management Administrator.

n

Non-ACD User. A non-agent user set up in Quality Management.
A non-ACD user exists only in Quality Management. The non-ACD user does not exist in
the ACD. A non-ACD user can be an evaluator, manager, supervisor, knowledge worker,
and/or archive user, but not an agent.
You can assign non-ACD users to the following roles: knowledge worker, supervisor,
manager, evaluator, and archive user.

The following table describes the buttons.
Tab

Description

Create Users

Add a non-ACD user. Non-ACD users are users that exist only
in Quality Management and Active Directory. Non-ACD users
do not exist in the ACD. You must link non-ACD users to an
Active Directory Account to be part of the Quality Management
system.

License Users

Assign a user with a license. See License/Unlicense Users for
more licensing information.
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Tab

Description

Delete User

Remove a non-ACD user. See Deleting an ACD User for
information on deleting an ACD user.

Edit User

Configure the user properties.

Add

Add an ACD team, QM team, or group to a list.

Remove

Delete an ACD team, QM team, or group from a list.

Save

Saves your changes.

Cancel

Cancels your current changes.

The following table describes the tabs.
Tab

Description

Configured Users

All non-ACD users who have been set up in Quality
Management. This includes the administrator.

Managers

Non-ACD users assigned to the manager role.

Evaluators

Non-ACD users assigned to the evaluator role.

Archive Users

Non-ACD users assigned to the archive user role.

Supervisors

Non-ACD users assigned to the supervisor role.

Agents

Non-ACD users assigned to the agent role in the ACD.

Knowledge Worker

Non-ACD users assigned to the knowledge worker role.

Not Configured Users

Non-ACD users who have not yet been set up in Quality
Management.

Unassigned Users

Non-ACD users not assigned to the manager, evaluator,
knowledge worker, supervisor, or archive user roles.

Administrators

Users assigned to the administrator role.

Search

Users found by the search feature.

Each tab displays information about the users that fall into its category, as shown in the following table.
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Column

License

Description

The license assigned to the user. The possible licenses are:
n

CR

n

AQM

A user must be licensed to be able to log into Unified Workforce
Optimization and be recorded.
Last Name

The user’s last name, as set up in the ACD or Quality
Management.
When syncing users from the ACD, this field displays the user’s
entire name (first and last name), and the First Name field
remains empty. If you are using QM authentication, a report that
normally displays a user’s first and last name only syncs the
information from the agent’s name field and displays the entire
name in the Last Name field.

First Name

The user’s first name, as set up in the ACD or Quality
Management.

User ID

The user ID assigned to the user.
If the user is an ACD user in a Unified CCX environment, the
format is <agent’s PG>.<agent’s ICM Peripheral Number>.
If the user is a Quality Management user, the Quality
Management system assigns a number.

Assigned Teams

The team assigned to the agent or knowledge worker.

Assigned Groups

The group assigned to the agent.

Windows Username

The user’s Windows user name.
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Column

Top Admin Role

Description

The highest administrator role assigned to the user. Use the
Admin Role drop-down list to assign the business or telephony
administrator role to a user. The possible values are as follows:
n

None—no administrator roles are assigned to the user.

n

Business—assigns the business administrator role to the
user.
Note: Only a system administrator or telephony
administrator can assign the business
administrator role to a user.

n

System—indicates the user is a system administrator.
Note: The Administrator Role drop-down list is
disabled when the user is a system administrator.
See Administrator Configuration for more
information on assigning users to the system
administrator role.

n

Telephony—assigns the telephony administrator role to
the user.
Note: Only a system administrator can assign the
telephony administrator role to a user.

When you select a user listed in any of the tabs, that user’s properties are displayed in the lower
section of the window. User properties are described in the following table.
Column

Description

License

The license assigned to the user.

First Name

The user’s first name, as set up in the ACD or Quality
Management.

Last Name

The user’s last name, as set up in the ACD or Quality
Management.
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Column

Assigned Team

Description

The team assigned to the agent or knowledge worker.
Note: The Assigned Team drop-down list only displays
teams containing knowledge workers.

User ID

The user ID assigned to the user. Quality Management assigns
a number to the user ID.

Windows Username

The user’s Windows user name.

Domain

The domain assigned to the user.

Evaluator Scope

The evaluation scope assigned to the user. The scope defines
who the evaluator can evaluate. The options are as follows:
n

All Teams—evaluators can evaluate any conversation,
including their own conversation. When this option is
selected, Evaluator's Teams will be disabled.

n

Scope Additions—evaluators can evaluate only
conversations for teams within their scope, their own
conversations, and the teams listed under Evaluator's
Teams. If there are no teams within the evaluator's scope
or listed under Evaluator's Teams, the evaluator can only
evaluate their own conversation.
Best Practices: To allow an agent or knowledge
worker to perform self evaluations, assign the
evaluator role and select Scope Additions from the
Evaluator scope drop-down list.

This field is enabled when the Evaluator check box is selected.
Auto Assign Evaluations

When selected, a new evaluation is automatically assigned to an
evaluator when the evaluator finishes the evaluation and
chooses Complete and Get Next Evaluation or goes to the
Recordings Evaluation Queue in the Recordings application.
When cleared, evaluators can choose which conversation to
evaluate next.
This field is enabled when the Evaluator check box is selected.
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Column

Roles

Administrator

Description

The roles assigned to the user. The available check boxes are
as follows:
n

Agent—available for ACD users only and disabled by
default.

n

Knowledge Worker—available for non-ACD users only.

n

Supervisors—disabled by default for ACD users.

n

Evaluator

n

Manager

n

Archive User

The administrator roles assigned to the user. The available
check boxes are as follows:
n

Business

n

Telephony

n

System—indicates the user is a system administrator. This
check box is disabled by default. See Administrator Configuration for more information on configuring system
administrators.

Supervisor’s ACD Teams Lists the ACD teams assigned to the supervisor in a
Unified CCX environment.
Supervisor’s QM Teams

Lists the QM teams assigned to the supervisor.

Evaluator's Teams

Lists the teams assigned to the evaluator.

Manager’s Groups

Lists the groups assigned to the manager.

To configure the ACD user for Quality Management:
1. On the Not Configured Users tab, locate and select the user you want to configure.
2. In the User Properties section, click Edit User and enter the user’s Windows Username and
Quality Management Password.
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The Windows user name must be unique, but users can have the same first and last
names. It must be between 1 and 64 characters long, cannot consist entirely of spaces,
and cannot include these characters: / \ [ ] : ; " | = , + * ? < > ( )
3. (Optional) Select a desired role from the Administrator Role drop-down list.
4. (Optional) Select the desired scope from the Evaluator Scope drop-down list.
5. If necessary, assign the user the Evaluator, Archive User, and/or Manager role by selecting
the check boxes next to those roles.
l

l

If you assigned the Manager role, you can now assign a group to the manager by
clicking Add under the Manager’s Groups section and selecting the appropriate
group.
If you assigned the Supervisor role in a CCX environment, you can now assign a team
to the supervisor by clicking Add under the Supervisor’s ACD Teams section and/or
Supervisor’s QM Team and selecting the appropriate team.

6. Click Save.
The ACD user is removed from the Not Configured User tab and appears under the tab for
each role that you assigned to the ACD user. For instance, if you assigned the ACD user to
the evaluator role, the ACD user appears under both the Agents tab and the Evaluators
tab.
Note: The ACD users initially appear under the Agents and/or Supervisors tabs and
non-ACD users under the Unassigned Users tab.

To create a non-ACD user:
1. Click Create User.
The Create User dialog box appears.
2. Complete the fields, and then click OK.
The Windows user name must be unique, but users can have the same first and last
names.
The Roles section is enabled. You can assign a role to the new user at this time, or do it
later.
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A user ID (Windows Username) is assigned to the new user and the user appears under the
tab for each role that you assigned the user, or under the Unassigned Users tab if you did
not assign any roles to the user.
To assign roles to a non-ACD user:
1. Select the non-ACD user from the Unassigned Users tab.
The user’s properties appear in the User Properties section of the window.
2. Select the desired role check box in the Roles section.
If you assigned the Knowledge Worker role, you can now assign the knowledge worker to a
team using the enabled Assigned Team field. Select the appropriate team from the dropdown list. The team can consist only of knowledge workers.
Note: Quality Management does not record the knowledge worker until you assign
that user to a team.

Note: To assign the system administrator role to a user, see Administrator
Configuration.
3. If the user is assigned to the supervisor, evaluator, or manager role, assign the teams or
groups to the user and click Add.
4. Click Save.

License/Unlicense Users
The License/Unlicense Users dialog box displays a list of users and available licenses. You can use this
dialog box to:
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n

Assign a license to one or more users.

n

Unlicense one or more users.

Personnel

Users must be licensed to log into Unified Workforce Optimization and to be recorded. A user’s license
status is displayed in the User Administration window.
The total number of licensed users is displayed on the User Administration interface to the right of the
Delete User button. The number displayed updates as soon as the users are licensed or unlicensed.
Users’ license status can be changed only after they have been linked to an AD user (in AD systems) or
configured (in non-AD systems).
The number of licenses you have is configured when your system is installed. More information about
managing your licenses can be found in License.

To change a user's license status:
1. From the User Administration window, click License Users.
The License/Unlicense Users dialog box appears. It displays a list of all linked users and the
available licenses.
2. Select the users whose license status you want to change.
n

Use Shift + Click to select contiguous rows in the list of users.

n

Use Ctrl + Click to select non-contiguous rows in the lists of users.

3. Select the license type you want to assign to the selected users and click OK. The possible
recording types are:
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n

AQM

n

AQMS+

n

CR

n

CRS+

n

Unlicensed—removes a license from a user.

The license is assigned to the users. The users can log into Unified Workforce Optimization
and the users can be recorded.
Note: Changes in license status go into effect the next time the user attempts to log
in.

Deleting an ACD User
You cannot delete the ACD user from Quality Management Administrator. You can only delete the ACD
user from the ACD system. However, you can change the ACD user to unlicensed, which means that
the user cannot log in to Unified Workforce Optimization and the user will not be recorded.

Deleting a Non-ACD User
To assign roles to a non-ACD user:
1. Select the non-ACD user you want to delete on one of the tabs in the User Administration
window.
2. Disable all roles assigned to the non-ACD user, remove any team associations and group
associations, and then click Save.
3. Click Delete User.
A dialog box asks you to confirm that you want to delete the selected non-ACD user.
4. Click Yes.
The non-ACD user is deleted.

Team Administration
The Team Administration window enables you to:
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n

View the agents, supervisors, and group belonging to a selected team.

n

Assign non-ACD supervisors to a team of ACD agents.

Personnel
n

Create, rename, and remove non-ACD teams.

n

Assign knowledge workers, ACD supervisors, and non-ACD supervisors to teams.

Assign agents and ACD supervisors to teams in Unified CCX. You cannot change team assignments in
Quality Management Administrator.
You cannot assign knowledge workers to the same team as agents. Knowledge workers must belong to
a non-ACD team made up only of knowledge workers.
You can assign non-ACD supervisors to an ACD team and ACD supervisors to a non-ACD team.
You cannot create, rename, or remove an ACD team. Create and maintain ACD teams in Unified CCX.

Managing Teams
To manage teams:
n

To configure an ACD team in a Unified CCX environment, choose an ACD team from the
Team drop-down list, add or remove QM supervisors, and then click Save.
When a team is created in Unified CCX, you can only change the QM Supervisors
assigned to the team.

n

To add a non-ACD team, click New, type the team’s name in the field, and then click OK.
Click Add under the each role and select the desired names from the list, and then
clicking OK. When the new team is complete, click Save.
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The team’s name must conform to the following rules.

n

l

The team’s name must be unique.

l

A team’s name cannot be longer than 32 characters.

To assign people to a non-ACD team, choose the team from the Team drop-down list.
under the each role and select the desired names from the list, and then clicking OK.
When the update is complete, click Save.
Use Shift + Click to select adjacent people and Ctrl + Click to select non-adjacent people.

n

To remove people from a team, select the people you want to remove from a section,
click Remove underneath the section, and then click OK.

n

To rename a team, select the team you want to rename from the Team drop-down list,
click Rename, type the new name in the field, and then click OK.

n

To delete a team, select the team you want to delete from the Team drop-down list, click
Delete, and then click Yes
Remove the team from the quality management workflow before you delete the team.
Note: You cannot delete a team if the team is assigned to a quality management
workflow. You can delete a team if the team is assigned to an archive workflow.

n

To delete a team, select the team you want to delete from the Team drop-down list, click
Delete, and then click Yes
Remove the team from the quality management workflow before you delete the team.
Note: You cannot delete a team if the team is assigned to a quality management
workflow. You can delete a team if the team is assigned to an archive workflow.

Group Administration
Groups contain teams and managers assigned to the groups. From the Group Administration window,
you can:
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n

Create, rename, and delete a group.

n

Add and remove teams from a group.

n

Add and remove managers from a group.

Personnel

To manage groups:
n

To add a group, click New, type the group’s name in the field, and then click OK. Add
teams and managers to the group by clicking Add underneath each section, selecting
the desired names from the list, and then clicking OK. When the new group is complete,
click Save.
The group’s name must conform to the following rules.

n

l

The group’s name must be unique.

l

A group’s name cannot be longer than 32 characters.

To add teams to a group, select the group from the Group drop-down list, click Add under
the Assigned Teams section. Select the team or teams you want to assign to the group
from the list of available teams, and then click OK. When the group is complete, click
Save.
Use Shift + Click to select adjacent teams and Ctrl + Click to select non-adjacent teams.
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Note: A team can belong to only one group. If you assign a team to a group and it
already belongs to another group, Quality Management will ask you to confirm
moving the team from one group to another group.

n

To remove teams from a group, select the group from the Group drop-down list, select
the teams you want to remove from the group, and then click Remove. When the group
is complete, click Save.

n

To add managers to a group, select the group from the Group drop-down list, click Add
under the Assigned Managers section. Select the manager or managers you want to
assign to the group from the list of available managers, and then click OK. When the
group is complete, click Save.

n

To remove managers from a group, select the group from the Group drop-down list,
select the managers you want to remove from the group, and then click Remove. When
the group is complete, click Save.

n

To rename a group, select the group you want to rename from the Group drop-down list,
click Rename, type the new name in the field, and then click OK.

n

To delete a group, select the group you want to delete from the Group drop-down list,
click Delete, and then click Yes
Remove teams assigned to the group, from the quality management workflow before
you delete the group.
Note: You cannot delete a group if any teams in that group are assigned to a
quality management workflow. You can delete a group if the teams in that group
are assigned to an archive workflow.
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The Recordings node allows you to configure when a customer conversation is recorded.
There are two types of recordings: those made for quality management purposes, and those made for
archiving purposes. Quality management recordings can include voice and screen recordings. Archive
recordings are voice only.
Quality management recordings and archive recordings use workflows to determine which recordings
of inbound and/or outbound calls (“calls of interest”) to save for evaluation or archival purposes. You
can assign teams to a workflow. Some examples of why you would record calls of interest are:
n

Tracking the performance of specific agents

n

Helping train new agents

n

Monitoring calls during a sale period

n

Monitoring calls during specific times of day

n

Monitoring calls from specific customers or specific phone numbers

Quality Management saves recordings that are at least 5 seconds long. Quality Management does not
consider a recording of less than 5 seconds a valid recording. For quality management purposes, you
can change the minimum duration in the WHAT rule for the quality management workflow classifier.
You cannot change the minimum duration for an archive workflow.
Quality Management does not support voice or screen recordings that are longer than 12 hours. If you
think a call will last longer than 12 hours, you need to stop recording the call before the call reaches
the 12 hour mark, and then start a new recording.
Quality Management displays the time associated with a contact as the time the contact occurred at
the agent’s location, expressed in 24-hour HH:MM:SS format.

Example: If the agent is located in Chicago, the time associated with any recorded contacts
made by that agent is Chicago local time.
The contact also displays the abbreviation for the local time zone. If the time zone associated with the
contact is unknown to Quality Management, then Quality Management displays the time in Greenwich
Mean Time (GMT).
Use the Recordings node to:
n

Configure recording retention periods for a workflow

n

Create quality management workflows for a team

n

Create and maintain evaluation forms
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n

Create archive workflows for a team

n

Configure and manage user-defined metadata

n

Configure thresholds for talkover and silence events in the Unified CCX environment

8-bit and 16-bit QM Recording
QM initially creates 16-bit recordings, but when the customer selects WAW-8 format recordings option,
it converts the 16-bit linear PCM data to 8-bit linear PCM. This process removed data from the
recording, and in cases where the audio volume was low, it could produce 8-bit audio that contained
static or a background hiss.
QM changes the internal definition of 8-bit to be WAV files containing u-Law compressed audio. This
stores the samples as 8-bit values without losing any information from the audio.
The following modules, processes, and services need to call the appropriate functions in the ASP
library to convert a u-Law WAV file to a 16-bit PCM WAV file if required for their processing of the audio
data:
n

Media Encoder service

n

Silence/talkover processing

n

Phonetic speech processing module

n

LVCSR processing

If customers record to 8-bit WAV files and upgrade to anything less than 9.3 SR3 ES4, 9.4 SR3 or 9.5
SR2 ES1, they will not be able to play back recordings.

Cisco MediaSense Recording Considerations
A workflow is configured to save recordings based on certain rules as they apply to individual contacts
(sessions). Using Cisco MediaSense Recording might result in more than one contact for a single call.

Example: If an agent places a call on hold, two contacts are created that will be evaluated
individually for a workflow. In this instance, a single call could produce a “shortest call” contact
(before the hold) and a “longest call” contact (after the hold). Alternatively, a single call
recorded by Cisco MediaSense Recording might result in one of multiple contacts (sessions)
being uploaded. It is also possible that some sessions in a single call might not be uploaded
based on the rules configured for the quality management workflow.
For this reason, Cisco recommends you choose the 100% QM Logging option when you configure
quality management workflows to guarantee the entire call appears in the Recording application for
Unified Workforce Optimization.
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Recording Retention
The administrator determines the amount of time contacts are retained for quality management
workflows and archive workflows.
The retention period for recorded calls is specified at the workflow level. The age of a call is based on
the day the call was recorded. This value is not updated by any actions performed on the recorded
call. The expiration date is the last day of the retention period.
Teams assigned to a workflow will share the same retention period.

Example: Two teams associated with one workflow might handle calls that require call
recordings to be kept for 7 years. A team associated with another workflow might handle calls
that require call recordings to be kept for only a year.
The length of time that quality management recordings are retained and configured is under the
Quality Management > Workflows node and the length of time archive recordings are retained and
configured is under the Archive > Workflows node.
Quality Management observes the following rules when determining retention time.
n

Every quality management workflow has individual retention periods for HR, Scored,
Tagged, Training, and Unscored calls.

n

Every archive workflow has individual retention periods for Archive and Tagged calls.

n

Different calls might be retained for different retention periods, depending on the
workflow retention period assigned to the call.

n

If a call is marked as Tagged, the screen recording file will be deleted at the end of the
quality management Tagged retention time. The audio file will be deleted at the end of
the longer retention time for the quality management Tagged or archived Tagged
retention time. Quality Management deletes metadata associated with a call when the
longest of the quality management Tagged, archived Tagged, or metadata retention
times is reached. By default, call data is stored for 13 months.
The following example shows how Quality Management handles Tagged retention when
both archive and quality workflows exist:
l

A contact is recorded for both quality management and archiving. It is also marked
as Tagged by the user.
o

Quality management Scored retention time is two months

o

Quality management Tagged retention time is 6 months
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o

Archive retention time is one year
Metadata retention time is thirteen months

o

l

l

Archive Tagged retention time is ten years

After 6 months, the screen recording is deleted and is no longer available.
After ten years, the audio recording and metadata are deleted and no longer
available.
Applications in Unified Workforce Optimization
Time

Data

where you can access the data

For 6 months

Screen
recording

Recordings

For 10 years

Audio
recording

Recordings

For 13 months

Metadata
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n

A quality management workflow retention period is assigned at the End of Day (EOD).

n

Once the retention period is assigned to a call, the call’s retention period can only be
changed by changing the retention times in the workflow in which the retention periods
were originally assigned.
Note: Remember that reducing a retention period after it has been initially set
can result in the deletion of recordings, and that increasing a retention period will
result in a larger use of storage space. Changing these values should be
considered carefully.

n

Once the retention period is assigned to a call, the call’s retention period will not be
changed if a team is moved from one workflow to another workflow. Subsequent calls
associated with the new workflow will use the retention period assigned to the new
workflow.

n

When you delete a workflow, any calls assigned to that workflow retain the last known
retention times for the deleted workflow.

Quality management contacts are retained according to the limits shown in the following table.

168

Recordings

Note: For retention purposes, 1 month = 30 days, and 1 year = 365 days.

Recording Type

Retention Period

Scored

1 day—unlimited (default = 30 days)

Unscored

1 day—unlimited (default = 30 days)

HR

1 day—unlimited (default = 6 months)

Training

1 day—unlimited (default = 6 months)

Tagged

1 day—unlimited (default = 120 months)

Metadata

13 months
Note: You cannot change the recording retention period for
metadata.

Archive workflow contacts are retained according to the limits shown in following table.
Recording Type

Retention Period

Archive (audio recordings 1 month—Unlimited (default = 84 months)
only)
Tagged

1 month—Unlimited (default = 120 months)

Contact Information

13 months minimum in both the Dashboard and Reporting
applications

Customizable Retention Rules
You can assign a different retention period for contacts with specific custom metadata and from one
or more specific geographic areas, based on the contact’s area code (ANI/DNIS). The retention period
you set can be different than that for the user's regular workflow.

Note: The customized retention policies you set are given the highest retention rule priority;
previously set retention rules could be overridden by custom retention policies.
For more information, refer to Retention Rules.

About Workflows
A workflow allows you to specify rules and classifiers to designate the types of contacts you want to
record. There are two types of workflows:
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n

quality management workflow—specifies the types of calls you want to save for quality
management recordings

n

archive workflow—specifies the types of calls you want to save for archive recordings

Changes to a workflow take effect immediately.
The following list describes when workflow processing occurs:
n

Beginning of Call (BOC)—this occurs when Voice Recording services get a message that
recording has started.
Note: This does not occur for screen recordings or Cisco MediaSense Recordings.
They only insert contacts after the recording is complete (EOC).

n

End of Call (EOC)—this occurs when the Voice Recording services are complete and the
recording has been converted, and the duration and derived metadata has been
discovered.

n

Non-Call Evaluation—this occurs when a user creates a non-call evaluation from the
Recordings application in Unified Workforce Optimization.

n

Metadata Reconciliation—this occurs when metadata is sent to the Server API to assign
metadata to a contact.

n

Quality Workflow Processing—This occurs after EOD for each configured quality workflow.

Before you create a workflow, you need to:
n

Set up users and groups

n

Assign teams to a group (required for quality management workflow; not required for an
archive workflow)

n

Create an active evaluation form (quality management workflow only)

You can set up multiple classifiers for a workflow. They are executed in the order they are listed (from
top to bottom) in the workflow navigation tree. This enables you to create classifiers that are subsets of
more general classifiers.
To change the order of classifiers in the navigation tree, select the classifier and use the Up and Down
arrow buttons to move it up or down in the navigation tree.
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Quality Management Workflows
This topic describes the Workflow Administration window and provides tasks to create and maintain
quality management workflows.

Note: Quality Management workflows are only available if you have quality management
licenses.
When a non-contact call is created or an Archive contact is marked for quality in Unified Workforce
Optimization, the contact assumes the retention times for unscored and scored contacts configured
in the quality management workflow for that agent's team. If you plan to use the Create Contact or
Mark for Quality features, Cisco recommends placing all users under a quality management workflow
in order to set the retention periods for these contacts. If no additional quality recordings are required
the quality management workflow classifier can be set to exclude recording on all numbers so the
quality management workflow will not cause any additional recording.

Workflow Administration
Use the Workflow Administration window to create quality management workflows based on team. The
quality management workflow includes specific rules and classifiers to designate the types of contacts
you want to record. These calls will be recorded for evaluation and review.
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Field

Workflows

Description

Lists the existing workflows. To modify the workflows that
appear in this list, choose one of the following options.
n

New—add a new workflow to the list

n

Rename—change the name of an existing workflow

n

Delete—remove a workflow from the list

Rename and Delete are enabled when you select an active
archive workflow from the list.
Name
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Field

State

End of Day

Description

The status of the workflow. The Possible states are as follows:
n

Active—The entire workflow can be modified.

n

Inactive—The modifiable parts of the workflow are limited
to the fields under Settings and Recording Retentions. An
inactive workflow is a default workflow that is not
associated with any agent. That is, the columns (Agent,
Team, and so on) remain blank in the search results.

The workflow is uploaded at the end of the selected day.
Recording still continues, but those recordings are uploaded
after the next EOD. Enter the time for the end of the work day in
24-hour format.
If the EOD is changed, the new EOD goes into effect
immediately and the Data API service will process calls using
the new EOD time. If the EOD changes after the Upload
Controller gets the original EOD, the Upload controller might
wait to upload recordings until after the original EOD time has
passed.

Enable Screen Recording

When this check box is selected, screen recording is enabled on
the agents' desktops and the Recording Controls application.
When the check box is clear, screen recording is disabled on the
agents' desktops and the Recording Controls application.

Immediate Voice Upload

When this check box is selected, audio recordings associated
with this workflow are immediately uploaded after the recording
completes. When the check box is clear, the normal upload
setting rules are in effect. This option applies to all recording
types.
If you change the Immediate Voice Upload option during the
day, the change does not go into effect until the quality
management workflow is reloaded after the End of Day.
For Desktop Recording, it is possible that audio recordings
waiting for upload can be lost if an agent’s PC crashes. Enabling
immediate uploading prevents this problem.
If you enabled two stage upload, audio recordings are uploaded
immediately using the two stage upload process.
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Field

Description

Immediate Screen Upload When this check box is selected, screen recordings associated
with this workflow are immediately uploaded after the recording
completes. When the check box is clear, the normal upload
setting rules are in effect. This option applies to all recording
types.

If you change the Immediate Screen Upload option during the
day, the change does not go into effect until the quality
management workflow is reloaded after the End of Day.
For Desktop Recording, it is possible that screen recordings
waiting for upload can be lost if an agent’s PC crashes. Enabling
immediate uploading prevents this problem.
If you enabled two stage upload, screen recordings are
uploaded immediately using the two stage upload process.
Note: In some cases, screen recordings in a Gateway
Recording environment configured for immediate upload
might take up to 10 minutes after the associated call is
reconciled to begin uploading. To avoid this delay and
ensure that screen recordings are uploaded immediately
after they complete, enable two stage upload in Site
Settings.
Allow Evaluators to
Change Form

Choose this option if you want to allow evaluators to select the
evaluation form they want to use.

Extend Screen Recording
(in seconds)

The number of seconds screen recording continues to record
after-call work after a call is dropped.

When you enter a value in this field, after call work screen
recording continues when a new call starts. This can consume
storage resources.
New Call Ends Extended
Screen Recording

When a value is entered in Extend Screen Recording, you can
choose this option to automatically end the first call’s screen
recording when a new call starts.

Recording Retentions

Set the length of time you want the various types of recordings
to be retained.

Teams Assigned to
Groups

Teams assigned to groups appear in this list.
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Field

Assigned Teams

Description

Teams assigned to this quality management workflow appear in
this list. A team can belong to only one quality management
workflow at a time.

Classifier Configuration
Use the Classifier Configuration: <workflow name> window to create, rename, or delete classifiers for a
quality management workflow.

Field/Option

Evaluation Form

Description

Select the form you want to use to evaluate the recorded calls.
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Field/Option

Record

100% QM Logging

Description

Select this option to record calls, and then choose from the
following options:
n

100% Recording Logging

n

Inbound

n

Outbound

Select this option if you want to configure a classifier that does
not use rules, but rather records all calls defined by the classifier.
If you clear this check box, you must configure at least one rule
for a Ringing Event. See Setting up Rules for a Classifier’s
Ringing Event for more information.

Inbound and/or Outbound Select which calls to be recorded—inbound, outbound, or both.
You must select at least one call direction.
Don’t Record

Use this option if you want agents to selectively tag calls for
recording using the Tag command.
This option allows you to exclude specific phone numbers or
area codes from recording. For example, a workflow for a team
has two classifiers in the following order:
n

Do not record a call for this workflow if the Calling
Number begins with 612* because the area has rules
against recording calls.

n

Record all calls with a Calling Number of *.

The first classifier excludes all calls that originate from a number
that starts with 612* from recording. The second classifier
records all calls that are not excluded by the first classifier.
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Field/Option

Numbers

Description

Select the type of number you want to use to filter the calls,
Called Number or Calling Number.
If the call is inbound, the Called Number is the route point
number if the call was routed, or the agent extension if the call
was direct dial. The Calling Number is the original number from
which the caller is dialing.
If the call is outbound, the Calling Number is the agent’s
extension, and the Called Number is the number of the
customer/client.
Note: If you add phone numbers to the Called Number
section, then select Calling Number from the Numbers
drop-down list, the phone numbers you added will be
deleted. The reverse is also true. If you add phone
numbers to the Calling Number section, then select
Called Number from the Numbers drop-down list, the
phone numbers you added will be deleted.

Called/Calling Number

Click Add to specify the phone numbers you want to filter for in
the Numbers field. You can enter:
n

Specific numbers
Example: 6125551212

n

Number ranges using wildcards
Example: 612*, where the * wildcard stands for
any number of digits, or 612555????, where the ?
wildcard stands for 1 digit

n

The * wildcard to record all calls

The numbers you enter cannot contain dashes or parentheses,
and must be between 1 and 16 characters long.

Creating a Quality Management Workflow
You must assign a team to a group before you can assign that team to a quality management workflow.
If you did not assign that team to a group, the team does not appear in the Teams Assigned to Groups
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section.

Note: A team can belong to one archive workflow and one quality management workflow.

To create a new quality management workflow:
1. In the navigation tree, select Recordings > Quality Management > Workflows
The Workflow Administration window appears.
2. Next to the Workflows section, click New.
The Workflow Name dialog box appears.
3. Enter a unique name for the new quality management workflow, and then click OK.
The quality management workflow now appears in the Workflows section.
4. Select the quality management workflow from the Workflows list.
5. Enter the time for the end of the work day in 24-hour format.
If the options are changed during the day, they do not go into effect until the quality
management workflow is reloaded just before the End of Day.
6. Select Immediate Voice Upload if you want to upload an audio recording immediately after
the recording is completed.
7. Select Immediate Screen Upload if you want to upload an audio recording immediately after
the recording is completed.
8. Select the Allow Evaluators to Change Form check box if you want to allow evaluators to
choose the evaluation form they want to use.
9. Specify the time, in seconds, the screen recording should continue after the call ends.
10. Set the length of time you want the various types of recordings to be retained
If you want recordings to be retained indefinitely, select the Unlimited check box associated
with the recording type. The minimum amount of time a recording can be retained is one
day for Scored and Unscored recordings and 1 month for Tagged, HR, and Training
recordings.
11. Assign teams to the quality management workflow.
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A team can belong to only one quality management workflow at a time. If a team that you
want to assign to this quality management workflow already belongs to another quality
management workflow, it will automatically be reassigned to this quality management
workflow. Quality Management Administrator displays a warning message telling you that it
reassigned the team from another quality management workflow.
12. Assign teams to the quality management workflow.
13. When you finish configuring the quality management workflow in this window, click Save.

Setting up Classifiers for a Quality Management Workflow
To set up classifiers for a quality management workflow:
1. Under the Quality Management > Workflows node, select the workflow you just created
The Classifier Configuration: <workflow name> window appears.
2. In the Classifiers section, click New to create a new classifier.
The Classifier Name dialog box appears.
3. Enter a name for your new classifier, and then click OK.
The new classifier is now listed in the workflow navigation tree.
4. Select the new classifier in the workflow navigation tree.
5. In the Classifier Settings section, select one of the following options.
l

Record—Select this option to upload recorded calls and then choose from the
following options: 100% QM Logging, Inbound, or Outbound. Then choose the type of
number (Called Number or Calling Number) you want to include from the Numbers
drop-down list and then click Add and enter the included numbers.
Note: You must select at least one call direction (Inbound or Outbound).

l

Don’t Record—Select this option to exclude specific phone numbers or area codes
from recording. Choose the type of number (Called Number or Calling Number) you
want to exclude from the Numbers drop-down list and then click Add and enter the
excluded numbers.

6. Click Save to save the classifier settings.
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If you did not select 100% QM Logging, you must now configure at least one rule for a Ringing Event.
See Setting up Rules for a Classifier’s Ringing Event for more information.

Note: The following message appears if a rule is not configured or you do not choose 100%
QM Logging:
Classifier <name> must have at least one rule or 100% QM logging enabled.

Configuring Actions for the Ringing, Answered, and Dropped Events
Each event in the workflow navigation tree is associated with one or more optional actions as follows.
n

Ringing event: Screen Recording Upload

n

Answered event: Start Voice Recording

n

Dropped event: Stop Voice Recording

Quality Management Administrator enables action settings by default.

To configure actions for ringing, answered, and dropped events:
1. Under Ringing Event, choose Actions and select the Screen Recording Upload check box if
you want to upload screen recordings after the call ends.
Screen Recording Upload is not available at the CR or QM license level.
2. Under Answered event, choose Actions, and select the Start Voice Recording check box if
you want to start voice recording when the call is answered.
3. Under Dropped Event, choose Actions and select the Stop Voice Recording check box if you
want to stop audio recording when a call is dropped:
4. Click Save to save the action settings.

Modifying a Quality Management Workflow
To modify a quality management workflow:
1. Select Recordings > Quality Management > Workflows in the navigation tree.
The Workflow Administration window appears.
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2. Choose one or both of the following options.
l

l

Select the workflow from the Workflows section to modify the assigned teams or the
workflow settings.
Select the workflow under the Workflow node in the navigation tree to modify the
workflow’s classifiers, rules, and actions.

3. When you finish your changes, click Save.
Quality Management Administrator saves the changes to the modified workflow.
Note: The modified workflow goes into effect after the agents assigned to the
workflow log out and log back in to their Windows session, or after the configured
End of Day. The quality management workflow information is updated before upload
occurs so that any changes during the day will take effect.

Setting up Rules for a Classifier’s Ringing Event
You must set up at least one rule for a Ringing Event if you have configured the classifier without
100% QM Logging.
Rules do not apply to classifiers that are configured with 100% Recording Logging.

To set up rules for a classifier’s ringing event:
1. In the workflow navigation tree, under the classifier, select Ringing Event.
The Rule Configuration window appears.
2. Click New to add a new rule.
The Rule Name dialog box appears.
3. Enter a name for the new rule, and then click OK.
Quality Management Administrator adds the new rule to the workflow navigation tree
underneath the Ringing event and the What, Who, and When tabs appear (see the
following figure).
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Note: As with classifiers, multiple rules may be set up and ordered from least to
most specific.
4. On the What tab, select the calls you want to record.
Note: You can configure up to five random call rules, as well as the minimum and
maximum call duration.
5. Click the Who tab.
The Who tab on the Rule Configuration window appears.
6. Select Agent or Team from the Select Who drop-down list.
7. In the Available Agents/Available Teams section, select the agent or team you want the
workflow to apply to, and use the arrow buttons to move those agents or teams to the
Assigned section.
8. Click the When tab.
The When Tab on the Rule Configuration window appears.
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9. Select when the workflow runs from the Select When drop-down list. Your choices are:
l

Set of Dates—select specific dates

l

Weekly—select the days of the week

l

Date Range—select a start and stop date

10. When you are finished configuring the workflow rules, click Save.

Deleting a Quality Management Workflow
Before you delete a quality management workflow, please consider the following information:
n

Once a workflow is deleted, you cannot adjust the retention times for calls associated
with the workflow or reactivate the workflow.

n

Quality management workflow settings are updated before upload. If you delete a quality
management workflow, the calls associated with the quality management workflow are
not uploaded.

To delete a quality management workflow:
1. Select the workflows node under Recordings > Quality Management > Workflows in the
navigation tree.
The Workflow Administration window appears.
2. Select the workflow from the Workflows pane and click Delete.
The Confirm Deletion dialog box appears.
3. Click Yes to confirm the deletion
Quality Management Administrator deletes the quality management workflow and the
status of the workflow changes to Inactive. The deleted workflow goes into effect after the
agents assigned to the workflow log out and log back in to their Windows session, or after
the configured End of Day.

Best Practices for Agent Evaluations
This section describes best practices for agent evaluations using Quality Management.
The goal of quality management is to establish consistency throughout the contact center. So no
matter what agent a customer calls on any given day, they get a consistently excellent user experience.
This allows you to:
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n

Reduce labor costs through efficiencies

n

Identify customer needs and expectations

n

Improve customer satisfaction

Quality Management Training Process
The quality management training process is a continuous improvement cycle.

The quality management training process requires you to:
n

Collect call recordings—Quality Management selects and processes phone calls
identified in the workflow.

n

Evaluate the call recordings—Supervisors or evaluators review and score the selected
recordings against Key Performance Indicators (KPIs).

n

Create reports based on evaluations that:

n
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l

Compare the performance of agents, teams, and the entire organization

l

Identify initiatives for quality improvements and training

Refine agents’ performance by:
l

Using quality calls for training

l

Reevaluate agents to gauge training effectiveness and measure skills

l

Repeat or select the next quality management initiative
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Determining Type of Calls to Record or Evaluate
Quality Management provides a two-level filter: you decide what calls you want to record, and from
those recorded calls, you then decide what calls you want to evaluate.
Quality Management has a unique workflow-based recording decision process that allows you to
create sophisticated criteria or triggers so that you can sort through all calls in the contact center and
identify those calls determined most likely to provide value when evaluated.
Quality Management:
n

Eliminates time sifting through irrelevant calls—using workflows allows you to eliminates
the time required to choose which calls to evaluate from a long list of unsorted calls. An
evaluator might spend an inordinate amount of time choosing calls to evaluate at
random. The workflow process allows you to identify relevant calls for evaluation.

n

Manages storage use—using workflows also allows you to manage your storage use. The
Advanced license includes the screen recording feature, which takes up significant
recording space at a rate of one megabyte per minute of recorded material. So you need
to be judicious when choosing which calls you want to record to manage storage space
on your Recording Server.

The following list provides examples of criteria you can build into your workflow criteria.
n

First call of the day—you can base your criteria on time management.
Example: You can choose to record the first call of the day, or the first two calls of
the day. Or you can choose to record the first call after lunch.

n

Longest or shortest call—you can choose to record the two or three longest calls or
shortest calls of the day for each agent. This allows you to understand some of the
components of long calls, or simply understand why the call handle times exceed the
norm. You can also set up a workflow to record three or four of the shortest calls of the
day to determine why you get 15 or 20 second calls.

n

Peak hour—you can choose to record several calls during peak hours.
Example: You could choose to record 3 calls at random during your peak hour
period between 1–2pm, so you can get a good assessment of how agents are
handling callers. Are they providing the same quality while there are callers in
queue?
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n

Specific (new) agents—if you are concerned about an agent’s performance, or you have a
new agent, you can record 100% of the agent’s calls for a specified period (for example,
two weeks). This allows you to understand their activities and get them up to speed with
the rest of your agents.
Specific customer or account ID—you can choose to add custom metadata fields at the
time of the recording. The information can include a customer ID, account ID, or
transaction code. The metadata field allows you to provide data like:
l

Did this call result in a sale? Yes/No.

What was the dollar value of the sale?
The date can come from the IVR data or the Enterprise data managed through CAD.
l

n

Identifying KPIs
You need to identify the business goals for the contact center for the current year and incorporate
those goals into the Key Performance Indicators (KPIs).

Example: Your contact center’s business goals could be to increase revenue, improve
customer satisfaction, or reduce overall cost.
A KPI can have a positive or negative impact on your contact center's business goals.

Example: If an agent turned an unhappy customer into a happy customer, the agent had a
positive impact on the your contact center's business goals. If another agent lost a potential
sale, that would have a negative impact on your contact center's business goals.
When you know what your business goals are you can incorporate those goals as answers to questions
in the evaluation form and assign KPIs to those questions. This allows you to align your agents’ goals
with the business goals for the contact center. You can then use the evaluation forms to measure your
agent’s performance against your contact center’s business goals.
When you break down the business goals, you need to identify the areas of challenges and the
metrics you have for success in meeting those business goals. For example, you can break the
business goals into:
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n

First Contact Resolution (FCR)

n

Sales process and skills

n

Product knowledge—you can use call evaluation to identify agents who do not have
sufficient product knowledge, and then provide training to improve their product
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knowledge. For example, you might want to consider the following questions when
evaluating an agent:
l

Does the agent have deep product knowledge?

l

Is this a critical indicator or a challenge area?

n

Agent proficiency with tools—agents sometimes have to deal with a wide variety of tools
when they deal with a customer. For example, order entry tools, agent productivity tools,
database tools, or custom software tools designed for the organization. You can use the
evaluation to monitor agent proficiency with your contact center’s tools, and then
provide training to improve their tool proficiency.

n

Average call duration—some calls are longer than others. You can use the evaluation to
understand what impact factors result in longer calls, and then provide solutions that
result in fewer long calls, and improve the average call duration.

Evaluation Goal Administration
The Evaluation Goal Administration window allows you to assign goals to evaluators.

Note: Evaluation Goal Administration is directly related to Auto Assign Evaluations. Use
Evaluation Goal Administration to determine how many evaluations to automatically assign to
an evaluator.
The Evaluation Goal Administration window displays the following information.

Field

Description

Goal

The goal’s ID.

Name

The name of the goal.

Action

The required action of the goal. The options are as follows:
n

Calibrate. Calibrate these contacts.

n

Evaluate. Evaluate these contacts.

n

Review. Listen to all or a specified percentage of the contacts.
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Field

Status

Description

The current status of goal. The options are as follows:
n

Editable. The goal can be modified, renamed, and
deleted. It is not yet available for evaluators to use.

n

Active. The goal is available for evaluators. Only the
assigned evaluators can be modified. An active goal cannot be deleted.

n

Inactive. The goal is no longer available for use by evaluators. It will be deleted automatically as soon as all goals
based on it are removed from the database.

Add

Create a new goal. See Managing Evaluation Goals for more
information.

Rename

Rename a selected goal.

Edit

Modify a selected goal.

Copy

Copy a selected goal.

Last Name

The evaluator’s last name.

First Name

The evaluator’s first name.

ID

The evaluator’s ID.

Windows Username

The evaluator’s Windows user name.

Goals Assigned

The goals assigned to the evaluator. Assigned goals can be active and editable. Only active goals are actually used.

Managing Evaluation Goals
To add an evaluation goal:
1. Click Add.
2. Enter the name for the goal and then click OK.
3. Complete the fields in the Add/Edit Goal Information dialog box. The fields are described in
the table below.
4. Click Add to save the evaluation goal.
To rename an evaluation goal:
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1. Select a goal under Goals and click Rename.
2. Enter a new name for the goal, and then click OK.
To modify an evaluation goal:
1. Select a goal under Goals and click Edit.
2. Complete the fields in the Add/Edit Goal Information dialog box. The fields are described in
the table below.
3. Click Update to save the evaluation goal.
To copy an evaluation goal:
1. Select a goal under Goals and click Copy.
2. Enter the new name for the copied evaluation goal, and then click OK.

Field

Description

Add/Edit Goal Information
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Field

Goal

Description

Enter the number of evaluations to perform in the first field and
choose an option from each of the following lists:
n

Choose one of the following evaluation types:
l

l

l

n

l

Email evaluations—When selected, the goal applies
to email evaluations.

Agent—When selected, indicates that the number
of evaluations to perform is per agent.
Team—When selected, indicates that the number of
evaluations to perform is per team.

Choose how frequently these evaluations have to be
performed. Your options are as follows:
l

Day—00:00.00.00 to 23:59:59.5999

l

Week—Monday 00:00 to Sunday 23:59

l

l

l
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Text evaluations—When selected, the goal applies
to text evaluations.

Choose one of the following options:
l

n

Call evaluations—When selected, the goal applies
to call evaluations.

Month—first day of month (1) 00:00 to last day of
month (28, 29, 30, 31) 23:59:59
Specific Date—Select a day to perform evaluations
Date Range—Use the Effective and Contact ranges
to specify the dates to perform evaluations
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Field

Classifiers

Description

Evaluation goal classifiers are a hierarchical ordering of items
that determine what type of contacts to assign for this goal.
Classifiers can be added, sorted, edited, and removed.
When you add a new classifier, the classifier is based on the
evaluation type assigned to the goal. The possible evaluation
types are: call evaluations, email evaluations, and text
evaluations. Each type of evaluation will have different types of
classifiers that can be assigned to the evaluation goal.
Example: If you choose the Quality Reason classifier
option for a call evaluation type, the available Quality
Reason options are based on the quality reason code
setup in the quality workflow panel.
If you specify multiple classifiers, classifiers are processed in the
order they are listed (from top to bottom). Use the up and down
arrow keys to the right of the classifiers to sort the classifiers.
The following algorithm is used to assign evaluations to
evaluators who are configured as Auto Assign Evaluators. If no
goals are assigned to them, then a random contact within their
scope will be assigned. If goals are assigned to them, an unfilled
goal will be chosen in round-robin fashion from their list of
incomplete goals. A list of potential teams/agents that have not
satisfied the goal will be created. An agent/team will be selected
randomly from this list. The classifier at the top of the list will be
used first to find a contact to assign to an evaluation goal. If no
contact matches the first classifier, the next classifier will be
used to find a contact, and so on. If no contact matches any of
the classifiers in the list, then another team/agent from the list
will be chosen at random, and the classifiers will be evaluated in
order for that contact. If no contact can be found to evaluate for
the list of agent/teams for that goal, no contact will be assigned
for that evaluation goal. If an evaluator has more than one goal
assigned, then the next goal will be processed. If no contacts
meet the defined classifiers for any goals, no contacts will be
assigned to the evaluator at that time.
Best Practices: Specify Any Call, Any Email, or Any Text
as the final classifier. These classifiers choose a random
contact that is in the evaluator's scope that meets the

191

Recordings

Field

Description

definition of the goal. This ensures the highest chance to
find a contact to assign to that evaluator if the other
classifiers cannot be met.
Add

Add a classifier

Remove

Delete a selected classifier.

Edit

Modify a selected classifier.

Evaluators

Lists the available evaluators.

Assigned Evaluators

Lists the assigned evaluators.

Effective Range

These fields define the dates the goals are active.
n

This goal is in effect as soon as it is active

n

This goal is only in effect during these specified dates

Start Date

Date the goal becomes active. The default start effective range
date is the first day of the next month.

Stop Date

Date the goal stops being active. The default stop effective
range date is the last day of the next month.

Contact Range

These fields define the contacts to which the goals are applied.
n

This goal selects contacts from any available date

n

This goal selects contacts from these specified dates

Start Date

Date the goal begins selecting contacts. The default start contact range date is the first day of the current month.

Stop Date

Date the goal stops selecting contacts. The default stop contact
range date is the last day of the current month.

Editable

The goal can be modified, renamed, and deleted. It is not yet
available for evaluators to use.

Active

The goal is available for evaluators. Only the assigned evaluators can be modified. An active goal cannot be deleted.

Inactive

The goal is no longer available for use by evaluators. It will be
deleted automatically as soon as all goals based on it are
removed from the database.
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Field

Description

Add/Edit Classifier Information
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Field

Options

Description

The options are based on evaluation type. The possible options
are as follows:
Call evaluations:
n

Quality Reason—select one of the following quality
workflow reasons:
l

First Call of Day

l

Longest Call of Day

l

Random Call

l

Performance

l

Marked for Quality

l

Last Call of Day

l

Shortest Call of Day

l

New Employee

l

100% Logging

n

Call Length less than—specify the maximum length of the
call in HH:MM:SS.

n

Call length greater than—specify the minimum length of
the call in HH:MM:SS.

n

Has metadata key—choose the metadata key associated
with the call.

n

Has metadata key with value—choose the metadata associated with the call and specify the value associated with
the metadata.

n

Any Call—automatically choose a random contact that is in
the evaluator’s scope that meets the definition of the goal.

Text evaluations:
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n

To—specify the address for the person who received the
text.

n

From—specify the address for the person who sent the
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Field

Description

text
n

Has metadata key—choose the metadata key associated
with the text.

n

Has metadata key with value—choose the metadata associated with the text and specify the value associated with
the metadata.

n

Any Text—automatically choose a random text that is in
the evaluator's scope that meets the definition of the goal.

Email evaluations:
n

To—specify the email address for the person who
received the email.

n

From—specify the email address for the person who sent
the email

n

Has metadata key—choose the metadata key associated
with the email.

n

Has metadata key with value—choose the metadata associated with the email and specify the value associated
with the metadata.

n

Any Text—automatically choose a random email that is in
the evaluator's scope that meets the definition of the goal.

Guidelines for Evaluation Forms
Consider the following when you create an evaluation form:
n

Identify the activity type you want to evaluate, and create an evaluation form for that
specific contact.
Example: Call recording, live monitor of voice or screen, counter work, chat, or
other social media
This allows Quality Management to accurately report non-call activities in the Dashboard
and Reporting applications.
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Clearly outline factors to rate performance.
Example: How does the agent perform when greeting a customer, handling an
application, empathizing with a caller, using tools during order entry, or closing a
call? You can rate an agent's performance for each action.

n

Align the evaluations with the contact center’s business goals and available training.
l

l

Do not create an evaluation form that covers every possible scenario.
Focus on a few critical areas, like how an agent resolves a customer issue or
implements new initiatives.
Example: If your call center’s focus is on capitalizing up-sell opportunities,
then make that the focus of your evaluation.

An evaluation that is aligned with the contact center’s business goals provides
quantitative measurements of agents while related training and incentive programs are
rolled out.
n

Do not go overboard when creating an evaluation.
l

Try to limit your evaluation to three or four measurements.

l

Identify the top three or four KPIs you want to evaluate for this quarter or year.

l

Limit the total number of questions to 20 to 30 in the evaluation form so you can
quickly complete the form.
You can always add additional sections in the form, or better yet, replace existing
questions when you resolve issues like greeting customers or handling an
application.

l

l

l

196

Identify the key categories. Allow no more than 10 categories.
Identify questions associated with each category. Allow no more than 10
questions per section. Yes/No questions are preferred.
Organize your form for ease of evaluation. Match the questions to the call flow to
enable evaluations on the fly.
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l

l

n

When using percentage-based scoring, apply weighting and scoring where
relevant.
Identify key points of “failure.” If the question fails, the entire evaluation fails.

Ensure the areas you are measuring have corresponding training materials or actions.
Establish a training or mentoring program to improve agent performance and address
inadequacies.

The goal is to improve the proficiency for the entire contact center and help agents struggling in
specific areas to gain a level of proficiency.

Guidelines for Evaluation Form Questions
Consider the following tips when writing evaluation form questions.
n

Avoid long or complex questions, and do not include questions within a question.
l

Limit the scope of a question to a single measurable event.
Example: Did the agent greet the customer with their first and last name?

l

l

n

Make the question clear to both the evaluator and the agent on how the agent
performed.
Simple questions allow managers and supervisors to investigate the root cause of
an agent’s low score.

Use questions that require a yes or no answer whenever possible.
l

l

Yes or no questions provide clear and concise answers.
Yes or no questions require less documentation and collaboration efforts to get
consistent evaluation measurements. These types of answers are less subjective.

Numerical ranges require documentation criteria for each number in the range. This
makes collaboration efforts between multiple evaluators difficult.
n

Organize your questions by placing them into distinct categories or sections.
l

l

Categorizing questions allows you to produce detailed reports about agent and
team performance in each category.
Match questions and sections to the flow of a typical call to make it easier for
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evaluators to score agent performance.
Example: You could create three sections named Greeting, Order Entry,
and Closing.

l

n

When using percentage-based scoring, indicate the relative importance of
questions and sections by assigning them different weights.

l

Use up to 50 sections in an evaluation form.

l

Use no more than 10 questions in a section.

Decide whether there are any key points of “failure.”
l

Mark questions that address critical behavior (such as courtesy) as KPIs. If such a
question is scored negatively, the entire evaluation fails.

Maximizing Quality Management Value through Effective Evaluations
The evaluation is the net result you get out of a quality management recording solution. It starts with
the recording but it is really the evaluation where you can separate the excellent agent behavior and
identify the areas where agents need improvement.
n

Prioritize your initiatives—start with the highest value/highest priority.

n

Establish a level of success—this is the desired behavior.

n

Create a log of measurements and compare scores over time—pick an evaluation form
and stay with it for at least a quarter so you can measure improvement over time and
verify if your training and coaching is improving performance over this time period.

n

Review agent evaluations and play back calls to determine root cause—find out where
you are having problems and improve training through root cause analysis.

n

Make agent, team, and organizational comparisons—measure progress at all levels.

n

Move on when you have established success—when you no longer have problems in one
section of the evaluation, for example agent greetings, you can remove it from the
evaluation. As your contact center’s business goals change you can add new sections to
the form to continually improve the performance of your agents.

Evaluation Forms
Note: Evaluation forms are only available if you have quality management licenses.
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The Evaluation Forms node allows you to:
n

Create and maintain evaluation forms

n

Configure who can evaluate contacts that use a specific form

n

Configure who can approve evaluations that use a specific form

New forms are created based on one of the read-only templates that come with Quality Management
Administrator.
When you create a new evaluation form, you specify one of the following evaluation types:

PERCENTAGE -BASED

SCORING

(PERCENTAGE )

The evaluation is scored based on a percentage. Sections and Questions are weighted (0100%) and the final score is a percentage.

Example: If an agent scores 4 out of 5 questions correctly and the questions are evenly
weighted, the agent's final score is 80%.

POINT-BASED

SCORING

(POINTS)

The evaluation is scored based on a point system. Point-based scoring is often used in
incentive-based performance. Agents accumulate points and when they have enough points
they can cash the points in for tangible rewards (much like credit card points). In this
environment, 0 is the normal score and points are awarded for going above and beyond the
normal expected outcome. Points can also be subtracted for poor service. The evaluation form
allows you to assign positive or negative scores to questions.

Example: If an agent positively demonstrates understanding during a call, the value is 10
points. If the agent fails to demonstrate understanding during a call, the value is -5 points.

Evaluation Form Templates
The Evaluation Form Templates window lists the templates that you can use to create an evaluation
form in the Evaluation Form Administration window.
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The following table describes the default templates.
Template Name

Blank Points Template

Description

Allows you to choose the question types as either scored on a
scale of 0 to 5, answered with Yes or No, or customized.
Use this template for point-based scoring.

Blank Template

Configured for mixed question types that are scored on a scale
of 0 to 5 or answered with Yes or No. The template has no
preexisting sections or questions.
Use this template for percentage-based scoring.
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Template Name

Template 0–5

Description

Configured for questions that are scored on a scale of 0 to 5.
The template comes with preexisting sections and questions.
Use this template for percentage-based scoring.

Template Mixed
Questions

Configured for mixed question types that are scored on a scale
of 0 to 5 or answered with Yes or No. The template comes with
preexisting sections and questions.
Use this template for percentage-based scoring.

Template Yes-No

Configured for questions that are answered with Yes or No. The
template comes with preexisting sections and questions.
Use this template for percentage-based scoring.

Evaluation Form Administration
The Evaluation Form Administration window lists available evaluation forms. From this window you can
create, rename, delete, and copy evaluation forms. An evaluation can be based on an existing template
or a blank form.
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Creating an Evaluation Form
To create a new evaluation form:
1. In the navigation tree, select Recordings > Quality Management > Evaluation Forms >
Forms.
The Evaluation Form Administration window appears.
2. Click New.
The Evaluation Form Configuration dialog box appears.
3. Select the type of score calculation that you want to use. Your options are:
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n

Percentage—Select this option if you want to use percentage-based scoring.

n

Points—Select this option if you want to use point-based scoring.

4. Choose an evaluation form template from the drop-down list. Your options are:
n

Percentage: Template 0-5, Template Yes-No, Blank Template, or Template Mixed
Questions

n

Points: Template Points Form

5. Type a unique name for the evaluation form and then click OK.
Quality Management adds the new evaluation form to the list of forms at the top of the
Evaluation Form Administration window.
You can now configure the newly-created evaluation form by completing the information on each tab
on the lower part of the window.

Details Tab
The Details tab displays a form’s properties. It appears at the bottom of the Evaluation Form Templates
window and the Evaluation Form Administration window.

Field

Description

Description

A descriptive name of the form or template. The default
description is the name of the template used to create the form.

Original Author

The name of the person who originally created the form or
template. The default is Administrator.

Last Author

The name of the person who last modified the form or template.
The default is Administrator.

Needs Improvement
Percentage

The evaluation score range that indicates the agent’s
performance needs improvement. The lowest value is 0. If you
change the highest value, all other score ranges change
accordingly.
Example: A value from 0 to 74% is a below average
score that indicates the agent needs additional coaching.
This field only appears if the evaluation form uses percentagebased scoring.
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Field

Meets Expected
Percentage

Description

The evaluation score range that indicates the agent’s
performance meets expectations. If you change the highest and
lowest value, all other score ranges change accordingly.
Example: A value from 75 to 89% can be considered an
adequate or average score.
This field only appears if the evaluation form uses percentagebased scoring.

Exceeds Expected
Percentage

The evaluation score range that indicates the agent’s
performance exceeds expectations.
Example: A value from 90 to 100% is an above average
score that indicates an agent performed beyond the
normal expected outcome.
This field is not editable. The value in this field it depends on the
values set in the lower two score range fields. The maximum
value is 100.
This field only appears if the evaluation form uses percentagebased scoring.
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Field

Needs Improvement
Points

Description

The evaluation points range that indicates the agent’s
performance needs improvement.
Example: Negative values are subtracted for poor
service. In this instance, a value from -1 to -50 is a below
average score that indicates the agent needs additional
coaching.
The minimum integer value can be less than 0. Note that the
minimum value for this range is determined by the total of all
minimum values that you assign to questions. If you change the
highest value, the lowest value for Meets Expected Points
changes accordingly.
Note: You cannot change the value in this field until you
create questions and assign maximum and minimum
values to those questions.
This field only appears if the evaluation form uses point-based
scoring.

Meets Expected Points

The evaluation points range that indicates the agent’s
performance meets expectations.
Example: A value from 0 to 2 can be considered an
adequate or average score.
If you change the value, all other score ranges change
accordingly.
Note: You cannot change the value in this field until you
create questions and assign maximum and minimum
values to those questions.
This field only appears if the evaluation form uses point-based
scoring.
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Field

Description

Exceeds Expected Points The evaluation score range that indicates the agent’s
performance exceeds expectations.
Example: Positive values are awarded for exceptional
service. In this instance, a value from 3 to 50 is an above
average score that indicates an agent performed beyond
the normal expected outcome.
This field is not editable. Note that the maximum value for this
range is determined by the total of all maximum values that you
assign to questions.
Note: The maximum value in this field does not change
until you create questions and assign maximum and
minimum values to those questions.
This field only appears if the evaluation form uses point-based
scoring.
Status

The default status is Editable. Do not change the status of an
evaluation form to Active until you finished modifying the
evaluation form. You can only change the status for an
evaluation form listed in the Evaluation Form Administration
window. You cannot change the status for an evaluation form
template in the Evaluation Form Templates window. See Form
Status for more information about statuses.

To configure an evaluation form's details:
1. Select the form in the list of forms at the top of the Evaluation Form Administration window.
2. Select the Details tab, and complete the fields.
The form’s properties appear in the tabbed section at the bottom of the window.
3. Click Save.

Form Status
A form’s status determines if it is available for use and if it can be modified. The following table
describes the possible states.
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Status

Description

Editable

The form can be modified, renamed, and deleted. It is not yet
available for evaluators to use.

Active

The form is available for use by evaluators, supervisors, or
managers. Everything that does not affect the score in the
evaluation can be modified, including:
n

Details tab (including ranges)

n

Settings tab

n

Sections tab (including names and chart results, but not
weights or number of sections)

n

Question tab (including text, description, and answer
label, but not number of questions, KPI, or weights)

An active form cannot be deleted.
Inactive

The form is no longer available for use by evaluators,
supervisors, or managers. It will be deleted automatically as
soon as all evaluations based on it are removed from the
database.

The following figure displays normal life cycle of an evaluation form.

Once you have changed a status to the next in line, you cannot go back to the previous status. Also,
you cannot skip a status.
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Example: You cannot go from Editable to Inactive.

To change a form's status:
1. In the navigation tree, select Recordings > Evaluation Forms > Forms.
The Evaluation Form Administration page appears.
2. Select the form whose status you want to change from the list of forms at the top of the
page.
3. On the Details tab, in the Status section, select the desired status (in accordance with the
normal form lifecycle), and then click Save.

Settings Tab
The Settings tab displays the configuration settings for evaluation, approval, and alerts. It appears at
the bottom of the Evaluation Form Templates window and the Evaluation Form Administration window.

Field

Evaluation and Approval

Description

Choose one of the following evaluation and approval options:
n

Comments are Editable—when selected, allows users to
edit any existing comment created by a person within the
user’s scope.
Example: An agent can only edit their own
comments. A supervisor can edit the comments
made by agents within the supervisor's scope and
the supervisor’s own comments.

n
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Field

Needs Approval

Approves

Description

Choose one of the following approval options for this evaluation
form:
n

No Evaluations—when selected, no evaluations require
approval.

n

Self Evaluations—when selected, all self evaluations
require approval.

n

All Evaluations—when selected, all evaluations require
approval.

Choose one or more of the following roles that can approve this
evaluation form:
n

Evaluator

n

Manager

n

Supervisor
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Field

Alert

Description

Choose one or both of the following alert options for this
evaluation form.
n

When Evaluation is Scored—when selected, an alert is
sent when an evaluation is scored. Choose one or more
of the following roles to notify when the evaluation is
scored:
l

l

l

Agent's Manager(s)—Quality Management sends
an alert to the agent’s manager(s) when an evaluation is scored.
Agent's Supervisor(s)—Quality Management sends
an alert to the agent’s supervisor(s) when an evaluation is scored.
Agent/Knowledge Worker—Quality Management
sends an alert to the agent or knowledge worker
when their evaluation form is scored.

Example: If you only want Quality Management to
send an alert to Agent’s Supervisor(s), clear the
Agent's Manager(s) and Agent/Knowledge
Worker check boxes.

n

When Evaluation Needs Approval—when selected, and
alert is sent when an evaluation needs approval. Choose
one or more of the following roles to notify when the
evaluation needs approval:
l

l

l
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Agent's Manager(s)Quality Management sends an
alert to an agent’s manager(s) when an evaluation
needs approval.
Agent's Supervisor(s)—Quality Management sends
an alert to an agent’s supervisor(s) when an
evaluation needs approval.
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Field

Description

Example: If you only want Quality Management to
send an alert to the Agent's Supervisor(s), clear
the Evaluator(s) and Agent's Manager(s) check
boxes.

To configure an evaluation form's settings:
1. Select the form in the list of forms at the top of the Evaluation Form Administration window.
2. Select the Settings tab, and complete the fields as desired.
The form’s settings appear in the tabbed section at the bottom of the window.
3. Click Save.

Sections Tab
The section tab allows you to specify the number of sections that appear in the evaluation form. There
can be a maximum of 50 sections in a form. Sections are automatically numbered from 1 to 50.
You can use these default sections as they are in the evaluation form, or customize them to suit your
needs by renaming them or deleting them.
You can also specify which sections appear in the chart results for point-based scoring.
If you are using percentage-based scoring, remember the following points when assigning weight to a
section:
n

You can assign a weight to each section that can affect how an evaluation is scored. The
score weight percentages assigned to the sections must add up to 100 percent.

n

You can assign zero (0) to a section weight if there is more than one section in the Evaluation form. All questions within the 0-weight section must add up to 100 percent. The
questions scored in a 0-weight section are not included in the overall score. You might
want to create a 0-weight section when you want to track questions that should not
affect the overall score.
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Field

Weigh Sections Evenly

Description

When you click this button, the values in the Score Weight
Percentage columns are assigned the same weight.
This button only appears if the evaluation form is associated with
percentage-based scoring. The button is disabled when the
form is Active.

Number

The number assigned to the section.

Name

The name of the section.

Chart Results

Choose the starting gradient color that will be associated with
this section in a chart for a point-based evaluation form. The
ending gradient color is predefined based on the starting
gradient color. If you choose None, the section will not appear in
the chart.
Note: This field can be changed on an active evaluation
form.

Score Weight Percentage Adjust the weight of each section. The weights of all the sections
must add up to 100%. The weight for each section will show a
percentage value that includes up to 2 decimal places.
This field only applies to percentage-based scoring.
New

Adds a new section. Quality Management supports up to 50 sections.

Rename

Changes the name of a selected section.

Delete

Deletes a selected section.

To manage sections:
1. Choose one of the following options:
n

To add a new section, click New under the Sections tab, type a name for the new
section, and then click OK.
The Question tab appears the first time you add a new section.
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n

To rename a section, select the section, click Rename, type the new name in the Section Name dialog box, and then click OK.

n

To delete a section, select the section and click Delete, click Yes to dismiss the
Delete Section dialog box.

2. If this form uses percentage-based scoring, change the score weights for each section until
they add up to 100% or click the Weigh Sections Evenly button.
3. Click Save.

Understanding How Sections are Weighted
Note: This topic only applies to percentage-based scoring.

Example: Assume the completed form has two sections called Greet and Assess. The Quality
Management administrator who set up the evaluation form determined that the score of the
Greet section would contribute 40% towards the overall score and the score of the Assess
section would contribute 60%. A section weight is indicated on each section tab. The sum of all
of the section weights must be 100.
These weights are applied after all sections are scored to arrive at the overall score (as a percentage)
for the evaluation.
The overall score is calculated as follows:
n

Section score (as a percentage) × section weight = weighted section score

n

Sum of all weighted section scores = total score (as a percentage)

In this example:
n

Greet section = 60% x 0.4 = 24%

n

Assess section = 80% x 0.6 =48%

n

24% + 48% =72% overall score

Questions Tab
The Questions tab allows you to configure the questions and answers associated with a section. When
configuring questions and answers, note that you can:
n

Enter up to 100 questions per form with a limit of ten sections per form.

n

Use a combination of answer of Yes/No or 0-5 scale, or custom answers on a question-
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by-question basis. A minimum of two answers per question is required.
Example: Your evaluation can include not only Yes/No questions about an
agent’s mandatory skills but also 0-5 scale questions about the agent’s soft skills.
If you use the Template 0–5, Template Mixed Questions, or the Template Yes-No to create your new
form, you already have questions set up. You can use these default questions as they are in the
evaluation form, or customize them to suit your needs by adding, editing, or deleting questions.
If you used the Blank Template or Template Points Form, you must create your own questions.
The Questions tab appears at the bottom of the Evaluation Form Templates window and the Evaluation
Form Administration window when you add a section.
The Questions tab displays up to 50 subordinate tabs. The names of these tabs are defined in the
Sections tab. See Sections Tab for more information.

Field

Description

Section

List of sections on the form.

Number

The number assigned to the question.

Question

A question in the evaluation form. You can enter a combined
maximum of 500 characters in the Question and Description
fields. This field allows HTML formatting.

Description

A comment associated with the question in the evaluation form.
The text in this field should explain the scoring criteria so that
evaluations are scored consistently. When a user moves the
cursor over the question in the evaluation form in Unified
Workforce Optimization, a popup dialog displays the text in this
field to the user.

KPI

Indicates whether or not the question has been marked as a Key
Performance Indicators (KPI) question. The valid values in the
KPI field are:

Type
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Yes

n

No

Click the Options button to define the answers to the questions.
See Configure Question Options for more information.
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Field

Min

Description

The minimum score for this question determined when the
question options were configured. Positive or negative numbers
can appear in this field.
This field only appears if the evaluation form is associated with
point-based scoring.

Max

The maximum score for this question determined when the question options were configured. Positive or negative values can
appear in this field.

This field only appears if the evaluation form is associated with
point-based scoring.
Score Weight

Adjust the weight of each question. The weights of all the
questions in a section must add up to 100%. The weight for each
question will show a percentage value that includes up to 2
decimal places.
Example: 12.55%
See Understanding How Sections are Weighted for more
information.
This field only appears if the evaluation form is associated with
percentage-based scoring.

New

Enter the name of a new section.

Rename

Enter a new name for a selected section.

Delete

Delete a selected section.

Weigh Questions Evenly

When you click this button, the values in the Score Weight
columns are assigned the same weight.
This button only appears if the evaluation form is associated with
percentage-based scoring. The button is disabled when the
form is Active.

To manage questions:
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1. Choose one of the following options:
n

To add a question, select a section tab under the Questions tab, click New, type the
question in the New Question dialog box, and click OK.

n

To add a description to a question, double-click the Description field, and type an
explanation of the question.

n

To define the possible answers to the question, double-click the Type field, complete
the fields in the Configure Question Options dialog box, and then click Done.
The KPI Order tab appears the first time you define an answer type as KPI.

n

To delete a question, select the question you want to delete, click Delete, and then
click Yes to dismiss the Delete Question dialog box.
Quality Management Administrator removes the question from the list.

2. If this form uses percentage-based scoring, change the score weights for each question
until they add up to 100% or click the Weigh Questions Evenly button.
3. Click Save.

Understanding How Questions are Weighted
NOTE: This information applies only to percentage-based scoring.
The maximum score for a section is 100%, no matter how many questions it contains.

Example: In a section with 3 questions, question 1 has a weight of 50%. Questions 2 and 3
each have a weight of 25%. This means question 1 is worth a maximum of 50 points and
questions 2 and 3 are each worth a maximum of 25 points.
If a 0-5 question has a weight of 50%, then points are given for each possible score as follows:
n

20 = 10 points

n

40 = 20 points

n

60 = 30 points

n

80 = 40 points

n

100 = 50 points

If a 0-5 question has a weight of 25%, then points are given for each possible score as follows:
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n

20 = 5 points

n

40 = 10 points

n

60 = 15 points

n

80 = 20 points

n

100 = 25 points

If a Yes/No question has a weight of 50%, then points are given for each possible score as follows:
n

No = 0 points

n

Yes = 50 points

If a Yes/No question has a weight of 25%, then points are given for each possible score as follows:
n

No = 0 points

n

Yes = 25 points

The following tables show the results for several sections in a sample evaluation form.
Scored example for a 3 question section
Question

Weight

Type

Score

Weighted Score

1

50

0-5

80

40

2

25

0-5

60

15

3

25

Yes/No

Yes

25

Section Score

80%

Scored example for a 4 question section
Question

Weight

Type

Score

Weighted Score

1

60

0-5

60

36

2

15

0-5

80

12

3

20

Yes/No

No

0

4

5

Yes/No

Yes

5

Section Score

53%
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Scored example with N/A as an answer to one of the questions
Question

Weight

Type

Score

Weighted Score

1

60

0-5

N/A

-

2

15

0-5

80

12

3

20

Yes/No

No

0

4

5

Yes/No

Yes

5

Section Score

42.5%

Note: An answer of N/A removes that question from the total possible. So for this example,
Quality Management bases the score of 43% on a score of 17 out of a total of 40.
The formula used for weighting questions considers the underlying scoring system used today. The
following example shows this scoring system.
Yes/No Question

No

Yes

N/A

Score

0

100

-

Possible

100

100

-

2

3

0-5 Question

0

1

4

5

N/A

Answer

0

20

40

60

80

100

N/A

Possible

100

100

100

100

100

100

-

In the current scoring system, the maximum score per question for a Yes/No question is 100 points.
For a 0-5 question the maximum score per question is 100. N/A is ignored.
So the formula used to calculate the weighted score for a single question is:
(Actual score/ Maximum score) * Weight = Weighted score
Here are some example calculations for weighted question scores:
Question type

Maximum score

Actual score

Weight

0-5

100

60

40%

(60/100) * 0.40

24%

0-5

100

40

17%

(40/100) * 0.17

6.8%

Yes/No

100

No

30%

(0/100) * 0.30

0%

Yes/No

100

Yes

45%

(100/100) * 0.45

45%

218

Formula

Weighted score

Recordings

Configure Question Options
The Configure Question Options dialog box allows you to configure the list of possible answers for a
question by:

1. Choosing one of the question option templates. These templates define the type of
answers that will be used for a specific question. You can choose from the following
options:
n

Yes-No—answers to questions are either yes, no, or not applicable (N/A).

n

0-5—answers to questions are based on a scale from 0-5 or N/A.

n

Custom—allows you to create your own answers.

2. Adding or deleting questions.
3. Arranging the order in which answers appear by selecting an answer and using the up or
down arrows to move the answer to the correct location. In Quality Management Workforce
Optimization, the drop-down list for the question will display the answers in the order shown
in the Configure Questions Options dialog box.

Template Name

Question Option
Template

Description

The template associated with this question. Your options are:
n

Yes/No—the answer is in the form of yes, no, or N/A.

n

0 - 5—the answer is scored on a scale of 0 - 5 or N/A.

n

Custom—you determine the answer and how it is scored.

See Configure Question Examples for examples.
Label

The text for the answer.
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Template Name

Type

Value

Description

The type of answer. The options are:
n

Accumulative—points for this option are added together to
get the final score, assuming no Key Performance Indicator (KPI) options are selected. In Unified Workforce
Optimization the accumulative total will appear in Section
Scores. KPI and Not Applicable are excluded from this
score in Sections Scores so you can see what the score
would have been had a KPI answer not been selected.

n

Not Applicable—ignore this answer by not including it in
any totals. For point-based scoring, this is similar to
assigning a 0 point value. However, the Section Scores
ignores this question. For percentage-based scoring, the
question is removed from the total possible points.

n

KPI—changes the final score to be the value specified by
this option. This type of answer is used for questions that
have a negative or positive impact on the score. The KPI
Order tab appears the first time you define a answer type
as KPI. See KPI Order for more information.

The integer value associated with this answer. Essentially, this
is how much the answer is worth.
Percentage-based scoring—This is a whole number value. The
valid range of whole numbers are from 0 to 100.
Example: 20
Point-based scoring—This is an integer value that consists of
natural numbers (1, 2, 3...), zero (0), or the negatives of natural
numbers (-1, -2, -3, ...).
Example: -10
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Template Name

Default

Description

When selected, this check box indicates this is the default
answer for the question on the evaluation form.
Example: If an evaluator skips a question on the
evaluation form and clicks Complete to submit the
completed evaluation, the default answer for the skipped
question appears in the completed evaluation form.
A default answer is required.

Configure Question Examples
The following examples show how to configure answers for each question option template.
In the following examples, any values that are greater than 100 or less than 0 apply only to point-based
scoring. Note that when creating an evaluation form for percentage-based scoring, the range of values
are limited to 0 to 100.

Example 1: If you want your answers to use a scale from 0-5 or Not Applicable (N/A), select 0-5
from the Question Option Template drop-down list.
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Example 2: If you want answers to use Yes, No, or N/A, select Yes/No from the Question Option
Template drop-down list. You can also assign a Key Performance Indicator (KPI) to one of the
answers if the answer has a negative impact to your contact center's business goals.

222

Recordings

Example 3: You can create a Custom template with +, 0, and - labels.
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Example 4: You can use the Custom template to add Yes or No answers and then assign a KPI
to the Yes answer and a value greater than 100 if you want to reward an agent for a positive KPI
result.
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Example 5: You can use the Custom template to add Yes or No answers and assign a KPI to
one of the answers.
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Example 6: You can use the Custom template to add descriptive words in the Label column.
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Example 7: You can use the Custom template to add descriptive words in the Label column
and assign KPI to multiple answers.
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KPI Order
A KPI answer has an absolute impact on the final score. If multiple KPI answers are defined, the
KPI answers will be prioritized to determine which KPI answer will be used to determine the final score.
The KPI Order tab ranks KPI questions in order of priority.

Field

Description

Section

The name of the section where the KPI was found.

Question

The question in the evaluation form that has a KPI answer.

Option

The answer to the question that is associated with the KPI.

Order

The order in which KPI answers are prioritized in the evaluation
form. 1 is the highest priority.

To change the priority order of a KPI question, select the
KPI item from the list and use the up or down arrows to move
the KPI item to the correct location.

228

Recordings

Survey Form Administration
QM One Voice allows you to integrate Quality Management with your existing Post Call Survey account
or a new Post Call Survey account. This will allow you to identify trends in calls that are causing your
customers' perceptions of the company to change.
The Survey Form Administration node allows you to configure the your surveys and email distribution
using an existing survey provider. Use the Survey Form Administration node to connect to the survey
providers and collect data from the surveys.
The survey application is independent from Recording and Quality Management. Survey data can be
collected from Interactive Voice Response (IVR) or can be collected from online survey data retrieved
from email distribution. For more information, see "Post-Call Survey API" in the Developer, API, and
Database Schema Guide.
When the File Observer service finds contacts that require a survey to be distributed, it will trigger an
API request to the survey provider to distribute the survey assigned on the Survey Form Administration
page. The date on the request is the day before the request is actually crated so the survey will be sent
as soon as possible. The File Observer service will then trigger a request for results.

Note: Some survey providers will send the surveys immediately (for example, Qualtrics), others
have built in delay for processing withing their environment (for example, Survey Monkey). The
last processed Metadata time is stored in the Survey Properties so that the process knows to
only send surveys that have not been distributed.
The Recent Surveys widget in Unified Workforce Optimization supports all survey types and shows the
data for the active survey. The Survey Score shown for IVR is the final score of the survey. The Survey
Score shown for other survey types is the KPI question's answer as final score computation does not
apply to these survey types.
Data retention for surveys is the same as the metadata retention time. See Recording Retention for
more information.

General Guidelines
When creating an account with a survey provider, the following account features are recommended:
n

Unlimited responses per survey

n

6 responses or more per second

Qualtrics Requirements
Before you configure the Survey Form Administration node, you will need the following information to
connect to the Qualtrics account:
n

The full username used to log in to the Qualtrics online portal

n

A custom toke for the Qualtrics API
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The IDs of the libraries used for the surveys

n

The ID of the message to be sent when requesting a survey

Survey Monkey Requirements
Before you configure the Survey Form Administration node, you will need the following information to
connect to the Survey Monkey account:
n

A configured Survey Monkey account

n

A developer account with Survey Monkey

n

The login name, account user, or client ID from the developer account

n

The developer API key

n

The developer API shared secret code

n

A generated token

n

A verified email account (if using the Basic plan)

Managing Survey Forms
Field

Survey Provider

Description

Select the survey provider from the drop-down list. Your options
are as follows:
n

None—There is no survey provider.

n

Generic IVR

n

Qualtrics

n

Survey Monkey

Survey Connection
Username

Enter the user's email address or username used when logging
in to the online portal for Qualtrics or Survey Monkey. This field
only appears when Qualtrics or Survey Monkey is the survey provider.

Token

Enter the custom token for the Qualtrics or Survey Monkey API.
This field only appears when Qualtrics or Survey Monkey is the
survey provider.
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Field

Description

Library ID

Enter the library IDs by the Qualtrics account. This field only
appears when Qualtrics is the survey provider.

Message ID

Enter the message ID to be sent when requesting a survey. This
field only appears when Qualtrics is the survey provider.

Refresh Survey List

When clicked, the Refresh Survey List button triggers the collection of Survey information from the third party provider. After
selecting the survey to use from the retrieved request, KPI
options are defined, Metadata field selection is made, and the
distribution information is added. This field only appears when
Qualtrics or Survey Monkey is the survey provider.

API Key

Enter the API key associated with this survey. This field only
appears when Survey Monkey is the survey provider.

Shared Secret

Enter the shared secret associated with this survey. This field
only appears when Survey Monkey is the survey provider.

Survey Configuration
Survey

Select a survey from the drop-down list.

Voice of Customer Question

Select a question from the drop-down list.

Generate Eval Threshold

Enter the evaluation threshold by selecting one of the following
options and a numeric value:
n

Greater Than

n

Greater Than Equals

n

Less Than

n

Less Than Equals

n

Equals
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Field

Call Identifier

Description

Select the call identifier that you want to use to link to a survey
for a given contact Your options are as follows:
n

Associated Call ID—the survey connects to all contacts
with this call identifier.

n

Contact ID—the survey connects to a single contact with
this call identifier.

n

ICM Call ID—e survey connects to a specific contact with
this call identifier.

These call identifiers are located in the results column of the first
question in the results file. This field only appears for a Generic
IVR provider.
Schedule

Select one of the following schedule options:
n

Every Hour

n

Every 12 Hours

n

Every Day at Midnight

n

Custom—enter the interval in the field. The free form text
value must be in Con format. See http://www.nncron.ru/help/EN/working/cron-format.htm for more
information on the Cron format.

This field only appears for a Qualtrics or Survey Monkey
provider.
MetaData Field for Distribution

Select the metadata field that identifies which contacts require
survey distribution from the drop-down list. This field only
appears for a Qualtrics or Survey Monkey provider.

Send From Email

Enter the email address used to send the survey. This field only
appears for a Qualtrics or Survey Monkey provider.

Reply to Email

Enter the email address used by the customer to return the survey. This field only appears for a Qualtrics or Survey Monkey provider.

Sender Name

Enter the name of the company or person that sent the survey.
This field only appears for a Qualtrics or Survey Monkey provider.
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Field

Email Subject

Description

Enter the subject for the Email. This field only appears for a Qualtrics or Survey Monkey provider.

Generic IVR fields
ID

The survey's ID.

Name

The name of the survey,

Status

The current status of survey. The options are as follows:
n

Editable. The form can be modified, renamed, and
deleted. It is not yet available for evaluators to use.

n

Active. The form is available for use by evaluators, supervisors, or managers. Once the form is active it cannot be
modified.

Created

The date when the survey was created.

Total Points

The total number of points for this survey.

#

The number assigned to the question.

Question

A question in the evaluation form.
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Field

Type

Description

The type of survey question. The options are as follows:
n

AUDIO. The user answers the question verbally.
Note: The audio file must be accessible from the
browser using a unique HTTP or HTTPS URL on
a web accessible file server. Go to the following
websites for more information:
http://stackoverflow.com/questions/12021781/theright-way-of-setting-a-href-when-its-a-local-file

n

DIGITS. The user enters numbers to answer the
question.
Note: When using Survey Monkey, use only
question types with numerical answers. Using any
other question type will not allow average scores to
be calculated.

Weight

n

OPTION. The user selects one of the provided options to
answer the question.

n

GREETING. A brief audio introduction for an IVR survey.

The weight assigned to the question.

Archive Workflows
This topic describes the Archive Workflow Administration window and provides tasks to create and
maintain archive workflows.

To allow agents and knowledge workers access to their archived recordings:
1. In the navigation tree, select the Recordings > Interface Configuration > Role Permissions.
The Archive Recordings Administration window appears.
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2. To allow agents or knowledge workers access to their own archived recordings, select the
Allow Agents To Access Archive check box.
3. Click Save.
The Recordings application appears in the Unified Workforce Optimization when agents and
knowledge workers log on.

Archive Workflow Administration
Use the Workflow Administration window to create archive workflows based on team. The archive
workflow includes specific rules and classifiers to designate the types of contacts you want to record.
These calls will be recorded for archive purposes, unless later tagged as quality management calls.
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Field

Archive Workflows

Description

Lists the existing archive workflows. To modify the workflows
that appear in this list, choose one of the following options:
n

New—add a new workflow to the list.

n

Rename—change the name of an existing workflow.

n

Delete—remove a workflow from the list.

Rename and Delete are enabled when you select an archive
workflow from the list.
Name

The name of the archive workflow.

State

The status of the workflow. The Possible states are as follows:

End of Day

n

Active—The entire workflow can be modified.

n

Inactive—The modifiable parts of the workflow are limited
to the fields under Archive Uploads and Recording
Retentions.

The workflow is uploaded at the end of the selected day.
Recording still continues, but those recordings are uploaded
after the next End of Day. Enter the time for the end of the work
day in 24-hour format.
If the EOD is changed, the new EOD goes into effect
immediately and the Data API service will process calls using
the new EOD time. If the EOD changes after the Upload
Controller gets the original EOD, the Upload controller might
wait to upload recordings until after the original EOD time has
passed.
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Field

Description

Immediate Voice Upload

When this check box is selected, audio recordings associated
with this workflow are immediately uploaded after the recording
completes. When the check box is clear, the normal upload
setting rules are in effect. This option applies to all recording
types.
If you change the Immediate Voice Upload option during the
day, the change does not go into effect until the archive
workflow is reloaded after the End of Day.
For Desktop Recording, it is possible that audio recordings
waiting for upload can be lost if an agent’s PC crashes. Enabling
immediate uploading prevents this problem.
If you enabled two stage upload, audio recordings are uploaded
immediately using the two stage upload process.

Recording Retentions

Set the length of time you want the various types of recordings
to be retained.

Available Teams

Available teams appear in this list.

Assigned Teams

Teams assigned to this archive workflow appear in this list. A
team can belong to only one archive workflow at a time.
Note: A team can belong to one archive workflow and
one quality management workflow.

To create a new archive workflow:
1. In the navigation tree, select Recordings > Archive > Workflows.
The Archive Workflow Administration window appears.
2. Next to the Archive Workflows section, click New.
The Archive Workflow Name dialog box appears.
3. Enter a name for the new archive workflow, and then click OK.
The workflow now appears in the Archive Workflows section.
4. Select the archive workflow in the Archive Workflows section.
5. In the Archive Upload section, enter the time for the end of the work day in 24-hour format.
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6. To upload audio recordings as soon as a call is completed, select the Immediate Voice
Upload check box in the Archive Upload section.
7. Set the length of time you want to retain recordings marked by agents.
l

Tagged—recordings that have been marked by an agent for retention.

l

Archive—all other recordings.

8. Assign teams to the archive workflow
A team can belong to only one archive workflow at a time. If a team you want to assign to
this archive workflow is already assigned to another archive workflow, it is automatically
reassigned to this archive workflow. A warning message is displayed telling you that the
team is being reassigned from another archive workflow.
9. When you are done configuring the archive workflow in this window, click Save.
Classifiers are filters that determine which calls are recorded.

To set up classifiers for an archive workflow:
1. Under the Archive > Workflows node, select the workflow you just created.
The Archive Workflow Classifier Configuration window appears.
2. In the Classifiers section, click New to create a new classifier.
The Classifier Name dialog box appears.
3. Enter a name for your new classifier, and then click OK.
The new classifier now appears in the classifier navigation tree.
4. In the Classifier Settings section, select one of the following options.
n

Record—select this option to upload recorded calls.
If you select Record, you must select the call direction you want to record (Inbound,
Outbound, or both). You must select at least one call direction.

n

Don’t Record—select this option to exclude specific phone numbers or area codes
from recording.

5. Select the type of number you want to use to filter the calls.
n
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the call was routed, or the agent extension if the call was direct call. If the call is
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outbound, the Called Number is the number of the customer/client.
n

Calling Number—if the call is inbound, the Calling Number is the original number from
which the caller is dialing. If the call is outbound, the Calling Number is the agent’s
extension.
Note: If you add phone numbers to the Called Number section, then select
Calling Number from the Numbers drop-down list, Quality Management
Administrator deletes the phone numbers you added. The reverse is also
true. If you add phone numbers to the Calling Number section, then select
Called Number from the Numbers drop-down list, Quality Management
Administrator deletes the phone numbers you added.

n

Line—The extension the agent used to answer the call.

6. Click Add to specify the phone numbers you want to filter
The Number dialog box appears.
7. Enter the numbers you want to filter. You can enter
n

Specific numbers
Example: 6125551212

n

Number ranges using wildcards
Example: 612*, where the * wildcard represents any number of digits, or
612555????, where the ? wildcard represents a single digit.

n

The * wildcard to record all calls

The numbers cannot contain dashes or parentheses, and must be between 1 and 16
characters long.
8. Click Save to save the classifier settings.
To manage archive workflows:
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n

To edit an existing archive workflow, select the workflow you want to modify under
Archive > Workflows, complete your changes, and then click Save.
Quality Management Administrator saves the changes to the modified workflow.
The modified workflow goes into effect after the agents assigned to the workflow log out
and log back in to their Windows session, or after the configured End of Day.

n

To delete an archive workflow, select the workflow you want to delete under Archive >
Workflows, click Delete, and then click Yes to dismiss the Confirm Deletion dialog box.
Quality Management Administrator deletes the archive workflow and the status of the
workflow changes to Inactive. The deleted workflow goes into effect after the agents
assigned to the workflow log out and log back in to their Windows session, or after the
configured End of Day.
Note: Once a workflow is deleted, you cannot adjust the retention times for calls
associated with the workflow or reactivate the workflow.

User-Defined Metadata
Metadata can be captured from Cisco Agent Desktop (CAD), and other applications to pass the data to
the Quality Management API.
The CAD HTTP Action can also be used to pass data to Quality Management. See the Cisco CAD
Desktop Administrator Guide for more information.
Use the User-Defined Metadata window to create and maintain metadata fields. You can define up to
30 metadata fields. Each metadata field can contain up to 25 characters.
These metadata fields appear in the Contact Information tab on the Media Player in Unified Workforce
Optimization in the same order they appear in the User-Defined Metadata window. You can configure
the order in which the metadata appears by selecting a row and using the Up and Down arrows to
move the selected metadata.
The following image displays the User-Defined Metadata window.
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Field

Display Name

Description

The metadata field name appears in the search results and the
contact information.
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Field

Key Name

Description

A unique identifier for the metadata field. APIs use the unique
identifier for the metadata field. It can be a maximum of 39
alphanumeric characters, and can include only one special
character, the underscore ( _ ).
Important: The key name must be unique. If you create a
key name for a metadata value that duplicates an existing
field name, you will not be able to add a search filter for
that key name under the Recordings application in
Unified Workforce Optimization. See Reserved Words
for a list of words that cannot be used as key names.

Type

Identifies the type of information contained in the metadata field.
The available types are:
n

Text

n

Number

n

Date

n

HyperLink

The maximum character length for metadata fields are as
follows:
n

Data=2056—that includes text, numbers and hyperlinks.
Note: Once the hyperlink is saved you can click the
hyperlink and the link will open in a separate web
browser.

n
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Field

Encrypted

Description

When selected, this check box indicates Quality Management
encrypts the metadata when stored. The Exportable check box
is disabled if you select the Encrypted check box.
Note: You cannot search for encrypted metadata in
Unified Workforce Optimization.

Exportable

When selected, this check box indicates you can export the
metadata via an API or Unified Workforce Optimization. This
check box is selected by default.

To manage metadata fields:
n

To add a metadata field, select the Recordings > Metadata node, click Add, complete
the fields, and then click OK to dismiss the Add/Edit Metadata Information dialog box.

n

To edit a metadata field, select the Metadata field you want to edit from the UserDefined Metadata window, click Edit, complete your changes, and then click OK to
dismiss the Add/Edit Metadata Information dialog box.
Your changes appear in the list of metadata fields on the User-Defined Metadata
window.

n

To delete a metadata field, select the Metadata field you want to remove from the UserDefined Metadata window, click Remove, and then click Yes to dismiss the Confirm
Deletion dialog box.
Quality Management Administrator deletes the metadata.

n

To sort the order in which the metadata appears, select a row, use the Up or Down arrow
to move the metadata row to where you want it to appear. Repeat this step until all
metadata rows appear in the desired order.

Reserved Words
Important: The key name must be unique. If you create a key name for a metadata value that
duplicates an existing field name, you will not be able to add a search filter for that key name
under the Recordings application in Unified Workforce Optimization.
The following words are reserved for Quality Management and cannot be used as a key name for a
metadata value.
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n

acd_login_status

n

agent_displayId

n

ani

n

approved_by

n

assocCallIdCount

n

call_duration

n

call_line

n

call_state

n

called_number

n

calling_number

n

contact_type

n

date

n

direction

n

dnis

n

evaluation_calibration

n

evaluation_date

n

evaluation_form_name

n

evaluation_score

n

evaluation_state

n

evaluator_name

n

first_name

n

from_address

n

group_name

n

hasScreen

n

hasVoice
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n

hr

n

id

n

isInbound

n

last_name

n

license

n

line

n

pc_hostname

n

phone_extension

n

qm_login_status

n

quality_reason

n

recording_last_failed

n

recording_last_failed_cause

n

recording_last_screen_status

n

recording_last_successful

n

recording_last_voice_status

n

recording_type

n

screen_recording_ip

n

silence_average_duration

n

silence_max_duration

n

silence_min_duration

n

silence_percent_of_call

n

silence_total_duration

n

silence_total_events

n

site_name

n

subject
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n

talkover_average_duration

n

talkover_max_duration

n

talkover_min_duration

n

talkover_percent_of_call

n

talkover_total_duration

n

talkover_total_events

n

team_name

n

testfield

n

time

n

to_address

n

training

n

tz

n

voice_recording_ip

Call Events Administration
The Call Events Administration window allows you choose the type of recording events you want
Quality Management to mark in a recording. When enabled, a Unified Workforce Optimization user
can search for recordings that have the specified silence or talkover events from the Recordings
application.
Field

Save TalkOver Events

Description

When selected, Quality Management saves information about
talkover events. The Save TalkOver Events check box is clear
by default.
A talkover event is a time when both parties on the call are
talking simultaneously.
Changes to this event configuration take effect after the next
End of Day.
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Field

Description

TalkOver Event Minimum
Duration

The minimum amount of time in seconds for a talkover event.
Quality Management only saves information about talkover
events with a duration that is equal to or greater than the
number of seconds specified in this field. You can specify from 1
to 3600 seconds (1 hour). The default is 10 seconds.
This threshold setting is used during after-call processing and
applies to all calls. If you change this setting, all previously
processed calls use the older threshold settings.
Using a low threshold (for example, 3 seconds) stores more
information about events than a high threshold (for example, 30
seconds). If you specify a 30 second threshold, a user cannot
search for recordings with talkover events that are under 30
seconds. Quality Management does not save information about
talkover events below the specified minimum duration.

Save Silence Events

When selected, Quality Management saves information about
silence events. The Save Silence Events check box is clear by
default.
A silence event is a time when neither party on the call is talking.
Changes to this event configuration take effect after the next
End of Day.

Silence Event Minimum
Duration

The minimum amount of time in seconds for a silence event.
Quality Management only saves information about silence
events with a duration that is equal to or greater than the
number of seconds specified in this field. You can specify from 1
to 3600 seconds (1 hour). The default is 10 seconds.
This threshold setting is used during after-call processing and
applies to all calls. If you change this setting, all previously
processed calls use the older threshold settings.
Using a low threshold (for example, 3 seconds) stores more
information about events than a high threshold (for example, 30
seconds). If you specify a 30 second threshold, a user cannot
search for recordings with silence events that are under 30
seconds. Quality Management does not save information about
silence events below the specified minimum duration.

To configure silence and talkover events:
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1. In the navigation tree, select the Recordings > Call Events node.
The Call Events Administration window appears.
2. To save information about talkover events, select the Save TalkOver Events check box, and
enter the duration of the event in seconds in the TalkOver Events Minimum Duration box.
3. To save information about silence events, select the Save Silence Events check box, and
enter the duration of the event in seconds in the Silence Events Minimum Duration box.
4. Click Save.
The Recordings application in Unified Workforce Optimization allows users to search for
recordings with silence and talkover events in a customer conversation.

Improving Detection of Silence and Talkover Events
The adaptive Voice Activity Detector (VAD) algorithm uses is very robust and accurate under normal
phone call situations. In this case, normal means:
n

Minimal to no background noise for both parties on a call

n

Good audio quality

n

One party for each side of a call

n

Each party speaks at normal volume

The adaptive VAD algorithm has been proven to be 90% accurate through testing under moderately
noisy conditions. It can handle background noise (for example, white noise) quite well. Rapid changes
in volume and frequency of any background noise can cause inaccuracies as the algorithm adapts to
the noise. A constantly changing background noise (for example, a radio playing loudly) will prevent
the adaptive VAD algorithm from working, and the results will be inaccurate.
Set minimum threshold values for silence and talkover events that are meaningful to your call center.
The threshold values define the granularity of the searches you can run on recorded calls.

Example: If you set the minimum duration for a Save Talkover Event to 10 seconds, the user
cannot search for recordings with any talkover events of 5 seconds or less because Quality
Management only saves talkover events that are 10 seconds or greater. If your users require
greater granularity when searching for a silence or talkover event, then lower the value for the
minimum duration of the event.
If your call center does not fit the definition of normal given above (for example, there is a lot of
background noise), it might be better to use shorter minimum durations for silence events to account
for the noise interfering with correctly identifying silence events. In a noisy environment, it might not
be possible to have a 20-second silence event since a background noise will usually break a
contiguous period of silence during a call. For a noisy call center, consider setting the minimum
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duration of a silence event to 3 seconds for better results. A noisy call center usually results in less
overall accuracy for the identification of silence events.
Another tactic you can use to identify silence events in a noisy call center is to modify your search. For
example, instead of searching for recordings with a single occurrence of a silence event that is 25
seconds or greater, consider searching for recordings with five or more occurrences of silence events
that are 6 seconds or greater. This type of filtering takes into account the shorter, but more frequent
silence events that can be found in a noisy environment.

Handling Pause and Hold when Searching for Silence or Talkover events
When a user searches for a silence or talkover event, Quality Management does not include pause
and hold events in the search. If a silence event occurs just prior to a pause or hold event, Quality
Management saves information about the silence event if the event meets or exceeds the minimum
threshold for the event. Quality Management does not look for silence or talkover events when a call is
paused or on hold.

Retention Rules
The retention rules window allows you to define one or more policies for contact retention based on
the location of the caller (ANI/DNIS), or on the values of up to three metadata fields. Based on the
settings in this window, you can specify how long contacts remain available for access before they are
deleted.
These contact retention rules fall outside the retention rules for the user’s workflow. The affect of
these rules will only be visible to the users when a contact that matches the retention rule criteria is
deleted or retained differently than the user’s standard workflow.
The retention rules defined in this window will be applied in order of priority; will be run once per day.
You can change the retention rules at any time; however, because retention rules have priorities, and
they may prevent a contact from being deleted, each rule must be run one-at-a-time, finally followed by
the standard workflow retention time query:
n

A running list of contacts will be maintained throughout the operation (in a temporary or
variable table).

n

Each rule should be run on this temporary list of remaining contacts.

n

As each rule is run, all contacts which should be deleted via that rule should be flagged
for deletion.

n

As each rule is run, all contacts for which that rule applies must be removed from the
temporary table.

n

A contact will be deleted if it is older than the applicable retention time of the highest priority retention rule whose filters apply to the contact.
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Field

Description

Rule #<number>

Select a rule to define. The rule definition fields appear.

Match <All/Any> of the following conditions

Select “All” to apply all of the specified retention conditions to
contacts (this is the most restrictive option; the retention rules
will apply to fewer contacts).
Select “Any” to apply any of the specified retention conditions to
contacts (this is the least restrictive option; the retention rules
will apply to more contacts).

<condition type>

(Unlabeled field.) Type of information on which to apply the rule.

<operand>

(Unlabeled field.) Select the relationship between the condition
and the value.

<value>

(Unlabeled field.) Enter the value that defines this condition. You
can use wildcard symbols ( * and ? ) to specify values that begin
with or contain the entered text.
All conditions must be associated with a value; to create a
rule matching contacts which do not have a value for a
metadata field, configure the condition with the “not
equals” operator and the “*” wildcard.

+ and -

Click + to add a condition, or - to delete a condition.

Recording Retentions

Select “Unlimited” in any of the categories to retain contacts that
meet the retention criteria indefinitely.

Scored

Enter the number of retention period units for scored contacts,
then use the drop-down to select the retention period unit (days,
months, or years).

Unscored

Enter the number of retention period units for unscored contacts, then use the drop-down to select the retention period unit
(days, months, or years).

Tagged

Enter the number of retention period units for tagged contacts,
then use the drop-down to select the retention period unit (days,
months, or years).

HR

Enter the number of retention period units for HR contacts, then
use the drop-down to select the retention period unit (days,
months, or years).
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Field

Description

Training

Enter the number of retention period units for training contacts,
then use the drop-down to select the retention period unit (days,
months, or years).

Tagged (archive)

Enter the number of retention period units for tagged archive
contacts, then use the drop-down to select the retention period
unit (days, months, or years).

Archive

Enter the number of retention period units for archive contacts,
then use the drop-down to select the retention period unit (days,
months, or years).

Up arrow

Increases the priority of the rule by moving it up in the rule list.

Down arrow

Decreases the priority of the rule by moving it down in the rule
list.

Add

Adds the selected retention rule.

Rename

Allows you to rename the selected retention rule.

Delete

Deletes the selected retention rule.
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Interface Configuration
The Interface Configuration node allows you to control some of the features and information that
appears in the Unified Workforce Optimization interface. Use the Interface Configuration node to:
n

Configure role permissions

n

Configure the default time format at the global level

n

Enable export of recordings for specific roles

n

Control the columns that appear in the <user name> - ID tab in the Media Player under
the Recordings application in Unified Workforce Optimization

Role Permissions
Role Permissions allow you to configure the recording visibility settings, export permissions, and agent
permissions at a global level.

Recording Visibility Settings
Recording Visibility Settings controls how long customer conversations are visible in the Recordings
application by role. When the time expires for a customer conversation, that recording is no longer
available to the user.

Note: Specifying how long customer conversations are visible does not affect retention time.
The customer conversation is not deleted when the visibility setting expires. The customer
conversation will still be available based on its retention time, but it will not be visible to the user
for playback in the Recordings application.
When configuring visibility of customer conversations by role, note the following:
n

The state of a recording has no impact on the visibility
Example: Scored, Unscored, In Progress, or Needs Approval

n

Tagging a contact for HR or Training does not override the visibility setting

n

If a user is assigned multiple roles, the longest visibility setting is used

n

All references to the contact remains in reports, and dashboard widgets
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Field

Days

Unlimited

Description

The number of days the customer conversation is visible in the
Recordings application by role. The time is defined by the date
and time when the call was recorded and the date and time
when user logged into Unified Workforce Optimization to view
and play back the customer conversation. This field is enabled
when the Unlimited check box is cleared. The defaults are as
follows:
n

Agent—7 days

n

Knowledge Worker—7 days

n

Supervisor—14 days

n

Manager—21 days

n

Evaluator—14 days

n

Archive User—21 days

When selected, the customer conversations are always visible. If
you clear the check box, you must specify the number of days
the customer conversations will be visible in the Recordings
application.

Export Permissions
Quality Management Administrator disables the recordings export feature by default. From the Role
Permissions window, you can enable the export of recordings by all roles or some roles.
Customer conversations are stored in a format that can be played only by Quality Management. When
export of recordings is enabled, users can export recordings from the Recordings application in
Unified Workforce Optimization. The recordings can be exported in the following formats:
n

WAV format (uncompressed audio)

n

WebM (compressed audio/video)

These formats are playable in other playback software (such as Windows Media Player).

Agent Permissions
You can choose to enable or disable the agents access to the archive, Mark for Quality, or Tag Contact
features.

254

Interface Configuration

Field

Description

Allow Access to Access
Archive

When selected, the agent can access archived contacts.

Allow Agents to Access
Training

When selected, the agent can access training contacts.

Allow Agents to Mark for
Quality

When selected, the agent can mark a customer conversation for
quality management.

Allow Agents to Tag
Contacts

When selected, the agent can tag and untag contacts that were
recorded as a result of a quality management or archive workflow. Tagging a contact applies the Tagged retention time to the
contact and changes the reason code accordingly. When
untagged, the contact reverts to its original retention time. See
Recording Retention for more information.

Recording Control Buttons
You can choose to enable or disable each button available in Cisco Recording Controls for agents and
knowledge workers. Disabled commands do not appear in Cisco Recording Controls.
Field

Description

Record

Clear or select the ck box to enable or disable the user's ability to
start recording a call.

Pause

Clear or select the check box to enable or disable the user's ability to pause a call recording.

Resume

Clear or select the check box to enable or disable the user's ability to resume call recording.

Delete

Clear or select the check box to enable or disable the user's ability to mark a call recording for deletion.

Login

Clear or select the check box to enable or disable the user's ability to send a login request for hot desking.

Logout

Clear or select the check box to enable or disable the user's ability to send a logout request for hot desking.

Metadata

Clear or select the check box to enable or disable the user's ability to attach metadata to an active call recording.

Start Segment

Clear or select the check box to enable or disable the user's ability to start audio and screen recording for an active call.
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Field

Description

Stop Segment

Clear or select the check box to enable or disable the user's ability to stop audio and screen recording for an active call.

Start Screen

Clear or select the check box to enable or disable the user's ability to start screen recording.

Stop Screen

Clear or select the check box to enable or disable the user's ability to stop screen recording.

Managing Role Permissions
To manage recording visibility settings:
n

Specify number of days or select the Unlimited check box for each role under Recording
Visibility Settings.

To enable export of recordings:
n

Select Enable Export of Recordings and choose on of the following options:
l

l

To enable export for all roles, select by all Roles. All roles will be able to export
recordings.
To enable export for specific roles, select by Some Roles and the select the check
box for each role that will be allowed to export recordings. Only the selected roles
will be able to export recordings.

To enable permissions for all agents:
n

Select one or more of the options listed under Agent Permissions. When an option is
selected, all agents have access to the selected feature.

To enable or disable buttons available in Cisco Recording Controls:
n

Select or clear the check box for each command you want to enable or disable in Cisco
Recording Controls for agents and knowledge workers.

Interface Settings
Interface settings allow you to configure the default time format at the global level and enable Live
Screen Monitor.
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Hour Format
You can choose the default time format at the global level. Your options are 24 hour and 12 hour time
format.

Live Screen Monitor
You can choose to enable or disable Live Screen Monitor from the Interface Settings window. Quality
Management Administrator enables the Live Screen Monitoring feature by default. Live Screen
Monitoring is based off the Microsoft Windows Desktop Sharing API. This same API is used by Microsoft
Windows Remote Assistance. One limitation of the Microsoft Windows Desktop Sharing API is that it
does not support the Windows Aero theme for the desktop being monitored during the time when
another desktop is connected to and viewing that desktop.
When you enable Live Screen Monitoring, choose one of the following options:
n

Load driver on request—choose this option if your agents have Desktop Recording
installed on their desktop and Windows is running the Windows Aero theme. When you
start monitoring an agent's screen, Windows will switch to the Windows Basic theme and
the screen will flash on the agent's desktop. When you stop monitoring an agent's
screen, the screen will flash and Windows will switch to the Windows Aero theme on the
agent's desktop. This option is selected by default.

n

Load driver on startup—choose this option if your agents have the following Microsoft
patch installed on their desktops. The Microsoft patch is located at:
http://support.microsoft.com/kb/3020398
When the patch is installed, the screen will not flash when you start or stop Live Screen
Monitoring on the agent's desktop.

n

WAV format (uncompressed audio)

n

WebM (compressed audio/video)

These formats are playable in other playback software (such as Windows Media Player).

Training Contacts
You can choose to enable or disable global agent access to training contacts from the Interface
Settings window. Quality Management Administrator enables global access to training contacts by
default. Your company may prefer not give all agents access to training contacts. If they choose not to
give access to training contacts, the following occurs:
n

“Training” is removed from the Advanced Search—Recording Flags option

n

The “Mark for Training” option is removed from the Media Player

n

The “Training” column is removed from the Recording application.
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Changing Interface Settings
To change the hour format:
n

Select 12 Hour or 24 Hour under Hour Format.

To enable Live Screen Monitoring:
n

Select Enabled and choose either Load driver on request or Load driver on startup.

To enable creation of traning contacts:
n

Select Allow creation and viewing of training contacts.
Note: This setting only enables the creation of training contacts. To give agents
the right to view training contacts, go to Agent Permissions and select Allow
Agents to Select Training.

Recording Columns
Recording Columns controls the fields that appear in the Recordings application for Unified Workforce
Optimization for all agents, knowledge workers, and supervisors.
The available fields appear under the following categories:
n

Organization Fields

n

Evaluation Fields

n

Date Fields

n

Contact Fields

n

Speech Fields

n

Analytics Fields

n

User Defined Metadata Fields
When you add a new metadata field, it appears in the Show Columns list by default,
unless modified by the Quality Management Administrator. On upgrade, the existing
metadata files appear in the Available Columns list, unless modified by the Quality
Management Administrator.
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Field

Description

Available Columns

Lists the columns that will not appear in the Recordings table in
Unified Workforce Optimization. Fields in the Available Columns
list always appear in alphabetical order.

Show Columns

Lists the columns that will appear in the Recordings Applications
under Contacts table in Unified Workforce Optimization and the
search fields. You can configure the order in which fields appear
in this list using the arrow keys.
Note: Agents, knowledge workers, and supervisors can
only view and search columns that appear in the Show
columns. Managers, evaluators, and archive users can
search all columns.

To manage recording columns:
1. To assign columns in Recording Columns, choose a tab and select the columns you want to
move.
l

To move all columns to the Available Columns list, click <<.

l

To move all columns to the Show Columns list, click >>.

l

l

l

l

To move multiple contiguous columns to the Available Columns list, click the first
column and shift-click the last column you want from the Show Column list and then
click <.
To move multiple contiguous columns to the Show Columns list, click the first column
and shift-click the last column you want from the Available Column list and then click
>.
To move multiple non-contiguous columns in the Available Columns list to the Show
Columns list, use the Ctrl key to select each column, and then click >.
To move multiple non-contiguous columns in the Show Columns list to the Available
Columns list, use the Ctrl key to select each column, and then click <.

Columns in the Available Columns list always appear in alphabetical order.
2. Repeat step 2 for each tab.
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Organization Fields
The Organization Fields tab lists the available fields. All fields appear in the Show Columns list by
default.
Field

Definition

Agent ID

The agent’s ID. Only the Agent ID field can be moved between
Available Columns and Show Columns.

First Name

The agent’s first name. This field always appears in the Show
Columns list.

Group Name

The name of the group. This field always appears in the Show
Columns list.

Last Name

The agent’s last name. This field always appears in the Show
Columns list.

Team Name

The name of the team. This field always appears in the Show
Columns list.

Evaluation Fields
The Evaluation Fields tab lists the available fields. All fields appear in the Show Columns list by default.
Field

Definition

% Score

The evaluation score given to the contact.

Approved By

The name of the manager or supervisor who approved the
evaluation.

Date Evaluated

The date when the customer conversation was evaluated.

Evaluation Calibration

The contact evaluation is marked for calibration.

Evaluation Form

The name of the evaluation form used to score the customer
conversation.

Evaluator Name

The name of the evaluator.

Date Fields
The Date Fields tab lists the available fields. All fields appear in the Show Columns list by default.
Field

Date
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Definition

The contact date. This field always appears in the Show
Columns list.
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Field

Definition

Time

The time of the contact. This field always appears in the Show
Columns list.

Time Zone

The time zone where the contact was recorded. Only the Time
Zone field can be moved between Available Columns and Show
Columns.

Contact Fields
The Contact Fields tab lists the available fields. All fields appear in the Show Columns list by default.
Field

Definition

Associated Call Count

The number of associated contacts for this call.

Associated Call ID

The ID for the associated call.

Call Duration

The duration of the contact (length of time between call
answered and call dropped) in HH:MM:SS.

Call Inbound

The call is inbound. The valid values in the Call Inbound field are:
n

Yes

n

No

Called Number

The number of the phone that received the call. Displays
“unknown” if the called number is unlisted or blocked. This field
always appears in the Show Columns list.

Calling Number

The number of the phone that made the call. Displays
“unknown” if the calling number is unlisted or blocked. This field
always appears in the Show Columns list.

Contact Type

The type of contact. The valid values in this field are:

Has Screen

n

Call—a contact with a call recording

n

Non-Call—a contact without call recording

The contact has a screen recording. The valid values in the Has
Screen field are:
n

Yes

n

No

261

Interface Configuration

Field

Has Voice

HR

Definition

The contact has a voice recording. The valid values in the Has
Voice field are:
n

Yes

n

No

The contact has been marked as an HR contact. The valid
values in the HR field are:
n

Yes

n

No

ID

The contact’s ID.

Line

The extension the agent used to answer the call. This field
always appears in the Show Columns list.
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Field

Recording Type

Reason

Definition

The recording type associated with this device. The valid value
in the Recording Type field are:
n

Server Recording—contact was recorded using Server
Recording (SPAN).

n

Network Recording—contact was recorded using
Network Recording.

n

Multiple Registration—contact was recorded using
Multiple Registration method. This method allows you to
programmatically add participants to an existing call.

n

Single Step Conference—contact was recorded using
Single Step Conferencing method. This method allows
you to choose up to three devices at a single, softphoneenabled extension.

n

Unknown—contact was recorded prior to 8.7 or the
recording type could not be determined.

n

Endpoint—contact was recorded using Endpoint
recording.

n

MediaSense Recording—contact was recorded using
Cisco MediaSense Recording.

The reason the contact was recorded as set in the recording rule
(Archive, First, Last, Longest, Shortest, Random, Logging,
Tagged, Performance, and New Employee).
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Field

State

Definition

The current evaluation state of the recording. The valid values in
the State field are:
n

Scored—contacts that are claimed by an evaluator, fully
scored, and, if approval is required, are approved.

n

Unscored—contacts that are as yet unclaimed by an
evaluator and unscored.

n

In Progress—contacts that are claimed by an evaluator but
which are not yet completely scored

n

Needs Approval—contacts that are claimed by an
evaluator, are fully scored, and are awaiting approval.

This field always appears in the Show Columns list.
Training

The contact has been marked as a training contact. The valid
values in the Training field are:
n

Yes

n

No

Speech Fields
The Speech Fields tab lists the available fields.
Field

Definition

AVG Silence

The average silence time in HH:MM:SS.

AVG Talk Over

The average talkover time in HH:MM:SS.

MAX Silence

The duration of the longest silence event that was detected in
HH:MM:SS.

MAX Talk Over

The duration of the longest talkover event that was detected in
HH:MM:SS.

MIN Silence

The duration of the shortest silence event that was detected in
HH:MM:SS.

MIN Talk Over

The duration of the shortest talkover time that was detected in
HH:MM:SS.
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Field

Definition

PCT Silence

The percentage of detected silence time.

PCT Talk Over

The percentage of detected talkover time.

Silence Events

The number of detected silence events.

Talk Over Events

The number of detected talkover events.

TOT DUR Silence

The total duration of silence time in HH:MM:SS.

TOT DUR Talk Over

The total duration of talkover time in HH:MM:SS.

User Defined Metadata Fields
The user-defined metadata fields appear in the Available Columns list by default. Text is the only
metadata field that appears in the Available Columns list by default until you configure your own
metadata fields. See User-Defined Metadata for information on adding your own metadata fields.
The Date field always appears in the Show Columns list.

View Configuration
A QM view controls the scope of access a user has in QM. A user assigned to a view has access only to
the entities (groups, teams, or specifically defined sets of metadata) assigned to that view according to
the permissions of their role. Views create a scope for the customer, and allow it to differentiate
contacts as it receives them.

Note: Before QM Views can be created, the customer must have created at least one metadata
field and have at least one valid user defined.

Example: A customer can act as a contact center service provider for several customers, each
of which can have a separate toll-free number. Agents in the centralized contact center can
take calls pertaining to any or all of the various customers. QM views are created for each of the
contact center’s customers, with metadata tags for each incoming number. By applying a
metadata tag for a view to each call, the calls can be limited to an exclusive scope for each
customer.
A QM user can be assigned to multiple views.
QM Views only pertain to calls received after the view was created. Users cannot retroactively tag
previously recorded calls to add them to a new or current view.
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Note: After QM views are created, the metadata comparisons are only applied to active QM
views. As a result, if the customer makes a view inactive, no processing for that view will take
place until the view is made active again.
QM views supersede any pre-existing scoping configurations. Only contacts that match the QM View
rules and have a nonzero quality or archive reason will be available in the Recording application.
When a QM user is assigned to an Active QM view, the Recording application will be the only one
available.

Creating QM Views
When you access this page, the system populates it with existing QM View and Person data. The table
below lists the fields in the Views section of the View Configuration window:
Field

Description

Inactive tab

Provides QM View and Person data for inactive views. Only
inactive views can be edited or removed.

Active tab

Provides QM View and Person data for active views. Active
views cannot be edited or removed. Metadata comparisons are
only applied to active QM views.

View ID

Alphanumeric identifier for the view.

Name

Name of the view

Status

Status of the view:
Active
Inactive

Rules

Number of rules included in the view.

Persons

Number of users assigned to the view.

Add

Creates the view.

Edit

Opens the Edit QM View Information window, which allows you
to change the selected view.

Copy

Creates a new view based on the selected view.

Delete

Deletes the selected view.

The table below lists the fields in the Persons section of the View Configuration window:
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Field

Description

Person ID

The QM ID of the user.

Name

Name of the QM user.

Add

Adds the selected person to the selected view.

Remove

Removes the selected person from the selected view.

The table below lists the fields on the Edit QM View Information window:
Field

Definition

View Name

Name of the view.

Status

Status of the view:
Active
Inactive

Condition type

Condition type of the view rule:
Match All
Match Any

Metadata field

Name of the metadata field used for the rule.

Value

Value of the metadata field used for contact matching.

Add

Opens the Add QM View Rule Information window.

Edit

Allows you to change the selected QM view rule information.

Remove

Allows you to delete the selected QM view rule information.

Update

Save the changes to the values of the fields on the window.

Cancel

Do not save the changes to the values of the fields on the window.

The table below lists the fields on the Add QM View Information window:
Field

Definition

Metadata field

Select the metadata field to add.

Rule value

Enter the value of the metadata rule field.

Add

Save the new rule information.

Cancel

Do not save the new rule information.
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